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Introducing Workshare Professional 

Chapter 1. Introducing Workshare 
Professional 

This chapter introduces Workshare Professional, providing an overview of how it works 
as well as a summary of the key features and benefits. It includes the following 
sections: 

• What is Workshare Professional?, page 11, introduces Workshare 
Professional. 

• Workshare Professional Functionality, page 12, describes the different areas 
of functionality of Professional. 

• Accessing Professional Functionality, page 16, describes how to access 
Professional functionality after install. 

• Licensing, page 19, describes how to license Professional after install. 
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What is Workshare Professional?  
Workshare Professional reimagines multi-party review and collaboration and ensures 
the safe and accurate exchange of information, enabling the collaborative evolution of 
high value business documents.  

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution. 

Key features of Workshare Professional include: 

• Comparison of Word, PowerPoint and PDF files, including image-based PDF 
files 

• Ability to accept/reject changes in a comparison and then create new documents 

• Advanced comparison features for Word and PDF files including one-to-many 
comparisons, version comparisons, and access from within Word and 
PowerPoint files 

• Change notifications in Outlook to alert users to changes in received 
attachments 

• Conversion from PDF to DOC format for local files and from within the 
DMS/CRM 

• Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook 

• Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data 

• Options to save and share Office documents to Workshare online 

• Access and visibility into online collaborative workspaces directly from Office 

• Secure file sharing from all devices and browsers with metadata removal and 
end-to-end encryption 

• Centralized policy design and enforcement administrator tools 

• ECM/DMS and OCR integration with desktop comparison features 

• Centralized user account management and control 

• Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional 
commenting and reviewer communications with presence indicators 

• Desktop sync app to synchronize your online content to your local desktop 
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Note: Workshare Professional can be installed without Microsoft Office integration. In 
this case, the comparison functionality is only available from the Workshare Compare 
application and the metadata removal functionality is only available when sending 
emails. 

Workshare Professional Functionality 
Workshare Professional provides sophisticated functionality that is convenient and 
accessible, enabling users to move smoothly between tasks and work rapidly to 
manage changes. Workshare Professional assists you throughout the complete 
document lifecycle – from document assembly, review, verification and security. 
Workshare Professional has also made key functionality of the DMS available, for 
example, enabling the comparison of DMS versions. 

Workshare Professional includes file comparison, file and metadata security and file 
share and sync. 

File comparison 
Workshare Compare reinvents multi-party review by helping users understand, 
communicate and implement changes more quickly and accurately. Compare shows 
precise changes between versions of Word, PDF and PowerPoint files including DMS 
files and versions. The DeltaView Redline sets the standard for an easy-to-read, 
accurate view of changes between document versions. Compare’s advanced 
comparison engine performs comparisons accurately and seamlessly enabling users to 
quickly compare even the most difficult and complex documents and presentations. 

See the changes 
With Microsoft Word and PDF files, users can perform one-to-one and one-to many 
comparisons and see accurate DeltaView Redlines in individual tabs. Compare 
compares both regular text-based PDF files and image-based PDF files that originate 
from scanned documents, automatically applying OCR (Optical Character Recognition) 
processing to translate the images of typewritten text into editable text. Compare 
provides access to files and version information stored in a DMS/CRM or SharePoint 
and users can browse for files to compare as well as save comparisons into the 
DMS/CRM or SharePoint. 

Users can launch Compare from the environment that suits them: 

• Launch a comparison of an attachment (Word or PDF) directly from an email 
message 

• Launch a comparison from within Word or PowerPoint 

• Launch a comparison from within a DMS/CRM or SharePoint 
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Additionally, Automatic Change Notification automatically detects that a received 
attachment is a changed version of a document sent previously enabling the user to 
quickly compare the two documents and see what’s changed. 

Understand the changes 
Compare provides an intuitive interface that enables users to navigate easily between 
changes. Category View divides changes according to type, for example, numbering 
changes, punctuation changes or matching changes, enabling users to quickly focus on 
the changes that are important to them. 

Implement the changes 
Compare includes the ability to accept and reject changes placing it at the centre of the 
review and comparison document lifecycle. Users can accept and reject changes 
(individually or as a group) from within Compare and create a new Word document that 
includes all their changes. 

File and metadata security 
Workshare Protect provides content risk protection through comprehensive cleaning of 
metadata and conversion to secure PDF. 

Protect enables the discovery and removal of hidden sensitive data as well visible 
sensitive data. Hidden sensitive data may include information such as track changes, 
author’s name, server names, keywords, routing slips and authoring trails. 

On your desktop 
Protect integrates with Office providing an option to display a comprehensive report of 
all the content risk in a document while it is open in Microsoft Word, Excel and 
PowerPoint. Content risk is displayed according to its risk level (high, medium, low). 
After discovery, users can remove selected metadata. 

Protect quickly and securely converts Office documents into PDF or PDF/A files. Users 
can access PDF conversion functionality from within Word, Excel and PowerPoint or by 
right-clicking closed Office files from the desktop and from within a DMS/CRM or 
SharePoint. Additionally, users can combine multiple files into a single PDF – a useful 
tool at the close of a project or when creating a report that involves documents, 
spreadsheets and graphics. 
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Within email 
Protect can be configured to support the way you work. 

Interactive Protect offers options to control documents and secure attachments before 
sending email. It simplifies metadata cleaning, avoids email pop-ups, and eliminates 
Outlook add-in issues. Protect scans documents as soon as they are added as 
attachments to an email. Users are made aware of the risk involved and given the 
option to make informed decisions before clicking Send. From the Interactive Protect 
panel users can clean metadata from attachments, convert attachments to PDF or 
PDF/A, and compress attachments into one zip file. Additionally, users can securely 
transfer attachments to a secure location in Workshare online and send recipients a link 
to that location. 

In other configurations, Protect prevents users from accidentally emailing confidential 
information by alerting users before the email is sent when an email or its attachment 
breaches security policies. Depending on the actions defined for policy breaches, 
emails may be blocked or sensitive data removed. Security policies can specify different 
actions when a document is sent internally or externally. For example, it may not be 
acceptable for hidden server names and user details to be included in documents sent 
externally, but it may be fine to leave those details in documents sent within an 
organization. Protect comes with a pre-defined default security profile (collection of 
policies). 

File share and sync 
Workshare’s online services provide a secure file sharing and online collaboration tool 
that enables users to store, share, and collaborate on content. There are several ways 
of interacting with the online services offered by Workshare, either online through a web 
browser or using special apps. The Workshare desktop app is the app for use on PCs 
and it is installed as part of the Professional installation when you select the File Share 
& Sync product. 

Note: Workshare’s mobile apps are apps designed for use on smartphones and 
tablets that provide access to documents in Workshare online while on the move. 

Users can sync documents safely across all their devices automatically updating 
content between Workshare online and their desktop and mobile devices. 

With the Groups functionality, users can easily organize and manage files and projects, 
ensuring the correct users and permissions are applied to a group. Tools for 
commenting, annotating, and file comparison are available to support all stages of 
document evolution. Users receive updates when files in particular groups are being 
accessed, commented on, or modified by other reviewers, so ideas and conversations 
are never missed. Once new file versions are uploaded, users can compare old and 
new versions to see at a glance what has changed.  
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Users can access, review, and collaborate on files from any device, supporting 
company-wide mobility initiatives. Users can also select files to save for offline access, 
enabling users to work on files without Internet access. Once the device is connected 
again, all updates are synced back as a new version.  

IT security controls are available at an account level, allowing data governance 
regulations to be met, and reduce the risk of accidental data loss. For added security, 
organizations can choose where their corporate data is stored (public cloud, custom 
public cloud, or hybrid). Finally, Workshare online can be integrated with existing DMS 
to securely mobilize content, and get the most out of IT system investments. 

With Professional, users can save and share Redlines or Office files (directly from 
Compare or Office) to Workshare online so they can access them on their other devices 
and on the move. Once shared, users can see their shared document, spreadsheet or 
presentation come alive and understand who’s reviewing it online- directly from Word, 
Excel or PowerPoint. 

DMS/CRM integration 
Workshare Professional can integrate with your DMS or CRM as well as SharePoint to 
provide comparison and other functionality.  

Note: To integrate with a DMS/CRM or SharePoint, Workshare Professional must be 
installed with the relevant integration selected and additional details may need to be 
configured in the Workshare Configuration Manager. Refer to your system 
administrator for further information. 

The specific functionality available with each DMS/CRM integration is detailed in the 
table below: 

Functionality Share 
Point 

NetDocu
ments 

iManage OpenText Worldox 

When comparing, 
browse to DMS 
from select dialog 

     

When comparing, 
save Redline to 
DMS 

     

Convert to PDF 
(from Workshare 
tab) 

     

Combine PDF 
(from Workshare 
tab) 
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Functionality Share 
Point 

NetDocu
ments 

iManage OpenText Worldox 

Right-click: 
Compare with 
Workshare 

     

Right-click: 
Convert to PDF 
with Workshare 

     

Right-click: 
Combine files in 
Workshare 

     

Right-click: Open 
in Word with 
Workshare 

     

Browse from 
desktop app to 
add files to 
Workshare 

     

Accessing Workshare Professional 
Workshare Professional can integrate with Microsoft Word, Excel, PowerPoint and 
Outlook. To this end, there is no independently accessed user interface for Professional 
- the user interface is accessed from within Word, Excel, PowerPoint or Outlook and is 
available from all documents. 

Notes: 
If your Workshare Professional is not integrated with Microsoft Word, Excel, 
PowerPoint and Outlook, refer to your system administrator. 
 
The comparison functionality of Workshare Compare is also available as standalone 
applications. Refer to Overview - Comparing Documents and Introducing Compare 
for PowerPoint. 

After you have installed Professional, the Workshare tab is added to the ribbon in your 
Microsoft Office applications - Word, Excel and PowerPoint. The addition of 
Professional does not affect the standard functionality of Word, Excel or PowerPoint. 
You can operate these applications as usual and access the Professional functionality 
as required. 
Workshare Professional functionality can also be accessed in the following ways: 

• Right-click closed Word documents and select Compare with Workshare or 
Convert to PDF with Workshare or Combine files in Workshare or Send 
to/Workshare Batch Clean. 
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• Right-click closed Excel or PowerPoint documents and select Convert to PDF 
with Workshare or Combine files in Workshare or Send to/Workshare Batch 
Clean. 

• Right-click closed PDF documents and select Compare with Workshare or 
Open in Word with Workshare or Combine files in Workshare or Send 
to/Workshare Batch Clean.  

• Right-click closed PowerPoint documents and select Compare with Workshare 
or Convert to PDF with Workshare or Combine files in Workshare or Send 
to/Workshare Batch Clean.  

• Click the Attachments dropdown in the Workshare tab in the email message 
window when you receive an email that contains an attachment (Word and PDF) 
to launch Workshare Compare. 

• Right-click any file and select Workshare/Send to Group.  

The Workshare Compare standalone application can also be accessed in the following 
ways: 

• Double-click the Workshare Compare icon on the desktop. 

• From the Start menu, select Programs, Workshare, Workshare Compare. 

The Workshare Compare for PowerPoint standalone application can also be accessed 
in the following ways: 

• Double-click the Workshare Compare for PowerPoint icon on the desktop. 

• From the Start menu, select Programs, Workshare, Workshare Compare for 
PowerPoint. 

Note: Workshare Professional can be installed without Microsoft Office integration. In 
this case, the Workshare tab is not available. The Workshare comparison 
functionality is only available from the Workshare Compare applications and the 
Workshare metadata removal functionality is only available when sending emails. 

Start menu 
After you have installed Workshare Professional, the following elements are added to 
the Start menu: 

• Under Workshare: 
 Workshare Batch Clean 
 Workshare Compare 
 Workshare Compare for PowerPoint 
 Workshare Configuration (User Mode) 
 Workshare Configuration Assistant 
 Help 
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• Under Workshare Desktop 
 Workshare 

Batch clean 
Workshare Batch Clean is a tool that cleans hidden data, such as versions, templates, 
comments, hidden text, reviewer and author information, from multiple Office 
documents at the same time. Refer to Batch cleaning, for further information. 

Workshare tab 
In Office applications, the Workshare tab is included as follows: 

 
Whether these options are included in the tab is configurable from the General > User 
Interface category in the Workshare Configuration Manager. Refer to Workshare 
Configuration Options for further information. 

The Workshare tab includes the following options: 

Group Item Description 
Compare Compare Microsoft Word and PowerPoint only.  

Enables you to compare a Word or PowerPoint file with a 
previous version of the same file or with another file. Refer to 
Overview - Comparing Documents and Introducing Compare 
for PowerPoint for further information. 

Protect Content 
Risk 

Enables you to display a report of all the content risk in a 
document as well as remove selected hidden data from the 
document. Refer to Displaying Content Risk in Documents for 
further information. 

 Combine 
PDF 

Enables you to combine multiple files into a single PDF file. 
Refer to PDF Combine for further information. 

 Convert 
to PDF 

Enables you to convert documents to PDF. Refer to 
Converting to PDF for further information. 

Sharing Toggle 
Panel 

Displays/hides the Workshare Connect panel in your Office 
window where you can see what’s happening with a 
collaboration in real-time. Refer to Getting Content Online for 
further information. 
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Group Item Description 
 Save to 

My Files 
Enables you to save documents to Workshare online so they 
will be accessible to you online at all times. Refer to Saving to 
My Files for further information. 

 Share Enables you to share documents to groups in Workshare 
online so you can collaborate on them with others. Refer to 
Sharing to a Workshare group for further information. 

Options Options Enables you to configure system parameters in the Workshare 
Configuration Manager. Refer to Introducing the Workshare 
Configuration Manager for further information. 

Info Help Provides access to version, copyright and license information 
about Workshare Professional as well as online help. 

Enabling Workshare Professional functionality 
To ensure Workshare Professional functionality is fully enabled, you should work with 
saved documents. If you are working in Microsoft Office on an unsaved document and 
you select Compare or Combine PDF, the following message is displayed: 
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Licensing 
After installation, you are prompted to log in to your Workshare account in order to 
retrieve your license entitlements. This can be in either of the following ways: 

• When File Share & Sync is included in the installation, the Workshare desktop 
app is launched after install and you will see the following: 

 
Enter your Workshare credentials (email address and password) and click Sign 
in. Your license entitlements are retrieved and you have access to all 
Workshare functionality. Your license entitlements are shown in the My 
Products tab of the Workshare Configuration Manager. 

If you do not log in at this point, then….. 
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• The first time you access Workshare functionality, for example, by clicking any 
option in the Workshare tab, you will see the following: 

 

Note: You can also open the Workshare Configuration Manager, select the My 
Products tab and click Sign in. 

Enter your Workshare credentials (email address and password) for Workshare and 
click Sign in. Your license entitlements are retrieved and you have access to all 
Workshare functionality. Your license entitlements are shown in the My Products tab of 
the Workshare Configuration Manager. 

Users who do not yet have a Workshare account can click Create an account in the 
login dialog. Workshare checks their email address and will automatically register them 
against your corporate Workshare account and update their license entitlement. 
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Chapter 2. Comparing Documents 
This chapter describes Workshare Compare, a standalone application that enables you 
to compare two or more documents. It includes the following sections: 

• Overview – Comparing Documents, page 23, introduces the Workshare 
Compare application. 

• Performing Comparisons, page 24, describes how to compare a document 
against an earlier version of the document or against a different document using 
Workshare Compare. 

• Changes to Received Attachments, page 29, describes Automatic Change 
Notification where Workshare Compare automatically detects if a received 
attachment is a changed version of a document sent previously. 

• Ensuring Successful Comparisons, page 30, describes how Workshare 
Compare performs comparisons using auto retry mode and failsafe mode. 

• Workshare Compare Main Window, page 33, describes the Workshare 
Compare environment and provides an overview of the functionality available. 

• Working with Redlines, page 51, describes the tools available to you when 
working with the compared (Redline) document after a comparison. 
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Overview - Comparing Documents  
Note: This chapter describes how to compare Word documents and PDF files. The 
comparison of PowerPoint presentations is described in Chapter 3. 

The Workshare Compare application compares documents – the original document and 
the modified document – and produces a comparison (Redline document), enabling you 
to instantly see any differences between them. In one view, you can see the source 
documents and the resulting DeltaView Redline. You can compare an original 
document against several different modified documents and see the Redline for each 
comparison in a different tab. Documents can be stored in your DMS or CRM, locally or 
on your network. 

You can compare any of the following file formats: 

DOC DOCX PDF RTF TXT 

Workshare Compare’s powerful engine accurately and reliably displays document 
changes in a Redline document with the differences clearly marked. For example, 
deleted text is red and struck through and added text is blue and double underlined. All 
content is compared including images, tables and embedded Microsoft Excel tables. 
You can review the Redline, navigating between the changes and accepting or rejecting 
the changes to create a new and revised document. To make the review easier, you 
can customize how the changes are highlighted within the document. 
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PDF comparison 
Workshare Compare can compare both regular text-based PDF files and image-based 
PDF files that originate from scanned documents. Workshare Compare compares 
regular PDFs by converting them to RTF before performing a comparison. With image-
based PDF files, Workshare Compare will first apply OCR (Optical Character 
Recognition) processing to translate the images of typewritten text into editable text and 
produce an RTF file.  

PDF files that originate from scanned documents may include: 

• PDF files generated from files that have been scanned: OCR (Optical Character 
Recognition) has already been used to translate images of typewritten text into 
editable text. Workshare Compare supports the comparison of such PDF files. 

• PDF files that have been created directly from the scanning: Where OCR has 
not been used and PDF files contain pure images of text. Workshare Compare 
applies OCR to the PDF files before performing comparisons.  

Notes: 
If you compare scanned PDF files without applying OCR, it may result in a blank 
Redline. 
 
Workshare Compare can perform OCR on the following languages: English, Danish, 
Dutch, Finnish, French, German, Italian, Norwegian, Polish, Portuguese, Spanish, 
Swedish and Russian. 

Performing Comparisons 
You can compare your original document against any previous version of the document 
or against another document entirely. For example, there may be ten versions of a 
document in your DMS. You can open version 3 and compare it against version 5. You 
can also compare a document against multiple versions. For example, you can open 
version 3 and compare it against version 5, version 7 and version 10. 

Note: You cannot compare secure PDFs, meaning PDF files with security settings 
configured. 

You can launch Workshare Compare and perform comparisons from within Microsoft 
Word, from your desktop, from right-click options or from an email and each of these 
scenarios is described in the following sections. 
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Launching Workshare Compare from Microsoft Word 
In this scenario, you first open your document in Microsoft Word. 

To compare documents: 

Click Compare in the Workshare tab. The Compare Documents dialog is displayed with 
the open document in the Original Document field. Select the files to compare it with 
as described in Launching Workshare Compare from your desktop. 

Launching Workshare Compare using right-click options 
You can launch Workshare Compare by right-clicking documents in Windows Explorer 
or in your DMS (iManage/OpenText/Worldox).  

• Right-click the original document and select Compare with Workshare. The 
Compare Documents dialog is displayed with the selected document in the 
Original Document field. Select the files to compare it against as described in 
Launching Workshare Compare from your desktop. 

• Select the original and modified documents, right-click and select Compare with 
Workshare. The Compare Documents dialog is displayed with the selected 
documents in the Original Document and Modified Document fields. Continue 
as described in Launching Workshare Compare from your desktop. 

You cannot launch Workshare Compare from SharePoint using right-click options. 

Launching Workshare Compare from email 
When you receive an email with a Microsoft Word or PDF attachment, you can compare 
the attachment with any document on your local file system, SharePoint or DMS/CRM. 
This feature can be used to compare the attached file with a previous version or 
another document on your computer. 

To compare an attachment from Microsoft Outlook: 

1. Click the Attachments dropdown list that appears in the Workshare tab  
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2. Select the attachment you want to compare. The Compare Documents dialog is 
displayed with the selected attachment in the Original Document field. Select 
the files to compare it against as described in Launching Workshare Compare 
from your desktop. 

Launching Workshare Compare from your desktop 
In this scenario, you launch Workshare Compare as a standalone application from your 
desktop or the Start menu. You then select the documents you want to compare. 
Launching Workshare Compare in this way enables you to perform one-to-many 
comparisons - comparing a single original document against multiple modified 
documents. 

To compare documents:  

1. Double-click the Workshare Compare shortcut on your desktop or from the Start 
menu, select All Programs > Workshare > Workshare Compare. The 
Compare Documents dialog is displayed: 
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2. Select the original document you want to compare: 

 Click  to the right of the Original Document field. 
 Navigate to the document location in your local file system, SharePoint or 

DMS/CRM. 
 Click Open. 

The selected document is displayed in the Original Document field. 

Tip: You can also enter text directly into the text box. Workshare Compare will 
predict locations as you type. This is possible for locations accessible from the 
local machine but not for locations in a DMS. 

3. Select the document you want to compare with the original document: 

 Click  to the right of the Modified Document field. 
 Navigate to the document location in your local file system, SharePoint or 

DMS/CRM. 
 Click Open.  

The selected document is displayed in the Modified Document field. 

Tip! If you want to compare a recently used file, click the dropdown  in the 
Original Document and Modified Document fields and select the documents 
you want to compare. These lists contain the last 10 documents you have used. 

Tip! To swap the original and modified documents, click . This button is 
only available if you are comparing two documents rather than comparing 
multiple documents against an original document. 

4. If you want to compare the original document against another document, click 

. An additional Modified Document field is added. 

5. Select the document you want to compare with the original document: 

 Click  to the right of the second Modified Document field. 
 Navigate to the document location in your local file system, SharePoint or 

DMS/CRM. 
 Click Open.  

6. Repeat step 5 to add further documents as required. 
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7. From the Rendering Set dropdown list, select the rendering set you want to 
use. Rendering sets contain a set of parameters that define how changes are 
displayed in the Redline (compared) document. You can select from the 
standard rendering sets provided with Workshare Compare or you can create 
and customize your own rendering sets (described in Introducing Rendering 
Sets). 

 

Note: Clicking  to the right of the Rendering Set field displays the 
Rendering Sets Manager where you can create, modify and delete rendering 
sets. For a full description refer to Introducing Rendering Sets. 

8. From the Comparison Mode dropdown list, select the type of comparison you 
want to perform from the following: 
 Standard: Workshare Compare performs a regular comparison. 
 Fast: When comparing a DOC or DOCX file against another DOC or DOCX 

file, Workshare Compare performs a binary comparison which is faster than 
a standard comparison. 

Note: The Fast option is only available if the Enable fast comparison 
parameter (Comparison > Administration category) in the Workshare 
Configuration Manager is selected. 

 Text Only: Workshare Compare performs a text-only comparison, 
comparing only the text in a document and not the formatting or styles. 

 Compare without OCR: Workshare Compare compares PDF files without 
first performing OCR. With image-based PDF files, Workshare Compare will 
first apply OCR (Optical Character Recognition) processing to translate the 
images of typewritten text into editable text in order to compare. If you do 
NOT want Workshare Compare to perform OCR, select this option. 

9. Click OK. The comparison process is launched and an In Progress dialog is 
displayed. 

Tip: Progress is also indicated by the shading in the Task Bar icon for Workshare 

Compare  
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When the comparison is complete, the Redline is displayed in the Workshare Compare 
window. If the original document has been compared against multiple documents, each 
Redline is displayed in a different tab. For a full description of the Workshare Compare 
interface, refer to Workshare Compare Main Window. 

Note: When comparing a PDF file, the display may vary according to the type of PDF 
- the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, 
novaPDF, and so on. 

Changes to Received Attachments 
Automatic Change Notification is a feature of Workshare Compare that automatically 
detects if a received attachment is a changed version of a document sent previously. If 
Workshare Compare detects that a received attachment is changed, you can launch a 
comparison of the two documents from within Microsoft Outlook and view the Redline in 
Workshare Compare. 

 

You can quickly see whether an email includes a changed 
attachment because it is flagged with “Attachment(s) 
Modified” in the Categories column and a green bar across 
the top of the email in the Reading Pane. 

To launch a comparison: 

1. Select an email that has been flagged. An alert is shown across the top of 
Outlook and the Workshare Compare panel is displayed to the right of the 
message. 

The panel provides a list of the attachment(s) that are modified versions of a 
document you have previously sent out. 
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Note: If you’re using Outlook 2010 or earlier, you must open the flagged email 
in order to display the alert and the panel in the email window. 

 
2. Click an attachment in the panel. Workshare Compare compares it to the 

document you sent out previously and displays the Redline. 

Ensuring Successful Comparisons 
If Workshare Compare cannot complete the comparison, it will do one of two things: 

• Invoke auto retry mode, if it is enabled. 

• Invoke failsafe mode, if auto retry mode is not enabled or if Workshare Compare 
cannot complete the comparison in auto retry mode. 

Auto retry mode 
If Workshare Compare is unable to complete the comparison, and auto retry mode is 
enabled, then Workshare Compare attempts to perform the comparison using reduced 
settings. For example, Workshare Compare may attempt to compare the documents 
without comparing field codes or without comparing footnotes. Workshare Compare 
repeatedly attempts to perform the comparison disabling settings one at a time until the 
comparison is successful. 
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Note: Auto retry mode is enabled in the rendering set – the Allow Auto Retry 
parameter in the Comparison Options category of the Rendering Sets Manager. 

Once the comparison is successful, a message is displayed informing you that the 
comparison has been performed using reduced settings. Click OK and scroll to the 
Redline Options Summary, which is displayed at the beginning or end of the Redline 
according to the settings in the selected rendering set (in the Redline Options category 
of the Rendering Sets Manager). Even if the rendering set does NOT have the Include 
Redline Options Summary parameter selected, when Workshare Compare performs 
an auto retry the Redline Options Summary is always displayed after the comparison. 

The Redline Options Summary indicates which settings Workshare Compare disabled 
in order to perform the comparison. For example: 

Redline Options Summary 
Option: Status: 
Redline Statistics at End of Document ON 

Include Redline Comparison Summary OFF 

Show Line Numbering OFF 

Show Change Numbers OFF 

Show Change Bars on Left ON 

Show Hidden Text OFF 

Detect List Numbering Changes ON 

Compare Headers/Footers ON 

Compare Footnotes SET OFF 

Display Compare Footers OFF 

Ignore Embedded Objects/Images OFF 

Compare at Character Level OFF 

Compare Numbers at Character Level OFF 

Show Moved Deletions OFF 

Show Changes to Spaces OFF 

Show Paragraph Changes OFF 

Ignore Case Changes OFF 

Ignore Textboxes SET ON 

Ignore Field Codes OFF 

Ignore Tables OFF 
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Note: The comparison may take longer than usual because Workshare Compare is 
attempting to compare using different settings. 

The status indications are as follows: 

ON This setting is selected and was applied during the comparison. 

OFF This setting is not selected and was not applied during the comparison. 

SET ON This setting was not selected but was enabled by Workshare Compare 
and applied during the comparison. 

SET OFF This setting was selected but was disabled by Workshare Compare and 
not applied during the comparison. 

If Workshare Compare cannot complete the comparison even using reduced settings, 
failsafe mode is invoked. 

Failsafe mode 
If Workshare Compare is unable to complete the comparison and auto retry mode is 
disabled, or if Workshare Compare cannot complete even a reduced comparison in 
auto retry mode, then failsafe mode is invoked. Failsafe mode means that Workshare 
Compare performs a text-only comparison, comparing only the text in a document and 
not the formatting or styles. 

You can manually invoke failsafe mode so that a text-only comparison is performed. 
You may want to do this if, after a full comparison, your Redline was not fully shown in 
Workshare Compare for any reason. Additionally, you may want to do this if you are 
more interested to see text changes rather than formatting and style changes. 

To manually invoke failsafe mode: 

Before running the comparison, select Text Only as the Comparison Mode in the 
Compare Documents dialog. 
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Workshare Compare Main Window 
The Workshare Compare main window enables you to view Redlines - the results of a 
comparison between an original document and a modified document. You can view (in 
one work area) both source documents, the Redline and a summary of the changes 
between the two source documents. 

 
When you select to run multiple comparisons, each resulting Redline is displayed in an 
individual tab. 
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Moving and placing windows 
The Source Documents window and the Change Summary window can easily be 
moved to different positions in the Workshare Compare main window according to 
individual preference. 

Left-click the title bar of the Source Documents window or Change Summary window 
and the drag the window to your preferred position. The selected window will float over 
the workspace. 

To dock a window: 

Left-click the title bar of a floating window and keep the mouse button pressed. 
Positioning arrows appear at the top, bottom, left and right of the Workshare Compare 
main window, as well as in the center. 

 
Move the mouse pointer over the required positioning arrow and release the mouse 
button. The window is docked in the selected location. For example, dragging the 
Change Summary window over the left positioning arrow will dock the Change 
Summary window down the left side of the Workshare Compare main window. 

To hide a window: 

Click  in the top right corner of the Source Documents window or the Change 
Summary window or use the options in the Layout group on the Home tab. 
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To auto-hide a window: 

Click  in the top right corner of the Source Documents window or the Change 
Summary window. The selected window is hidden with just a tab remaining. 

For example, if the Change Summary window is displayed on the left side of the 
Workshare Compare main window: 

1. Click , the Change Summary window is hidden with just a tab displayed on the 
left side. 

2. Hover over this tab, the Change Summary window is displayed again and you 
can work in it as required. 

3. Click elsewhere, for example in the Redline, the Change Summary window is 
automatically hidden again. 

 

To turn off auto-hide, click . 
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Quick access toolbar 

 
The quick access toolbar provides one-click access to popular functionality. By default, 
the New Comparison, Open Comparison, Save and Save As buttons are included in 
the quick access toolbar. By clicking the arrow to the right of the quick access toolbar, 
you can customize it as follows: 

 

Select/deselect the New Comparison, Open 
Comparison, Save or Save As options to display/hide 
these options in the quick access toolbar. 

Select More Commands to add additional options to the 
quick access toolbar. 

Select Show Below the Ribbon to display the quick 
access toolbar below the ribbon. 

Select Minimize the Ribbon to hide the details of the 
ribbon until you click the Home, Review or View tabs. 

Note: To change the commands that appear in the quick access toolbar, right-click in 
the ribbon and select Customize the Ribbon. Refer to Customize the Workshare 
ribbon. 

File menu 
Clicking File displays a menu with the following options: 

Option Description 
New Comparison Opens the Compare Documents dialog enabling you to 

perform a new comparison. Refer to Launching 
Workshare Compare from your desktop. 

Open Comparison Enables you to open a saved comparison. Comparisons 
are saved as Workshare DeltaFiles (.WDF). Refer to 
Opening saved Workshare DeltaFiles. 

Save Enables you to save the current comparison. Refer to 
Saving Redlines. 

Save As  Includes the following sub-options: 

Comparison 
document 

Enables you to save the Redline as a WDF, DOC, 
DOCX, TXT, RTF, HTM or PDF file. Refer to Saving 
Redlines. 
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Option Description 
Word document with 
Track Changes 

Enables you to save the Redline as a DOCX document 
with the changes shown as track changes. Refer to 
Saving Redline as track change document. 

Save to My Files Includes the following sub-options: 

As Comparison 
document 

Enables you to save the Redline to Workshare online as 
a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. 
Refer to Saving Redlines to Workshare online. 

As Word document 
with Track Changes 

Enables you to save the Redline to Workshare online as 
a DOCX document with the changes shown as track 
changes. Refer to Saving to Workshare online as track 
change document. 

Share Includes the following sub-options: 

As Comparison 
document 

Enables you to share the Redline to a group in 
Workshare online as a WDF, DOC, DOCX, TXT, RTF, 
HTM or PDF file. Refer to Sharing Redlines to 
Workshare online. 

As Word document 
with Track Changes 

Enables you to share the Redline to a group in 
Workshare online as a DOCX document with the 
changes shown as track changes. Refer to Sharing to 
Workshare online as track change document. 

Email  Includes the following sub-options: 

Attach as PDF Converts the Redline to PDF and opens a new email 
window with the PDF attached. Refer to Sending by 
email. 

Attach as PDF (only 
pages with changes) 

Converts the changed pages in the Redline to PDF and 
opens a new email window with the PDF attached. 
Refer to Sending by email. 

Attach as Word 
document with Track 
Changes 

Converts the Redline to a Word document with the 
changes shown as track changes and opens a new 
email window with the document attached. Refer to 
Sending by email as track change document. 

More email 
options…. 

Enables you to select which documents from the 
comparison to email and in what format. Refer to 
Sending by email. 

Print Enables you to print the Redline and includes the 
following sub-options: Refer to Printing Redlines. 

Comparison only Enables you to print the Redline.  

Comparison + 
Modified 

Enables you to print the Redline and the modified 
source document. 
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Option Description 
Comparison + 
Modified + Original 

Enables you to print the Redline, the modified source 
document and the original source document. 

Print Preview Enables you to preview the print output and includes the 
following sub-options: 

Comparison only Enables you to preview the Redline.  

Comparison + 
Modified 

Enables you to preview the Redline and the modified 
source document. 

Comparison + 
Modified + Original 

Enables you to preview the Redline, the modified 
source document and the original source document. 

Help Includes the following sub-options: 

Help Provides access to online help. 

About Displays version and copyright information about 
Workshare Compare. 

Keyboard shortcuts Displays a list of keyboard shortcuts available in 
Workshare Compare. 

License Displays information about your Workshare Compare 
license in the My Products page of the Workshare 
Configuration Manager. 

Workshare Config 
Manager 

Opens the Workshare Configuration Manager where, if 
you have permission, you can configure system 
parameters. Refer to Introducing the Workshare 
Configuration Manager for further information. 

Exit Workshare 
Compare 

Closes the Workshare Compare application. You are 
prompted to save any open Redlines. 

Home tab 
The Home ribbon provides access to key functionality in Workshare Compare. 
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The options are described in the following table. 

Group Option Description 
New New 

Comparison 
Opens the Compare Documents dialog enabling 
you to perform a new comparison. Refer to 
Launching Workshare Compare from your 
desktop. 

Comparison 
Document 

Save As Includes the following sub-options: 

 Comparison 
document 

Enables you to save the Redline as a WDF, DOC, 
DOCX, TXT, RTF, HTM or PDF file. Refer to 
Saving Redlines. 

 Word 
document 
with Track 
Changes 

Enables you to save the Redline as a DOCX 
document with the changes shown as track 
changes. Refer to Saving Redline as track change 
document. 

 Save to My Files Includes the following sub-options: 

 As 
Comparison 
document 

Enables you to save the Redline to Workshare 
online as a WDF, DOC, DOCX, TXT, RTF, HTM or 
PDF file. Refer to Saving Redlines to Workshare 
online. 

 As Word 
document 
with Track 
Changes 

Enables you to save the Redline to Workshare 
online as a DOCX document with the changes 
shown as track changes. Refer to Saving to 
Workshare online as track change document. 

 Share Includes the following sub-options: 

 As 
Comparison 
document 

Enables you to share the Redline to a group on 
Workshare online as a WDF, DOC, DOCX, TXT, 
RTF, HTM or PDF file. Refer to Sharing Redlines 
to Workshare online. 

 As Word 
document 
with Track 
Changes 

Enables you to share the Redline to a group on 
Workshare online as a DOCX document with the 
changes shown as track changes. Refer to 
Sharing to Workshare online as track change 
document. 

 Email  Includes the following sub-options: 

 Attach as 
PDF 

Converts the Redline to PDF and opens a new 
email window with the PDF attached. Refer to 
Sending by email. 
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Group Option Description 
 Attach as 

PDF (only 
pages with 
changes) 

Converts the changed pages in the Redline to 
PDF and opens a new email window with the PDF 
attached. Refer to Sending by email. 

 Attach as 
Word 
document 
with Track 
Changes 

Converts the Redline to a Word document with the 
changes shown as track changes and opens a 
new email window with the document attached. 
Refer to Sending by email as track change 
document. 

 More email 
options… 

Enables you to select which documents from the 
comparison to email and in what format. Refer to 
Sending by email. 

 Print Enables you to print the Redline and includes the 
following sub-options: Refer to Printing Redlines. 

 Comparison 
only 

Enables you to print the Redline.  

 Comparison + 
Modified 

Enables you to print the Redline and the modified 
source document. 

 Comparison + 
Modified + 
Original 

Enables you to print the Redline, the modified 
source document and the original source 
document. 

 Close All Closes all open comparisons. 

Convert PDF Enables you to convert the Redline to PDF. Refer 
to Converting Redline to PDF. 

 Word Includes the following sub-options: 

 Open in Word Opens the Redline in Microsoft Word where you 
can edit it. Refer to Editing Redlines. 

 Open in Word 
with Track 
Changes 

Opens the Redline in Microsoft Word with the 
changes converted to track changes so you can 
implement changes using track changes 
functionality. Refer to Showing changes as track 
changes. 

Note: The Convert to Track Changes option is 
only available if the Enable ‘Convert to Track 
Change document’ parameter is selected in 
the Workshare Configuration Manager 
(Comparison > User Interface category). 
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Group Option Description 
Change 
Navigation 

Change 
Summary 

Displays/hides the Change Summary window. 

 Search Displays the Search tab in the Change Summary 
window enabling you to search for specified text or 
keywords in the Redline and source documents.  

 Previous Navigates to the previous change and highlights 
the entire change in the Redline. Refer to 
Navigating between changes. 

 Next Navigates to the next change and highlights the 
entire change in the Redline. Refer to Navigating 
between changes. 

 First Navigates to the first change and highlights the 
entire change in the Redline. Refer to Navigating 
between changes. 

 Last Navigates to the last change and highlights the 
entire change in the Redline. Refer to Navigating 
between changes. 

 Specific Enables you to navigate to a specific change 
number. The entire change is highlighted in the 
Redline. Refer to Navigating to a specific change 
number. 

Comparison 
Theme 

Select Enables you to select a different rendering set 
from the dropdown list and Workshare Compare 
automatically re-runs the comparison applying the 
selected rendering set. Refer to Introducing 
Rendering Sets.  

 Edit Opens the Rendering Sets Manager where you 
can apply different rendering sets to a comparison 
and, if you have permission, you can add, edit and 
delete rendering sets. Refer to Introducing 
Rendering Sets. 

Layout Select Enables you to select what is displayed in the 
Workshare Compare window. 

 Comparison 
only 

Hides the Source Documents window and displays 
the Redline only. 

 Comparison + 
Original 

Displays the Redline as well as the original 
document in the Source Documents window. 

 Comparison + 
Modified 

Displays the Redline as well as the modified 
document in the Source Documents window. 
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Group Option Description 
 Comparison + 

Original + 
Modified 

Displays the Redline as well as both source 
documents. 

More tab 
The More ribbon provides access to other useful functionality. 

 
The options are described in the following table. 

Group Option Description 
Original/ 
Modified 

Swap Swaps the original and modified documents. Refer 
to Swapping the source documents. 

Mode Comparison 
Mode 

Enables you to select a comparison mode from the 
dropdown list and Workshare Compare 
automatically re-runs the comparison in the 
selected mode – Fast, Standard, Text Only or 
Image Based PDF. 

Info Help Includes the following sub-options: 

 Help Provides access to online help. 

 About Displays version and copyright information about 
Workshare Compare. 

 Keyboard 
shortcuts 

Displays a list of keyboard shortcuts available in 
Workshare Compare. 

 License Displays information about your Workshare 
Compare license in the My Products page of the 
Workshare Configuration Manager. 
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Customize the Workshare ribbon 
To change the commands that appear in the Workshare Compare ribbons and quick 
access toolbar, right-click in the ribbon and select Customize the Ribbon. 

 
To customize the Compare environment to suit your needs, you can select which 
commands to include in the Home and More tabs or add new tabs. 

The Redline 
The DeltaView Redline shows the results of the comparison between the original 
document and the modified document. Changes are marked according to the rendering 
set applied to the comparison. For example, deleted text could be red and struck 
through and added text could be blue and underlined. 

You can navigate between the changes in the Redline and accept/reject the changes to 
create a new and revised document. You can also save the Redline locally, or to your 
DMS or to Workshare online. All of these options are described in Working with 
Redlines. 
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Redline tabs 

 
When the original document has been compared against multiple modified documents, 
each resulting Redline is displayed in a different tab. Select the tab header to display 
the comparison in the Workshare Compare window. You can also display the tabs 
simultaneously side by side by clicking and dragging the tab header across the 
Workshare Compare window. 

 

Redline right-click menu 
Right-clicking text or changes in the Redline displays a popup menu, providing rapid 
access to some of the more commonly used tools. 

Option Description 
Copy Copies selected text to the clipboard. 

Select All Selects all the content of the Redline. 

Find Displays the Search tab in the Change Summary window enabling 
you to search for specified text or keywords in the Redline and 
source documents. 

Find Next When you have specified text or a keyword in the Search tab, 
navigates to the next occurrence of the specified search text or 
keyword. 

Edit Redline Opens the Redline in Microsoft Word where you can edit it. Refer to 
Editing Redlines. 

Zoom Enables you to change the display of the Redline from 20% to 
200% of its original size.  
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Option Description 
Link to 
Move 

When text has been moved to another position, navigates and 
highlights the text in its new or previous position in the Redline.  
• When right-clicking text in its new position, clicking Link to 

Move highlights the text in its previous position. 
• When right-clicking text in its original position, clicking Link to 

Move highlights the text in its new position. 
You must right-click a move-type change for this option to be 
available. 

Link to 
Change 

Jumps to the Redline Summary (at the end of the Redline) 
highlighting the selected change. You must right-click a change for 
this option to be available. 

The Include Redline Comparison Summary parameter 
(Redline Options category of the Rendering Sets Manager) 
must be selected in the applied rendering set. 



 

46 

Comparing Documents 

Redline comparison summary 
At the beginning or end of the Redline, you can see a summary of the comparison and 
a list of the changes found.  

 
In order for the Redline to include this summary, the Include Redline Comparison 
Summary parameter in the Redline Options category of the Rendering Sets Manager 
must be selected in the applied rendering set. 
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Change Summary window 
The Change Summary window provides a list of changes found between the source 
documents. Selecting a change highlights the change in the Redline and displays the 
position of the change in both the source documents. From the Change Summary 
window, you accept and reject changes. Refer to Reviewing changes. 

You can hide/display the Change Summary window by clicking Change Summary in 
the Home tab. 

Tip! The Change Summary window is by default positioned down the left side of the 
Workshare Compare environment. It can be moved as required. Refer to Moving and 
placing windows. 

The Change Summary window includes two tabs – Changes and Search – and the 
Changes tab has three views. These are described in the following sections. 

Changes tab Category View 

 
The Changes tab, Category View displays all the changes between the original 
document and the modified document according to the type of change. The changes 
can be grouped into any of the following categories: 

• Numbering Changes: Any changes to numbering lists identified in a document. 
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• Whitespace Changes: Changes that only involve whitespace – ie 
deletion/insertion of spaces or tabs, or a space changing to a tab or 3 spaces 
changing to tabs. 

• Capitalization Changes: Any changes to the capitalization of a word. 

• Punctuation Changes: Any changes to a punctuation mark. 

• Spelling Corrections: Changes where a single word replacement includes the 
deletion of a word that is not a dictionary word and the insertion of a dictionary 
word in its place. The replacement word must also be a spell check suggestion 
for the replaced word – for instance replacing ‘recieve’ with ‘receive’. 

• Word Variations: Changes which involve changing the form a word ie replacing 
‘confirms’ with ‘confirmed’ – the two words (original and replacement) must come 
from the same stem word and just have different endings. This relies on a 
dictionary as well – refer to document above on instructions on how this can be 
customized. 

• Matching Changes: Changes that are repeated and identical. 

• Suggested Changes: Changes that a reviewer could have neglected to make. 
For example, there are 400 instances of “ACME INC” in the original document 
but the reviewer has only changed 399 of these to “Workshare Inc”. The 
Suggested Changes category will indicate that there is 1 change that might 
have been missed. 

• Style Changes: Style changes in a document. 

• Font Changes: Changes made to font type, font style, font colour, underline 
style, underline color and font effects. 

• Footnote Changes: Any changes in the footnote of a document. 

• Endnote Changes: Any changes in the endnote of a document. 

• Header Changes: Any changes in the header of a document. 

• Footer Changes: Any changes in the footer of a document. 

• Placeholder Changes: The change summary shows items for blocks of 
placeholder text that are found to be matching between the original and modified 
documents. While these are not changes between the two documents as such, 
they highlight areas where the editing of the document may be incomplete. 
Typical blocks of placeholder text might be ‘[Client Name]’, ‘[Company Address]’ 
etc. 

• Boilerplate Changes: Changes that occur inside blocks of boilerplate text in a 
special ‘Boilerplate Changes’ section. These changes merit special attention as 
in general boilerplate text should not be modified. Note that the change is only 
marked as a boilerplate change if it is found inside an occurrence of one of the 
boilerplate text items in the original document. 

• Comment Changes: Changes that have been made to comments. 

• Uncategorized Changes: Changes that do not fall into any of the above groups. 
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Changes tab List View 

 

The Changes tab, List View displays 
all the changes between the original 
document and the modified document 
in the order that they occur. The 
following information is shown for each 
change: 

#: The number of the change in the 
document. A change may have two 
numbers when it includes two actions. 
For example, a deletion and an 
addition. 

Page, Line: The page number and the 
line number in the original document 
where the change occurs. 

Accept: Whether you accept the 
change or not. 

Change Text: Details of the change. 

Changes tab Status View 

 

The Changes tab, Status View 
displays all the changes between the 
original document and the modified 
document according to their review 
status – Accepted, Not Accepted or 
Flagged. When you have selected the 
checkbox to the left of a change, it 
appears under Accepted. 
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Search tab 

 

The Search tab enables you to search 
for changes in the Redline that include 
a specific keyword or text. Refer to 
Searching for changes. 

 

Source Documents window 
The Source Documents window is where you can view the original document and the 
modified document that have been compared. You can select (from the Layout group 
in the Home tab) to display the original document, the modified document or both 
documents in the Source Documents window. 
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You can scroll through both documents and selecting a point in one source document 
automatically scrolls the other source document as well as the Redline to the same 
point. The source documents are read-only and cannot be modified in any way. The 
name of the source document is shown above the document. 

Tip! The Source Documents window is by default positioned across the top of the 
Workshare Compare environment. It can be moved as required. Refer to Moving and 
placing windows. 

Right-clicking text in the original document or the modified document displays a popup 
menu, providing rapid access to some of the more commonly used tools. 

Option Description 
Copy Copies selected text to the clipboard. 

Select All Selects all the content of the original or modified document. 

Find Displays the Search tab in the Change Summary window enabling 
you to search for specified text or keywords in the Redline and 
source documents. 

Find Next When you have specified text or a keyword in the Search tab, 
navigates to the next occurrence of the specified search text or 
keyword. 

Zoom Enables you to change the display of the original or modified 
document from 20% to 200% of its original size.  

Working with Redlines 
This section describes the tools available to you when working with the Redline 
DeltaView after a comparison. 

Navigating changes 
After performing a comparison, you can review the Redline (the result of the 
comparison) and look through the changes between the original and modified 
documents. You can move between changes in the Redline by jumping from change to 
change or searching for a specific change using change numbers or keywords. You can 
also accept or reject the changes and create a new document based on your decisions 
– refer to Reviewing changes. 
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Navigating between changes 
Selecting a change in the Change Summary window highlights the change in the 
Redline and displays the position of the change in both of the source documents. 

• Click Previous in the Home tab to move to the previous change and highlight 
the entire change in the Redline. Click First to move to the first change in the 
Redline. 

• Click Next in the Home tab to move to the next change and highlight the entire 
change in the Redline. Click Last to move to the last change in the Redline. 

Navigating to a specific change number 
Changes are allocated numbers, which are displayed next to the change in the Change 
Summary window. A change may have two numbers when it includes two actions, for 
example, a deletion and an addition. You can move to a specific change number in the 
Redline. 

To navigate to a specific change number: 

1. Click Specific in the Home tab. The following dialog is displayed: 

 
2. In the Change Number field, enter the number of the change you want to 

display in the Redline. 

3. Click Go To. The entire change is highlighted in the Redline. 

4. Repeat steps 2 and 3 to navigate to further changes as required. 

5. Click Close to close the dialog. 

Tip! To maximize this feature, apply a rendering set with the Show Change 
Numbering parameter selected in the Redline Rendering category, Change 
Numbering section. Refer to Change Numbering. This shows all the change numbers 

against each change in the Redline, for example, . 
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Searching for changes 
You can search for changes in the Redline that include a specified keyword or text. 
Workshare Compare can search only the changes for the specified text or it can search 
the text of the original or modified documents. 

To search for a change: 

1. In the Change Summary window, select the Search tab or click Search in the 
Home tab. 

2. In the text box at the top of the Search tab, enter the search criteria – the word 
or words for which you want to search. 

3. If the case is not important, select the Ignore Case checkbox. 

4. Select where you want to search from the dropdown list. The options are as 
follows: 
 Search changed text only: Searches through all text in the Redline that has 

been changed. 
 Search text near a change: Searches through all text in the Redline that 

has been changed and also text that is within 100 characters of a change. 
 Search Original Document text: Searches through all text in the original 

document. 
 Search Modified Document text: Searches through all text in the modified 

document. 
 Search all Redline text: Searches through all text in the Redline. 

5. Click Search. A list of changes that include the specified word or words is 
displayed in the lower text area. 

 
Selecting a change in the search results highlights the change in the Redline and 
displays the position of the change in both the source documents. 
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Reviewing changes 
You can accept and reject changes from within Workshare Compare and create a new 
Word document that includes all your changes. Changes can be accepted/rejected 
individually or as a group. Using the Category View of the Changes tab, you can 
choose to accept or reject an entire category. For example, the Matching Changes 
category includes changes that are repeated and identical and you can accept or reject 
them all at one time. Switching to Status View provides an easy way to quickly see 
what changes haven’t yet been reviewed. 

To accept/reject changes: 

1. Review the changes that you care about and mark them in any of the following 
ways: 
 In the Change Summary window, select the checkbox to the left of an 

individual change to accept it. 
 In Category View, select the checkbox to the left of a category to accept all 

changes in that category. 

Tip! You can select all changes in a category by selecting the category 
checkbox and then deselect one or two changes within that category as 
required. 

 Right-click an individual change or a category and select Flag. This is a way 
to highlight the change – perhaps for future consideration or to check 
sources. 

 Right-click an individual change or a category and select Mark as Read. 
This is a way to indicate that you have reviewed the change but do not want 
to give it a status. 

Note: To reset a change marked as read, select Mark as Unread from the 
right-click menu. 

2. When you have completed your review, click Apply Accepted Changes at the 
bottom of the Change Summary window. A new Word document is opened with 
the changes accepted or rejected according to your selection. You can save this 
document as your new master document. 

Note: Changes to comments (grouped in the Comments category) will not be 
accepted. 

The comparison is not altered in any way so you can return to the comparison in 
Workshare Compare and change your mind about whether to accept changes or 
not. Every time you click Apply Accepted Changes, a new Word document is 
opened with the current accept/reject statuses applied. 
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You can also save the comparison as WDF file and this will save all your selections 
along with the source documents and Redline document. You can open this WDF at a 
later time and continue working or send it a colleague for further review. 

Editing Redlines 
A Redline remains an accurate comparison of two documents and cannot be directly 
edited in Workshare Compare. However, you can open the Redline in Microsoft Word 
and edit the document as required. There are two ways of opening the Redline in Word 
– one where the changes appear as text and another where the changes appear as 
track changes. 

Showing changes as text  
Using this method, changes appear as normal text with just the formatting to identify 
them. For example, if the rendering set used in the comparison showed inserted text as 
red with a double underline, then the text will appear as red with a double underline in 
Word. 

To open the Redline in Word: 

1. In the Home tab, click Word and then Open in Word or right-click in the Redline 
and select Edit Redline. The Redline is opened in Microsoft Word with the 
default name Redline.docx. All the changes are displayed as ordinary text but 
with formatting marks indicating whether they are additions, deletions and so on. 

2. Edit the document as required. 

3. Save the document. By default, the document is saved in a temporary folder. 

Showing changes as track changes 
Using this method, the changes are converted to track changes and you can implement 
the changes using Microsoft Word’s track changes functionality.  

Note: The converting to track changes functionality is only enabled, if the Enable 
‘Convert to Track Change document’ parameter (Comparison > User Interface 
category) in the Workshare Configuration Manager is selected. 

To convert to track changes: 

1. In the Home tab, click Word and then Open in Word with Track Changes. The 
Redline is opened in Microsoft Word with all the changes displayed as track 
changes. 

2. Review the track changes and implement them as required. 

3. Save the document. By default, the document is saved in a temporary folder. 
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Changing the comparison 
You can re-run a comparison swapping the source documents, changing the 
comparison mode, applying a different rendering set or changing specific comparison 
options. 

Swapping the source documents 
You can re-run a comparison exchanging the original document for the modified 
document and the modified document for the original document. For example, if you 
selected Document A as the original document and Document B as the modified 
document, Workshare Compare compares Document A to Document B and presents 
the changes made to Document A. You can then swap the original and modified 
documents so that Document B is now the original document and Document A is the 
modified document. Workshare Compare automatically re-runs the comparison, 
comparing Document B to Document A, and presents the changes made to Document 
B. 

To swap the source documents: 

Click Swap in the More tab to swap the source documents. Workshare Compare 
automatically runs a new comparison, using the modified document as the original 
document and the original document as the modified document. The new Redline is 
displayed in the same tab replacing the first comparison. 

Changing the comparison mode 
You can re-run a comparison using a different comparison mode (or type) if required. 

To re-run a comparison using a different mode: 

In the More tab, click Comparison Mode and then select the required mode from the 
following: 

• Fast: Workshare Compare performs a fast comparison. When comparing a 
.DOC file against another .DOC file, Workshare Compare performs a binary 
comparison which is faster than a standard comparison because it is comparison 
at the binary level. When comparing a .DOCX file against another .DOCX file, 
Workshare Compare performs a faster comparison by converting the documents 
to DOC followed by comparison at the binary level. 

Note: The Fast option is only available if the Enable fast comparison 
parameter (Comparison > Administration category) in the Workshare 
Configuration Manager is selected. 

• Standard: Workshare Compare performs a regular comparison. 

• Text Only: Workshare Compare performs a text-only comparison, comparing 
only the text in a document and not the formatting or styles. 
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• Image Based PDF: Means that Workshare Compare will re-run the comparison 
and force OCR processing on scanned/image content. You may want to try this 
if Workshare Compare has performed a Standard or Fast comparison and 
some scanned/image content has not been converted to text. 

Note: This type of ‘forced’ OCR may be useful when scanned pages are 
difficult to detect, for example, when they have lots of annotations on top of the 
scans like Bates numbering, etc. or when the text is actually vector output (from 
a CAD product for example) and there are no actual characters with fonts in the 
PDF. 

Workshare Compare re-runs the comparison using the selected mode and displays the 
resulting Redline in the Workshare Compare main window. 

Applying a different rendering set 
You can re-run a comparison using a different rendering set. 

To re-run a comparison with a different rendering set: 

1. In the Home tab, click Select in the Comparison Themes group. A list of the 
currently defined rendering sets is displayed. 

 
2. Select the rendering set to apply. 

Workshare Compare re-runs the comparison using the selected rendering set and 
displays the resulting Redline in the Workshare Compare main window. 
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Changing the comparison options 
You can re-run a comparison changing specific options within the rendering set. 

To re-run a comparison with different options: 

1. In the Home tab, click Edit in the Comparison Themes group. The Rendering 
Sets Manager is displayed. 

 
2. Edit the rendering set parameters as required. For example, select the Ignore 

Tables checkbox. Rendering set parameters are described in Rendering Set 
Parameters. 

3. Do one of the following: 
 Click Apply. Workshare Compare re-runs the comparison using the selected 

parameters and displays the resulting Redline in the Workshare Compare 
main window. Click OK to close the Rendering Sets Manager. Any changes 
you made to the rendering set parameters are lost. 
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 Click OK. The save dialog is displayed. Enter the name of an existing 
rendering set to overwrite a rendering set or enter a new name to create a 
new rendering set. Do not use the following characters when naming 
rendering sets: <, >, :, \, “, /, \\ or |. Click Yes. Workshare Compare re-runs the 
comparison using the revised options and saves the revised options as the 
specified rendering set. Click No. Workshare Compare re-runs the 
comparison using the revised options and saves the revised options as a 
temporary rendering set called “Custom rendering set”.  

Note: The “Custom rendering set” will be selected in the Rendering Set dropdown list 
the next time the Rendering Sets Manager is opened. However, once you navigate 
away from the “Custom rendering set” and a different rendering set is selected and 
the Rendering Sets Manager is closed, the “Custom rendering set” is lost. 

Distributing Redlines 
After you have compared your documents, Workshare Compare provides many options 
for saving or circulating the Redline. Workshare’s DeltaView Redline can be distributed 
in many formats, such as PDF or TXT or DOCX. Only if it is distributed as a WDF will 
your ‘Accept’ and ‘Flag’ selections, as well as the source documents, be included. WDF 
files can only be opened in Workshare Compare. The Redline can also be distributed 
as a Word document with the changes shown as track changes. The following sections 
describe how you can distribute your Redlines: 

• Save locally or to your DMS, refer to Saving Redlines 

• Save to Workshare online, refer to Saving Redlines to Workshare online 

• Share to Workshare online, refer to Sharing Redlines to Workshare online 

• Email, refer to Sending by email 

• Print, refer to Printing Redlines 

• Convert to PDF, refer to Converting Redline to PDF 
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Saving Redlines 
You can save the Redline as a Workshare Compare DeltaFile (WDF), which contains 
all three documents (original, modified and Redline) as well as your ‘Accept’ and ‘Flag’ 
selections. You can also save just the Redline as a DOC/DOCX, RTF, HTM, TXT or 
PDF file or you can save the Redline as a track change document. 

You can save the Redline to your DMS/CRM, SharePoint or locally. The following 
procedure describes how to save to NetDocuments as an example. 

To save the Redline: 

1. Click Save As and then Comparison document in the Home tab (or quick 
access toolbar or File menu). The following dialog is displayed.  

 
2. Select whether you want to save the comparison as a new document or attach it 

to the original or modified documents. 
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3. Click OK. The NetDocuments Save As dialog is displayed.  

 

Note: If you are not working with a DMS or SharePoint, the LocalStore Save As 
dialog is displayed or if you click Cancel in this dialog, a message is displayed 
asking if you would like to save the Redline locally. 

Tip! If you are working with a DMS or SharePoint but both documents 
compared are local documents, then you can press the Shift key while clicking 
Save and the LocalStore Save As dialog is displayed. 

4. Browse to the location where you want to save the comparison and modify the 
name of the comparison as required. 
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5. From the Save as type dropdown list, select the format for the saved file from 
the following: 
Workshare DeltaFile 
(*.wdf) 

Saves both the Redline and the source documents, as 
well as your ‘Accept’ and ‘Flag’ selections, as a 
Workshare DeltaFile. This file can only be opened in 
Workshare Compare. 

Word Document 
(*.doc/*.docx) 

Saves the Redline as a Microsoft Word file. The 
source documents and your ‘Accept’ and ‘Flag’ 
selections are not saved. 

Text Only (*.txt) Saves the Redline as a text file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Rich Text Format 
(*.rtf) 

Saves the Redline as an RTF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

HTML Document 
(*.htm) 

Saves the Redline as a HTML document. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Adobe Acrobat File 
(*.pdf) 

Saves the Redline as a PDF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Adobe Acrobat 
PDF/A File (*.pdf) 

Saves the Redline as a PDF/A file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

6. Click Save. 

Saving Redline as track change document 
You can also save the Redline as a Microsoft Word file that shows the changes as track 
changes. 

Note: The converting to track changes functionality is only enabled, if the Enable 
‘Convert to Track Change document’ parameter (Comparison > User Interface 
category) in the Workshare Configuration Manager is selected. 

To save Redlines with changes as track changes: 

1. Click Save As and then Word document with Track Changes in the Home tab 
(or quick access toolbar or File menu). 

2. Select whether you want to save the comparison as a new document or attach it 
to the original or modified documents. 

3. Click OK. The NetDocuments Save As dialog is displayed.  

4. Browse to the location where you want to save the track change document and 
modify the name of the document as required. 
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5. Click Save. The Redline is saved as a Microsoft Word document with the 
changes indicated by track changes. 

When you open the saved file in Microsoft Word, the changes are displayed as track 
changes. 

Opening saved Workshare DeltaFiles 
When a comparison has been saved as a Workshare DeltaFile, you can open it from 
Workshare Compare. 

To open a saved comparison: 

1. Click Open Comparison from the File menu. An Open dialog is displayed. 

Note: Clicking Open when you work with a DMS/CRM or SharePoint accesses 
the DMS/CRM or SharePoint. To open from a local or network drive, hold the 
Shift key down when clicking Open or click Cancel in the DMS/CRM or 
SharePoint open dialog. 

2. Navigate to the location where the comparison is saved and select the WDF file 
you want to open. 

3. Click Open. The selected comparison is opened in Workshare Compare. The 
source documents and the Redline are displayed as well as any ‘Accepted’ and 
‘Flagged’ selections you made in the Change Summary window. 

Saving Redlines to Workshare online 
If you work with Workshare online, you can save Redlines there so they will be 
accessible to you online at all times. 

You can save the Redline as a Workshare Compare DeltaFile (WDF), which contains 
all three documents (original, modified and Redline) as well as your ‘Accept’ and ‘Flag’ 
selections. You can also save just the Redline as a DOC/DOCX, RTF, HTM, TXT or 
PDF file or you can save the Redline as a track change document. 

Note: You can also use Save As and save the Redline to your Workshare sync folder 
and it will be synchronized to Workshare online. Refer to Adding files to Workshare. 
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To save the Redline to Workshare online: 

1. Click Save to My Files and then As Comparison document in the Home tab 
(or File menu). The Save to My Files dialog is displayed. 

Note: If you are not logged in to Workshare online, you will be asked to log in 
before the Save to My Files dialog is displayed. 

 
2. Browse through My Files and select the folder where you want to save the 

comparison. 

Note: To create a new folder, click Create new folder, enter a name for the 
folder and click Create. 

3. In the File name field, modify the name of the comparison as required. 
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4. From the Save as type dropdown list, select the format for the saved file from 
the following: 

Workshare DeltaFile 
(*.wdf) 

Saves both the Redline and the source documents, as 
well as your ‘Accept’ and ‘Flag’ selections, as a 
Workshare DeltaFile. This file can only be opened in 
Workshare Compare. 

Word Document 
(*.doc/*.docx) 

Saves the Redline as a Microsoft Word file. The 
source documents and your ‘Accept’ and ‘Flag’ 
selections are not saved. 

Text Only (*.txt) Saves the Redline as a text file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Rich Text Format 
(*.rtf) 

Saves the Redline as an RTF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

HTML Document 
(*.htm) 

Saves the Redline as a HTML document. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Adobe Acrobat File 
(*.pdf) 

Saves the Redline as a PDF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

Adobe Acrobat 
PDF/A File (*.pdf) 

Saves the Redline as a PDF/A file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved. 

5. Click Save. 

Saving to Workshare online as track change document 
You can also save the Redline to Workshare online as a Microsoft Word file that shows 
the changes as track changes. 

Note: The converting to track changes functionality is only enabled, if the Enable 
‘Convert to Track Change document’ parameter (Comparison > User Interface 
category) in the Workshare Configuration Manager is selected. 

To save Redlines to Workshare online with changes as track changes: 

1. Click Save to My Files and then As Word document with Track Changes in 
the Home tab (or File menu). 

2. In the Save to My Files dialog displayed, select a folder in My Files (or create a 
new one), specify a name for the track change document and click Save. The 
Redline is saved as a Microsoft Word document with the changes indicated by 
track changes. 
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Sharing Redlines to Workshare online  
When you work with Workshare online, you can share Redlines to groups there so you 
can collaborate on them with others.  

You can share the Redline as a PDF file or you can share the Redline as a track 
change document. 

Note: You can also use Save As and save the Redline to a group folder in your 
Workshare sync folder and it will be synchronized to Workshare online. Using this 
method, you could share the entire comparison, including the source files and your 
‘Accept’ and ‘Flag’ selections as a WDF file. Refer to Adding files to Workshare. 

To share the Redline to Workshare online: 

1. Click Share and then As Comparison document in the Home tab (or File 
menu). The Share dialog is displayed. 

Note: If you are not logged in to Workshare online, you will be asked to log in 
before the Share dialog is displayed. 
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2. Enter the name of the group you want to share the Redline with. As you start to 
enter the name, groups are suggested to you. 

 
3. Select a group or enter a new group name and click Create a new group. 

4. Edit the name of the Redline by clicking , modifying the name and then 
clicking . 

5. Click Share. The Redline is saved to the group in Workshare online and a 
confirmation dialog is displayed. 
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6. Continue in one of the following ways: 
 Click Send email to open a new email in Outlook that includes a link to the 

Redline in Workshare online. You can invite people to the group by sending 
the email to them. 

 Click Go to group to open the group in Workshare online where you can 
see the Redline and set group permissions and members. 

Note: Click  to copy the link to the Redline to your clipboard. You can then 
paste this link to another location, for example, an email or an instant message.  

Sharing to Workshare online as track change document 
You can also share the Redline to Workshare online as a Microsoft Word file that shows 
the changes as track changes. 

Note: The converting to track changes functionality is only enabled, if the Enable 
‘Convert to Track Change document’ parameter (Comparison > User Interface 
category) in the Workshare Configuration Manager is selected. 

To share Redlines to Workshare online with changes as track changes: 

Click Share and then as Word document with Track Changes in the Home tab (or 
File menu). The Redline is saved as a Microsoft Word document with the changes 
indicated by track changes and shown in the Share dialog as a DOCX file. Complete 
the share process as described in the procedure above. 

Sending by email 
Workshare Compare integrates with your email system so you can send the Redline as 
well as the original and modified documents as email attachments. You can send the 
entire Redline or just the pages that include changes. You can also send the Redline as 
a Microsoft Word file that shows the changes as track changes. This is useful if the 
recipient does not have Workshare Compare. 

To send a Redline as a PDF: 

Click Email and then Attach as PDF in the Home tab (or File menu). The Redline is 
converted to PDF and a new email window is opened with the PDF attached. 

To send changed pages as a PDF: 

Click Email and then Attach as PDF (only pages with changes) in the Home tab (or 
File menu). The changed pages in the Redline are converted to PDF and a new email 
window is opened with the PDF attached. 



 

69 

Comparing Documents 

To send source documents with the Redline: 

1. Click Email and then More email options in the Home tab (or File menu). The 
Email Comparison Documents dialog is displayed. 

 
2. Select the files to send by selecting one of the following options: 
 Individual documents included in this comparison 

Selecting this option displays a list of the documents included in the 
comparison in the lower pane. Select the checkboxes to the left of the 
documents you want to send. You can click in the Document Name fields 
and modify the names of the documents. 

Note: The original and modified documents are sent in Microsoft Word format 
and the Redline is sent by default as a PDF. Click in the Document Format 
field of the Redline to change the default format, for example, to RTF. 
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 Workshare Compare’s internal file format (DeltaFile) 
Selecting this option sends the compared documents as a DeltaFile which 
contains all three documents (original, modified and Redline) as well as your 
‘Accept’ and ‘Flag’ selections. A DeltaFile can only be opened in Workshare 
Compare. The file extension for a DeltaFile is WDF. 

 

Tip! Click in the Document Name field to change the name of the Redline. 

3. If you only want to include the pages with changes in the Redline, select the 
Only include pages…. checkbox. This is only available when you are sending 
the Redline as a PDF. 

4. Click OK. An email message window is displayed with the selected files as 
attachments. 

5. Enter the recipient(s) name and any other text you want to include and click 
Send. 

Sending by email as track change document 
You can also send the Redline as a Microsoft Word file that shows the changes as track 
changes. 

Note: The converting to track changes functionality is only enabled, if the Enable 
‘Convert to Track Change document’ parameter (Comparison > User Interface 
category) in the Workshare Configuration Manager is selected. 

To send Redlines with changes as track changes: 

Click Email and then Attach as Word document with Track Changes in the Home 
tab (or File menu). The Redline is saved as a Microsoft Word document with the 
changes indicated by track changes and a new email window is opened with the Word 
document attached. 
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Printing Redlines 
You can print the entire Redline or just the pages that have changes, as well as either 
of the source documents. 

To print the comparison documents: 

1. Click Print in the Home tab (or File menu) and then one of the following options: 
 Comparison only 
 Comparison + Modified 
 Comparison + Modified + Original 

The Print dialog is displayed. 

 
2. Select from the standard print options in the usual way. 

3. If you are printing to a black and white printer, select the Print Redline in black 
and white checkbox, as color text may not appear clearly when printing in black 
and white.  

4. If you only want to print pages of the Redline that include changes, select the 
Only print pages with changes checkbox. 

5. Click OK. 

Note: You can preview the printed version of the Redline, original or modified 
document using the Print Preview options in the File menu. 
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Converting Redline to PDF 
You can convert the Redline to PDF and save it locally or in your DMS or you can 
attach the PDF to an email and send. 

To convert a Redline to PDF: 

1. Click PDF in the Home tab. The Convert to PDF dialog is displayed. 

 

Note: This dialog displays slightly differently depending on whether you are 
working with a document saved in your DMS/CRM. 

2. Select whether you want to convert the Redline to PDF or PDF/A. 
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3. If required, click Configure PDF Security to set PDF security options as well as 
metadata cleaning options. The following dialog is displayed. 

 
4. If you selected PDF, you can select one or more of the security options as 

required: 
 Prevent printing: Prevents recipients from printing the PDF document. 
 Prevent editing of text: Prevents recipients with Adobe Distiller from editing 

the PDF document. 
 Prevent the copying of text and/or graphics: Prevents recipients from 

copying graphics or text directly from the PDF document. 
 Prevent comments being added: Prevents recipients with Adobe Distiller 

from adding comments to the PDF document. 
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5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata 
to remove before converting the Redline to PDF. 

 
6. Select metadata elements as required. For a full description of all the metadata 

elements, refer to Cleaning Hidden Data. 

7. Click OK. 

8. If you selected PDF, you can set a password to protect the PDF by entering the 
password twice in the Password protection area. When a password is 
specified, the recipient can only open the PDF after entering this password. 

9. Click Apply. 

10. In the Convert to PDF dialog, when working with a DMS, select whether to save 
the PDF as a new document or as a related document or locally. 
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11. If you want to create a PDF of part of the Redline only, select the Pages radio 
button and specify a page range.  

Note: You can also PDF individual pages by specifying the pages (separated 
by commas) in the Pages field. 

12. If required, click Preview to view the document as a PDF. 

13. To open the PDF once it has been created, select the Open PDF once created 
checkbox. 

14. To attach the PDF to a new email message once it has been created, select the 
Email PDF as an attachment checkbox. 

15. Click Create. The Save as dialog is displayed. 

16. Specify the name and location for the PDF file and click Save. The Redline is 
converted to PDF. 
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Chapter 3. Comparing Presentations 
This chapter describes Workshare Compare for PowerPoint, a standalone application 
that enables you to compare two or more presentations. It includes the following 
sections: 

• Introducing Compare for PowerPoint, page 77, introduces the Workshare 
Compare for PowerPoint application and explains how to launch it. 

• Comparing Presentations, page 78, describes how to compare a presentation 
against an earlier version of the presentation or against a different presentation 
using Workshare Compare for PowerPoint. 

• Workshare Compare for PowerPoint Main Window, page 81, describes the 
Workshare Compare for PowerPoint environment and provides an overview of 
the functionality available. 

• Working with Comparisons, page 87, describes the tools available to you 
when working with the compared presentation after a comparison. 
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Introducing Compare for PowerPoint 
Note: This chapter describes how to compare PowerPoint presentations. The 
comparison of Word documents and PDF files is described in Chapter 2. 

Workshare Compare for PowerPoint is a presentation comparison tool designed to 
make the process of editing and revising presentations as fast and efficient as possible. 
Workshare Compare for PowerPoint enables you to compare Microsoft PowerPoint 
presentations and immediately see any differences between them. In one view, you can 
see both the original and modified presentations with the differences clearly marked as 
well as a written summary of the changes and color-coded thumbnails of the slides 
showing which slides were modified, deleted, and inserted. Presentations stored in your 
DMS or CRM, locally or on your network can be compared. 

To make the review easier, you can select different “comparison themes” to define 
exactly what is compared as well as how changes are displayed. 

What is compared? 
Workshare Compare for PowerPoint provides a comprehensive comparison of two 
Microsoft PowerPoint presentations and can detect the following changes: 

• Slide moves, insertions and deletions 

• Text moves, insertions and deletions 

• Text formatting changes 

• Image and object content changes 

• Text box changes 

• Hyperlink changes 

• Speaker note changes 

• Slide background changes 

Launching Workshare Compare for PowerPoint 
The Workshare Compare for PowerPoint application can be accessed in the following 
ways: 

• Double-click the Workshare Compare for PowerPoint icon on the desktop. 

• From the Start menu, select Programs, Workshare, Workshare Compare for 
PowerPoint. 

• Within Microsoft PowerPoint, click Compare in the Workshare tab. 
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• Right-click a closed Microsoft PowerPoint document (locally or in your DMS) and 
select Compare with Workshare. 

In each case, the Select Presentations for Comparison dialog is displayed from where 
you can select which presentations to compare. 

Comparing Presentations 
You can compare your original presentation against a previous version of the 
presentation or against another presentation entirely. 

To compare presentations:  

1. Double-click the Workshare Compare for PowerPoint desktop icon or from the 
Start menu, select Programs > Workshare > Workshare Compare for 
PowerPoint. The Select Presentations for Comparison dialog is displayed: 

 

Note: Click Cancel if you want to close the Select Presentations for 
Comparison dialog without running a comparison. For example, if you just want 
to open the Workshare Compare for PowerPoint window in order to open a 
previously saved comparison. 
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2. Select the original presentation you want to compare by clicking the Open  
button to the right of the Original Presentation field. 

3. Navigate to the document in your local file system, SharePoint or DMS/CRM and 
click Open. The selected presentation is displayed in the Original Presentation 
field. 

Tip! If you want to compare a recently used file, click the dropdown  in the 
Original Presentation and Modified Presentation fields and select the 
presentations you want to compare. These lists contain the last 8 files you have 
used. 

4. Select the document you want to compare with the original presentation by 

clicking the Open  button to the right of the Modified Presentation field. 

5. Navigate to the document in your local file system, SharePoint or DMS/CRM and 
click Open. The selected presentation is displayed in the Modified 
Presentation field. 

Tip! To swap the original and modified presentations, click . 

6. From the Select Comparison Theme dropdown list, select the comparison 
theme you want to use. Comparison themes contain a set of parameters that 
define exactly what is compared as well as how changes are displayed. You can 
select from the standard comparison themes provided with Workshare Compare 
for PowerPoint or you can create and customize your own comparison themes. 
Refer to Introducing Comparison Themes for further information. 

Note: Clicking  to the right of the Select Comparison Theme field displays 
the Comparison Themes Manager where you can create, modify and delete 
comparison themes. For a full description refer to Appendix B: Configuring 
Comparison Themes. 

7. Click OK. The comparison process is launched and a progress dialog is 
displayed. 

When the comparison is complete, the Workshare Compare for PowerPoint window is 
displayed showing the changes between the selected presentations. For a full 
description of the Workshare Compare for PowerPoint interface, refer to Workshare 
Compare for PowerPoint Main Window. For a description of how to navigate between 
the changes and review the changes in your compared presentations, refer to Working 
with Comparisons. 
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Workshare Compare for PowerPoint from the command line 
Comparisons can be run from the command line. Running DeckCompare.exe /? 
displays a summary of the available command line options when the program starts up.  

 
The command line parameters are as follows: 

Parameter Definition 
/load <file> Loads an existing comparison file (*.wpf). 
/original <file>  Selects an existing original presentation file for comparison. 
/modified <file>  Selects an existing modified presentation file for comparison. 
/theme <name> Selects the named Comparison Theme. 
/save<file> For an initial comparison from the command line, specifies a 

file to save the comparison to. 

/report <file name> Creates a report of the comparison that includes the original 
and modified slide as well as a list of the changes per slide 
pair. 

/showselector Displays the Select Presentations for Comparison dialog 
enabling you to perform a new comparison. 

/resetwindowlayout Displays the main window in its default layout. 
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Parameter Definition 
/noapply Turns off the Apply Change functionality for the comparison. 

/? Shows the command line options. 

If /load is used, or both /original and /modified, the Select Presentations for Comparison 
dialog is bypassed. Otherwise, the dialog is pre-populated with whichever of /original, 
/modified and /theme are specified. 

Workshare Compare for PowerPoint Main 
Window 
The Workshare Compare for PowerPoint main window enables you to view the results 
of a comparison between an original presentation and a modified presentation. You can 
view (in one work area) both source presentations, slide thumbnails and a summary of 
the changes between the two source presentations. 

 
The ribbon changes according to the selected tab. In the above example, the Home tab 
is selected so the Home ribbon is displayed. 
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The different areas of the Workshare Compare for PowerPoint work area are described 
in the following sections. 

File menu 
The File menu includes the following options: 

Option Description 
Open Enables you to open a saved comparison. 

Comparisons are saved as Workshare 
.wpf files. Refer to Opening saved 
Workshare Compare for PowerPoint files. 

Save Enables you to save the current 
comparison. Refer to Saving 
comparisons. 

Save As Enables you to save a saved comparison 
with a new name. 

Print Enables you to print a comparison report 
showing the changes found by the 
comparison. Refer to Printing comparison 
reports. 

About Displays version information about 
Workshare Compare for PowerPoint. 

Exit Closes Workshare Compare for 
PowerPoint. 

Quick access toolbar 
The quick access toolbar provides one-click access to functionality. By default, the 
Save and New buttons are available. Clicking the arrow to the right of the quick access 
toolbar displays a menu with the following options: 

Option Description 
Reset Layout Displays the main window in its default layout with the Slide 

Selector area on the left, the Slide View area on the top 
right and the Change Summary area on the bottom right. 

Minimize the Ribbon Hides the ribbon. 

Note: To change the commands that appear in the quick access toolbar, right-click in 
the ribbon and select Customize Quick Access Toolbar.  
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Home tab 
The Home ribbon enables you to move between slides and changes, as well as apply 
and edit comparison themes. 

 
The options are described in the following table. 

Section Option Description 
Comparison New Opens the Select Presentations for Comparison 

dialog enabling you to perform a new comparison. 
Refer to Comparing Presentations. 

Reports Print Enables you to print a comparison report showing 
the changes found by the comparison. Refer to 
Printing comparison reports. 

 Create Enables you to create a comparison report showing 
the changes found by the comparison. Refer to 
Creating comparison reports. 

Change 
Navigation 

Show 
Changes 

Displays only slides that include changes, hiding 
those slides that have not changed. 

 Change 
Summary 

Displays/hides the Change Summary area. Refer to 
Change Summary area. 

 Current Slide 
Only 

Displays only changes relating to the currently 
displayed slide in the Change Summary area. 

 Find Change Enables you to search for specific text in the Change 
Summary area. Refer to Searching changes. 

 Previous Navigates to the previous change in the Change 
Summary area. The change in also highlighted in the 
Slide View area. Refer to Navigating between 
changes. 

 Next Navigates to the next change in the Change 
Summary area. The change in also highlighted in the 
Slide View area. Refer to Navigating between 
changes. 

 First Navigates to the first change in the Change 
Summary area. The change in also highlighted in the 
Slide View area. Refer to Navigating between 
changes. 
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Section Option Description 
 Last Navigates to the last change in the Change 

Summary area. The change in also highlighted in the 
Slide View area. Refer to Navigating between 
changes. 

Comparison 
Themes 

Select Enables you to select an alternative comparison 
theme from the dropdown list. This comparison 
theme is then applied to the current comparison. 
Refer to Applying Comparison Themes. 

 Edit  Opens the Comparison Themes Manager from 
where you can modify existing comparison themes 
as well as create new comparison themes. Refer to 
Customizing Comparison Themes. 

More tab 
The More ribbon enables you to change the display of the different areas in the main 
window. 

 
The options are described in the following table. 

Section Option Description 
Original/ 
Modified 

Swap Swaps the original and modified presentations and re-
runs the comparison. Refer to Swapping the source 
files. 

Slide/Views Horizontal Displays the original and modified presentations side by 
side in the Slide View area. 

 Vertical Displays the original presentation above the modified 
presentation in the Slide View area. 

 Tabbed Displays the original and modified presentations in tabs 
in the Slide View area. 



 

85 

Comparing Presentations 

Section Option Description 
Zoom Zoom Enables you to change the magnification of the original 

and modified presentations in the Slide View area. 
There are also zoom controls on the right side of the 
status bar.  

 Fit Width Fits the original and modified presentations to the width 
of the Slide View area. 

Slide Selector area 
The Slide Selector area displays thumbnail images of the slides in the original and 
modified presentations. The slides have different colored borders so you can see at a 
glance when a new slide has been inserted or a slide has been deleted or includes 
changes. The border colors are as follows: 

Yellow The content of the slide has changed.  

Green The slide has moved its position (the new position is indicated). 

Red The slide has been deleted. 

Blue The slide is a new inserted slide. 

Slides that have not changed in any way have no colored border. 

In addition, the following icons in between the slide pairs indicate which slide pairs are 
different and which are the same: 

 Both slides in the slide pair are the same. 

 There are differences between the slides in the slide pair. 

The slides currently selected in the Slide Selector area are displayed in the Slide View 
area. 

The Slide Selector area is by default positioned down the left side of the Workshare 
Compare for PowerPoint environment. It can also float over the other windows. Click 
the  and select from the following options: 

 

Tip! You can also use the  to auto-hide the Slide 
Selector area. 
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Slide View area 
The Slide View area displays both presentations that have been compared and clearly 
indicates the changes on each. The presentations are synchronized so that if you select 
a particular slide in the Slide Selector area or a particular change in the Change 
Summary area then that slide or change is shown in both the original and modified 
presentations. 

Changes are marked according to the comparison theme applied to the comparison. 
For example, deleted text could be red and struck through and added text could be blue 
and underlined. 

Change Summary area 
The Change Summary area provides a list of all the changes between the original and 
modified presentations in the order that they occur. Changes can be displayed for all 
slides or on a slide by slide basis. Selecting a change in the Change Summary area 
displays the slides that include the change in the Slide View area and highlights the 
slides in the Slide Selector area. The change that is selected is highlighted in light 
green in the Slide View area. 

The color and formatting of the change in the Change Summary area and in the Slide 
View area is determined by the comparison theme applied to the comparison. For a full 
description of comparison themes, refer to Introducing Comparison Themes. 

You can select changes in the Change Summary area using the mouse or using 
buttons in the Home tab. 

The following information is shown for each change in the Change Summary area: 

Slide Number The number of the original slide and the number of the modified slide 
in the comparison. 

Change 
Numbers 

The number of the change in the comparison. A change may have 
two numbers when it includes two actions. For example, a deletion 
and an addition. 

Type The type of change, such as replaced text, deleted text box, moved 
slide. 

Details Details of the change.  

The icons to the left of each change indicate the type of change as follows: 

 Replacements  Formatting changes 

 Insertions  Slide move source 

 Deletions  Slide move destination 
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The Change Summary area is by default positioned across the bottom of the 
Workshare Compare for PowerPoint environment. It can also float over the other 
windows. Click the  and select from the following options: 

 

Tip! You can also use the  to auto-hide the Change 
Summary area. 

Working with Comparisons 

Navigating changes 
After performing a comparison, you can review the result of the comparison and 
consider the changes between the original and modified presentations. You can move 
between changes by navigating between slides or by navigating between changes. All 
areas of the Workshare Compare for PowerPoint window are synchronized. 

Navigating between slides 
Clicking slides in the Slide Selector area displays the selected slides in the Slide View 
area and shows the changes relating to that slide in the Change Summary area. 

 
The following icons in between the slide pair in the Slide Selector area indicate whether 
the slide has changed or not: 

 The slide has not changed.  

 The slide has changed. 
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In addition, the thumbnail images of the slides in the Slide Selector area have different 
colored borders so you can see at a glance when a new slide has been inserted or a 
slide has been deleted or a slide includes changes. The border colors are as follows: 

Yellow The content of the slide has changed.  

Green The slide has moved its position (the new position is indicated). 

Red The slide has been deleted. 

Blue The slide is a new inserted slide. 

Slides that have not changed in any way have no colored border. 

Navigating between changes 
Clicking a change in the Change Summary area displays the slides that include the 
change in the Slide View area and highlights the slides in the Slide Selector area. The 
change that is selected is highlighted in light green in the Slide View area.  

The color and formatting of the change in the Change Summary area and in the Slide 
View area is determined by the Comparison Theme applied to the comparison. For a 
full description of Comparison Themes, refer to Introducing Comparison Themes. 

 
You can also move between changes in the Change Summary area using the First, 
Last, Previous and Next buttons in the Change Navigation group of the Home tab. 

Note: By default, the Change Summary area provides a list of all changes occurring 
on all slides in the compared presentations. If you want to display just the changes 
that occur on the displayed slide, click the Current Slide Only button in the Change 
Navigation group of the Home tab. 

The Change Summary area indicates the type of change as well as details of the 
change itself, such as the specific text that has been inserted or deleted. 
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Searching changes 
You can search for specific text in the Change Summary area. Workshare Compare for 
PowerPoint can search all text in the Change Summary area or just the text that has 
been changed (inserted, deleted or moved). 

To search changes: 

1. Click the Find Change button in the Change Summary group of the Home tab. 
The Find Changes dialog is displayed. 

 
2. In the Find what field, enter the text that you want to look for. 

3. Select the Match case checkbox if you want to search for identical text in the 
same case. 

4. Select the Search changed text only checkbox if you want to search only the 
text that has been changed. 

5. Click Find. Workshare Compare for PowerPoint searches for the specified text. 
When it is found, the text is highlighted in the Change Summary area and the 
relevant slide is shown in the Slide Selector area and Slide View area. 

6. Click Find Next to search for further occurrences of the specified text. Click Find 
Previous to return to the previously found instance. 

7. Click Close to close the Find Changes dialog. 
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Swapping the source files 
You can re-run a comparison exchanging the original presentation for the modified 
presentation and vice versa. For example, if you selected Presentation A as the original 
presentation and Presentation B as the modified presentation, Workshare Compare for 
PowerPoint shows the changes made to Presentation A to produce Presentation B. You 
can then swap the presentations so that Presentation B is now the original and 
Presentation A is the modified presentation. Workshare Compare for PowerPoint 
automatically re-runs the comparison and shows the changes made to Presentation B 
to produce Presentation A. 

To swap the source presentations: 
Click Swap in the More tab. Workshare Compare for PowerPoint automatically runs a 
new comparison, using the modified presentation as the original presentation and the 
original presentation as the modified presentation. The new comparison is displayed in 
the Workshare Compare for PowerPoint window replacing the previous comparison. 

Saving comparisons 
You can save a comparison as a Workshare Compare for PowerPoint file (.wpf) in your 
DMS or CRM, locally or on your network. This file type can be opened in Workshare 
Compare for PowerPoint. 

To save a comparison: 

1. Click Save in the File menu or quick access toolbar. The Save As dialog is 
displayed. 

2. Navigate to the location where you want to save the file and enter a name for the 
file. 

3. Click Save. 

Note: If you work with Workshare online, you can also use Save As and save the 
comparison to your Workshare sync folder and it will be synchronized to Workshare 
online. Refer to Adding files to Workshare. 

Opening saved Workshare Compare for PowerPoint files 
When a comparison has been saved as a Workshare Compare for PowerPoint file, you 
can open it from the Workshare Compare for PowerPoint main window. 

To open a saved comparison: 

1. Click Open in the File menu. An Open dialog is displayed. 
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Note: If Workshare Compare for PowerPoint is not open, launch it in the usual 
way and click Cancel in the Select Presentations for Comparison dialog so that 
no initial comparison is performed and a blank Workshare Compare for 
PowerPoint main window is displayed. 

2. Navigate to the location where the comparison is saved and select the .wpf file 
you want to open. 

3. Click Open. The selected comparison is opened in Workshare Compare for 
PowerPoint.  

Creating comparison reports 
After you have run a comparison, you can create a report showing the changes found 
by the comparison. The PDF comparison report can include both the original and 
modified slides as well as a list of changes per slide pair or you can select to include 
just the slide pair or just the list of changes. 

To create a comparison report: 

1. Click Create in the Home tab. The Create Comparison Report dialog is 
displayed. 

 
2. In the Choose Report Layout area, select what you want to include in the 

report by selecting one of the following options: 
 Full Comparison Report: Includes the original and modified slide as well as 

a list of the changes per slide pair. 
 Change Summary Only: Includes the list of changes in table format for 

each slide pair. 
 Slide View Only: Includes the original and modified slides. 
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3. Select the Exclude Unchanged Slides from Report checkbox if you only want 
to include slides with changes in the report. 

Note: To display the selected comparison report, click Preview. 

4. Click Create. 

5. In the save dialog, browse to a save location and enter a name for the report. 

6. Click Save. The comparison report is generated and saved as a PDF in the 
specified location. 

Printing comparison reports 
After you have run a comparison, you can print a report showing the changes found by 
the comparison. The comparison report can include both the original and modified 
slides as well as a list of changes per slide pair or you can select to include just the 
slide pair or just the list of changes. 

If you have created a comparison report already and saved it as a PDF (as described in 
Creating comparison reports) you can simply print the PDF in the usual way. The 
following procedure describes how to create and print a comparison report in one step. 

To print a comparison report:  

1. Click Print in the Home tab or File menu. The Print Comparison Report dialog is 
displayed. 

2. In the Choose Report Layout area, select what you want to include in the 
report by selecting one of the following options: 
 Full Comparison Report: Includes the original and modified slide as well as 

a list of the changes per slide pair. 
 Change Summary Only: Includes the list of changes in table format for 

each slide pair. 
 Slide View Only: Includes the original and modified slides. 

3. Select the Exclude Unchanged Slides from Report checkbox if you only want 
to include slides with changes in the report. 

4. In the Printer area, select which printer to use. 

5. In the Print Range area, select whether to include all slides or selected slides.  

6. In the Copies area, enter how many copies of the comparison report you want to 
print and select the Collate checkbox if collating of multiple copies is required. 

Note: To display the selected comparison report, click Preview. Note that the 
full report is displayed for preview even if a page range has been specified. 

7. Click OK. The comparison report is created and printed as specified. 



 

93 

Protecting Documents 

Chapter 4. Protecting Documents 
This chapter describes how to view the content risk in documents as well as remove 
selected content risk from a document. It includes the following sections: 

• Overview – Protection on your Desktop, page 94, introduces the ways in 
which Workshare Protect enables you to protect documents by viewing and 
removing sensitive content risk. 

• Displaying Content Risk in Documents, page 94, describes how to discover 
all content risk in Office documents. 

• Cleaning Hidden Data, page 96, describes how to remove selected types of 
hidden data from a document and from multiple documents. 

• Converting to PDF, page 106, describes how to secure your documents by 
converting to PDF.  
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Overview – Protection on your Desktop 
Note: This chapter describes how to protect documents on your desktop by removing 
metadata and converting to PDF.  The protection of documents when emailing is 
described in Chapter 5: Protecting Attachments. 

Workshare Protect offers complete protection of files to ensure they are fully secure 
before distribution. Discover what hidden metadata remains in your document, clean it 
and then convert the document to PDF ensuring a safe and secure file. 

Protect provides comprehensive content risk protection enabling the discovery and 
removal of hidden sensitive data as well visible sensitive data. Hidden sensitive data 
may include information such as track changes, author’s name, server names, 
keywords, routing slips and authoring trails. Protect integrates with Office providing an 
option to display a comprehensive report of all the content risk in a document, displayed 
according to its risk level (high, medium, low). 

Workshare Protect creates the most secure PDF files available from any application. 
You can quickly and easily convert open and closed Microsoft Office documents into 
PDF or PDF/A removing hidden data from the document and setting security options as 
you do so. Workshare Protect also provides “PDF Anywhere” which is the ability to 
convert a document to PDF from any application. 

Note: PDF creation can also be enforced on email attachments leaving your 
organization. Refer to Chapter 5: Protecting Attachments. 
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Displaying Content Risk in Documents 
Workshare Protect integrates with Microsoft Office to provide an option to discover and 
view content risk in Microsoft Word, Excel or PowerPoint documents. 

To discover content risk in your document:  

1. Open your document and click Content Risk, (Protect group) in the Workshare 
tab. 

Workshare Protect checks the document for content risk. This process may take 
a few moments if your document is large or if it contains large amounts of 
content risk. Once the discovery process is complete, the Document Risk Report 
is displayed showing a summary of the content risk found. 

 
The content risk found is divided into high risk, medium risk and low risk. 

2. To display details of the content risk found, click  to the left of the content risk 
type. 

3. To remove hidden data from the document, use the Remove button. Refer to 
Cleaning Hidden Data, for more details. 

4. To print the report, click Print. 
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Cleaning Hidden Data 
In Microsoft Office documents, once you have discovered the content risk in a 
document, you can remove selected types of hidden data as required. If you want to 
remove hidden data from PDF files or from multiple Microsoft Office documents, you 
can use the Workshare Batch Clean tool. Refer to Batch cleaning. 

To remove hidden data:  

1. Click Remove in the Document Risk Report. The Advanced Options dialog is 
displayed. 

 
A complete list of hidden data that can be removed, reset or converted is listed 
in the dialog. Different options will appear according to the type of document – 
Word, Excel or PowerPoint. For a full description of the different options, refer to 
Cleaning options. 

2. Select the hidden data you want to remove by selecting the checkboxes to the 
left of the options. 

3. After making your selection, click OK. The selected hidden data is removed from 
the document. 
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Workshare Protect may take a few moments to clean you document depending on the 
size of the document and the amount of hidden data to be removed. The Document 
Risk Report is updated after the document has been cleaned to show any remaining 
content risk. After cleaning, the document with hidden data removed is still stored in 
memory only. If you want to keep the cleaned document, you now have to save the 
document. 

Batch cleaning 
If you want to remove the same types of hidden data from several documents, you can 
use the Workshare Batch Clean tool to clean multiple documents (up to 256) 
simultaneously. 

To clean multiple documents: 

1. From the Start menu, select All Programs, Workshare, and then Workshare 
Batch Clean. The Batch Clean dialog is displayed. 

 

Note: To view more document types, select All Office files from the Files of 
type dropdown list. If unsupported file types are selected for batch cleaning, 
they will be ignored. 
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2. Select the documents you want to clean. Press the Ctrl or Shift key to select 
multiple documents. 

3. Click Open. The Batch Clean dialog is displayed. 

Tip! An alternative to steps 1, 2 and 3 is to select the documents in Windows 
Explorer, then right-click and select Send To then Batch Clean. 

 
A complete list of hidden data that can be removed, reset or converted is listed 
in the dialog. For a full description of the different options, refer to Cleaning 
options. 

4. Select the hidden data you want to remove by selecting the checkboxes to the 
left of the hidden data options. All the selected files will be cleaned using the 
same options. 
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Tip! Select the Toggle on/off checkbox to select/deselect all the hidden data 
options. 

5. Select one of the following save options: 
 Overwrite files after cleaning: Selecting this option will save the cleaned 

files over the original files, overwriting the existing version. 

Note: You must have ‘write’ permissions on the file in order to overwrite the 
original. If you do not have ‘write’ permissions on all files selected, this option is 
disabled. 

 Save files to new location after cleaning: Selecting this option will save 
the cleaned files to a different location, leaving the original files in their 
original location and in an uncleaned state. Click the browse button and 
select the new save location. 

6. Click Clean. The selected files are cleaned according to your selection. Once 
the process is complete, a report is displayed indicating which files were cleaned 
successfully. 
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7. Click Finish. 

Batch cleaning using a command line 
Batch cleaning can be performed using the command line. 

To batch clean using the command line: 

1. From the Start menu, select Run. 

2. Enter cmd in the Open field and click OK. 

3. Enter the clean command required. Samples are given below: 

• To clean hidden data from the entire hard disk: 
bc-console.exe “c:\” /s /all 

• To clean all hidden data from a single document: 
bc-console.exe “<filepath>” /all 

where <filepath> is the full path to the document to clean. 

• To exclude specific data from the cleaning (here comments and track changes 
are excluded): 
Bc-console.exe “<filepath>” /all /exclude:comments /exclude:trackchanges 

• To clean only specified data from the document (here comments and track 
changes are the data to clean): 
Bc-console.exe “<filepath>” /include:comments /include:trackchanges 

For a complete list of options, type the following command: 
Bc-console.exe/ 
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The options are described in the following table: 

Option Description 
/All All hidden data is removed from the specified documents. 

To leave specified types of hidden data in a document, 
the /All command can be used in conjunction with the 
/Exclude command. 
The /All command cannot be used in conjunction with 
the /Include command. 

/S Hidden data is removed from sub-folders of the specified 
folder. 

/WriteToFolder:[folder] The cleaned file is saved to a specified location. 
If this command is not included the original file is 
overwritten with the cleaned file. 
Cleaned files saved using the /WriteToFolder command 
will have a flat file structure. If files have the same names, 
they will be appended with a number. 

/Exclude:[optionname] Excludes specified types of hidden data from being 
removed. The /Exclude command is used in conjunction 
with the /All command. 
The valid types of hidden data that can be excluded are 
detailed in the optionnames list. 

/Include:[optionname] Specifies which types of hidden data are to be removed. 
The /Include command is used instead of the /All 
command. 
The /Include command cannot be used with the /All 
command or the /Exclude command. 
The valid types of hidden data that can be specified are 
detailed in the optionnames list. 

optionnames The valid types of hidden data that can be used with the 
/Exclude and /Include commands. 
Footnotes, DocumentStatistics, BuiltInProperties, 
Headers, Footers, SmartTags, Template, Authors, 
CustomProperties, DocumentVariables, Fields, Macros, 
RoutingSlip, SpeakerNotes, Links, Reviewers, 
TrackChanges, Comments, SmallText, WhiteText, 
HiddenText, HiddenSlides, AutoVersion, Versions 



 

102 

Protecting Documents 

Cleaning options 
The different hidden data cleaning options that are selected when cleaning an individual 
document or when batch cleaning several documents are explained below: 

Option Description 
Accept changes and 
turn off Track 
Changes (Word and 
Excel) 

Microsoft Word and Excel. Accepts all revisions made to the 
document. The revisions are therefore no longer displayed 
as revisions but rather as text in the document. Track 
changes is also turned off so that further revisions are not 
tracked. 

Convert attached 
template to Normal 
(Word) 

Microsoft Word only. Converts the attached template to 
normal.dot. Automatic style updating is disabled before the 
template is removed. Therefore the formatting and styles in 
your document will not be affected by removing the attached 
template. 
To view the attached template: Click the File menu/Office 
Button, select Options/Word Options and then select Add-
Ins. From the Manage dropdown list, select Word Add-ins 
and click Go. 

Convert field codes 
to text (Office) 

Microsoft Word, Excel and PowerPoint. Converts any field 
codes that exist in a Microsoft Word document to text, for 
example, hyperlinks, table of contents, index. In Microsoft 
Excel and PowerPoint, hyperlinks are converted to text. 

Note: For Microsoft Excel and PowerPoint, hyperlinks are 
the only field codes that exist. 

This prevents the field codes from being updated after you 
have distributed the document. It also prevents errors for 
fields that reference built-in or custom properties that have 
been removed. 

Note: You may want to remove some field codes but not 
others. For example, you may want to clean ‘Include text’ 
field codes, but retain the Table of Contents and Page 
Numbers. To do this you can specify the field codes you 
want to keep in the Protection > Exclude Metadata 
category of the Workshare Configuration Manager, and 
then clean field codes as normal. See Workshare 
Configuration Options for more details. 

To view field codes: Click the File menu/Office Button, select 
Options/Word Options and then select Advanced. Select 
the Show field codes instead of their values checkbox in 
the Show document content area. 
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Option Description 
Delete attachments 
(PDF) 

PDF only. Removes files that are attached to the PDF as a 
whole. 
Attachments that are linked to a specific point in a PDF file 
are not removed. They are treated as markups and will only 
be removed if the Delete markups parameter is selected. 

Delete bookmarks 
(PDF) 

PDF. Removes any bookmarks in a PDF file. 

Delete built-in 
properties (Office) 

Microsoft Word, Excel and PowerPoint. Removes all 
summary properties - author, category, comments, 
company, keywords, manager, title, subject, and hyperlink 
base; and custom properties – text, date and number. 
To view built-in properties: In MS Office 2010/2013, click the 
File menu, select Info and then select Advanced 
Properties from the Properties dropdown list in the right 
panel. In the Properties dialog, select the Summary and 
Contents tabs. In MS Office 2007, click the Office Button, 
select Prepare and then select Properties. In the Document 
Information Panel, select Advanced Properties from the 
Document Properties dropdown list. In the Properties 
dialog, select the Summary and Contents tabs. 

Delete comments 
(Office) 

Microsoft Word, Excel and PowerPoint. Removes any 
comments embedded in the document. 

To display comments: In MS Office 2010/2013, click the 
Review tab and from the Show Markup dropdown list 
(Tracking group), select Balloons then Show Only 
Comments and Formatting in Balloons. In MS Office 
2007, click the Review tab and from the Balloons dropdown 
list (Tracking group), select Show Only Comments and 
Formatting in Balloons. 

Delete custom 
properties (Office) 

Microsoft Word, Excel and PowerPoint. Removes any 
custom properties that have been added to the document. 
To view document properties: In MS Office 2010/2013, click 
the File menu, select Info and then select Advanced 
Properties from the Properties dropdown list in the right 
panel. In the Properties dialog, select the Custom tab. In MS 
Office 2007, click the Office Button, select Prepare and then 
select Properties. In the Document Information Panel, 
select Advanced Properties from the Document 
Properties dropdown list. In the Properties dialog, select the 
Custom tab. 
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Option Description 
Delete document 
variables (Word) 

Microsoft Word only. Deletes all document variables. 
Document variables are values stored in Microsoft Word 
documents that are used by either field codes or macros. 
These variables may contain confidential information like 
company names or file locations. Even if field codes and 
macros are removed, the variables used may remain in the 
document. 
Variables can be viewed in Microsoft Word in the Visual 
Basic Editor. 

Delete footers (Excel 
and PowerPoint) 

Microsoft Excel and PowerPoint. Removes any footers 
included in the sheet or slide. 
To view headers and footers: Click the Insert tab and select 
Header & Footer (Text group). 

Delete headers 
(Excel and 
PowerPoint) 

Microsoft Excel and PowerPoint. Removes any headers 
included in the sheet or slide. 
To view headers and footers: Click the Insert tab and select 
Header & Footer (Text group). 

Delete hidden slides 
(PowerPoint) 

Microsoft PowerPoint only. Removes hidden slides from 
Microsoft PowerPoint files. Hidden slides are not required for 
a slide show (they are not automatically displayed during a 
slide show) but they may contain confidential information. 

Delete hidden text 
(Word) 

Microsoft Word only. Removes all text that has been 
formatted as hidden. 
To view hidden text: Click the File menu/Office Button, select 
Options/Word Options and then select Display. Select the 
Hidden Text checkbox. 

Delete links (Excel)  Microsoft Excel only. Converts external links in Microsoft 
Excel files to text. The following are examples of external 
links: 
Link to a cell in another Microsoft Excel document. 
Named link to a named reference in another Microsoft Excel 
document. 
Link to another document. 
OLE link that inserts another document as an icon. 
OLE link that inserts another document as text. 

Delete macros 
(Word and Excel) 

Microsoft Word and Excel. Removes VBA macros from a 
document. This feature is not intended as virus protection, 
but rather to protect any confidential information, intellectual 
property or formulas included in the macros. 
To view macros: Click the View tab and select Macros and 
then View Macros. 



 

105 

Protecting Documents 

Option Description 
Delete markups 
(PDF) 

PDF. Removes any markup in a PDF file. 
Markup is a tool used to make comments and annotations to 
PDF documents. 

Delete properties 
(PDF) 

PDF. Removes properties in a PDF file. 

Standard properties are details about a file that help identify 
it, including its title, subject, author, manager, company, 
category, keywords, comments, and hyperlink base. 

Note: Removing properties from a PDF/A file will disable 
its PDF/A status. 

Delete routing slip 
(Word and Excel 
2003) 

Microsoft Word and Excel. Removes all entries from a 
routing slip, as well as the message subject and text. This 
can prevent email addresses of colleagues from being 
unknowingly distributed. This also deletes any envelope 
information, such as recipients, subject, and introduction, 
which are used when sending to a mail recipient. 
Routing slips are not supported in MS Office 2007. 
To view routing slip entries: From the File menu, select Send 
To and then Routing Recipient. To view envelope 
information: From the File menu, select Send To and then 
Mail Recipient. 

Delete Smart Tags 
(Word 2003/2007) 

Microsoft Word only. Removes smart tags from Microsoft 
Word documents. 
Smart tags are added to your documents as you create them 
if the option is enabled. These tags are linked to particular 
text in a document, such as a name, and allow you to 
perform certain actions by selecting the link associated with 
the text. Depending on the smart tag functions you use, they 
may embed extra hidden information in your document. 
Smart tags only exist in Microsoft Office XP to 2010. 
To manage smart tags: In MS Word 2010, right-click a word, 
select Additional Actions and then Options. In MS Word 
2007, click the Office Button, select Word Options and then 
select Proofing. Click the AutoCorrect Options button and 
select the Smart Tags tab. 

Delete Speaker 
Notes (PowerPoint) 

Microsoft PowerPoint only. Deletes all text that appears on 
the Notes Page in a Microsoft PowerPoint presentation. This 
is usually used by speakers to remind them of points during 
a presentation. You may want to remove speaker notes 
before distributing a presentation, as they are not usually 
intended for others to read. 
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Option Description 
Delete text smaller 
than 5pt (Word) 

Microsoft Word only. Removes all text that has been 
formatted with a font size less that 5pt (i.e. 4pt and less). 
Small text can also be detected in Microsoft Excel but it is 
not cleaned. 
To view small text: Click the View tab, select Zoom and 
specify a percentage greater than 100%. 

Delete versions 
(Word 2003) 

Microsoft Word only. Removes any previous versions of the 
document that you may have saved. Previous versions can 
be useful while you are developing a document, but often 
they can contain confidential information that you have 
removed from the main document. 
Document versions are not supported in MS Office 2007. 
To view versions: From the File menu, select Versions. 

Delete white text on 
white background 
(Word) 

Microsoft Word only. Removes all text with a white font that 
has been formatted with a white background color. 
To view such text: Click the Page Layout tab and select a 
color from the Page Color dropdown list (Page Background 
group). 

Turn off versioning 
(Word 2003) 

Microsoft Word only. Turns off the flag to automatically save 
a new version of the document every time the document is 
closed. This applies to local file systems only. Versions can 
still be saved manually by saving a file with a different name. 
Versioning is not supported in MS Office 2007. 

Converting to PDF 
At any time when working on a document in Microsoft Word, Excel or PowerPoint, you 
can convert the document into PDF or PDF/A. This is useful if you want to maintain a 
file in its current format, as PDF documents cannot be edited as easily as Microsoft 
Word, Excel and PowerPoint documents. This functionality is available from within an 
open document or when the document is closed.  

Workshare Protect automatically saves a document before converting to PDF or PDF/A. 
Documents can be stored locally, in SharePoint or in your DMS. 
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To convert a document to PDF or PDF/A: 

1. Start in either of the following ways: 
 With your document open in Microsoft Word, Excel or PowerPoint, click 

Convert to PDF (Protect group) in the Workshare tab. 
 Right-click a closed Microsoft Word, Excel or PowerPoint file on your 

desktop or DMS and select Convert to PDF with Workshare from the 
menu. 

The Convert to PDF dialog is displayed. 

 

Note: If working with a DMS, the dialog looks slightly different to the one above 
and you can select whether to save the PDF as a new document or related 
document in your DMS or as a local file. 

2. Select whether to convert to PDF or PDF/A. 



 

108 

Protecting Documents 

3. Click Configure PDF Security to set PDF security options and remove 
metadata. 

 
4. Select one or more of the following security options: 
 Prevent printing: Prevents users from printing the PDF document. 
 Prevent editing of text: Prevents users with Adobe Distiller from editing the 

PDF document. 
 Prevent the copying of text and/or graphics: Prevents users from copying 

graphics or text directly from the PDF document. 
 Prevent comments being added: Prevents users with Adobe Distiller from 

adding comments to the PDF document. 

Note: These options are disabled and cannot be selected if you selected 
PDF/A in step 2. 
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5. To specify what hidden data to remove before converting it to PDF, click 
Cleaning Options. 

 
6. Select hidden data elements as required. For a full description of all the hidden 

data elements, refer to Cleaning options for further information. 

7. Click OK. 

8. If required, set a password to protect the PDF by entering the password twice in 
the Password protection area. When a password is specified, users can only 
open the PDF after entering this password. 

Note: If you selected PDF/A in step 2, you cannot set a password and the 
Password protection area is disabled. 

9. Click Apply. 



 

110 

Protecting Documents 

10. In the Convert to PDF dialog, if you want to create a PDF of part of the 
document only, select the Pages radio button and specify a page range. 

Note: You can also PDF individual pages by specifying the pages (separated 
by commas) in the Pages field. 

11. In the View and send area, select the Open PDF once created checkbox if you 
want the PDF to be opened once it has been created or select the Email PDF 
as attachment checkbox if you want the PDF to be attached to an email once it 
has been created. 

12. If required, click Preview to view the document as a PDF. 

13. Click Create. 

14. In the save dialog, specify the name and location for the PDF file and click Save. 
The document is converted to PDF or PDF/A. If you selected Open PDF once 
created, the new PDF is opened. If you selected Email PDF as attachment, an 
email message window is displayed with the PDF as an attachment. 

PDF anywhere 
Workshare Protect can convert any document or file to PDF, for example, a page in 
Internet Explorer, an email message or a text file in Notepad. You can create a new 
PDF from the file or add to an existing PDF. 

To convert to PDF from anywhere: 

1. Click Print in the application. 

2. Select Workshare PDF Publisher as the printer.  
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3. Specify other settings as required and click Print. The Output File Name dialog 
is displayed.  

 
4. Specify a name for the PDF in the File name field or, if you want to add to an 

existing PDF, select the Concatenate checkbox and browse to and select the 
existing PDF. 

5. Click OK. The open document is converted to PDF and saved as specified or 
added to an existing PDF. 
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Chapter 5. Protecting Attachments 
This chapter describes the Workshare Protect functionality with regard to identifying 
content risk in emails and their attachments. It includes the following sections: 

• Introducing Attachment Protection, page 113, introduces how Workshare 
Protect protects your files when sending by email. 

• Interactive Protect, page 117, describes how to use Interactive Protect to 
secure your emails. 

• Using the Protect Profile Dialog, page 126, describes how to send secure 
emails using the Workshare Protect Profile dialog. 

• Using the Email Security Dialog, page 132, describes how to send secure 
emails using the Workshare Protect Email Security dialog. 

• Sending Links to your Files, page 146, describes how to use the secure file 
transfer functionality to upload attachments to Workshare online and send 
recipients links to the files. 
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Introducing Attachment Protection 
Note: This chapter describes how to protect documents when emailing by removing 
metadata or converting to PDF or using secure file transfer. The protection of 
documents on your desktop is described in Chapter 4: Protecting Documents. 

Workshare Protect provides security and protection for email attachments. It is able to 
process the emails you send to ensure security in the following ways: 

• Remove metadata from attachments 

• Convert attachments to PDF or PDF/A 

• Send attachments to a secure location and send recipients a link to that location 

• Compress multiple attachments into a single zip file 

Whether Workshare Protect processes your emails is determined by the Apply 
Workshare Protect parameter in the Workshare Configuration Manager (Protection > 
Administration category). Your administrator may have selected that Workshare 
Protect processes emails to external recipients only, emails to internal recipients only, 
all emails or no emails. 

When Workshare Protect is “on”, the user experience when sending emails will vary 
depending on which option your administrator has selected for the After an email with 
attachments is sent show parameter in the Workshare Configuration Manager 
(Protection > Administration category). 

 
When sending emails, you may experience one of the following three options: 

• Interactive Protect panel 

• Protect Profile dialog 

• Email Security dialog 
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Interactive Protect panel 

 
The Interactive Protect panel is displayed when Interactive Protect has been selected 
for the After an email with attachments is sent show parameter in the Workshare 
Configuration Manager (Protection > Administration category). 

The Interactive Protect panel is described in Using Interactive Protect. 
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Protect Profile dialog 

 
The Protect Profile dialog may be displayed in different ways depending on the option 
selected for the After an email with attachments is sent show parameter in the 
Workshare Configuration Manager (Protection > Administration category).  

• Protect Profile dialog using desktop profiles: The Protect Profile dialog is 
displayed after clicking Send. It provides a list of profiles available locally from 
which you can select to apply to your email (shown above). 

• Protect Profile dialog using server profiles: The Protect Profile dialog is 
displayed after clicking Send. It provides a list of profiles available on Workshare 
Protect Server from which you can select to apply to your email. 

The Protect Profile dialog is described in Using the Protect Profile Dialog. 
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Email Security dialog 

 
The Email Security dialog may be displayed in different circumstances depending on 
the option selected for the After an email with attachments is sent show parameter 
in the Workshare Configuration Manager (Protection > Administration category).  

• Email Security dialog while discovering risk: The Email Security dialog is 
always displayed. It is displayed immediately after clicking Send while 
Workshare Protect checks the email against the default profile. The options are 
enabled once the check is complete. 

• Email Security dialog for all mail: The Email Security dialog is always 
displayed. It is displayed after clicking Send once Workshare Protect has 
checked the email against the default profile. 

• Email Security dialog for internal mail only: The Email Security dialog is 
displayed when an email has internal recipients. It is displayed after clicking 
Send once Workshare Protect has checked the email against the default profile. 
For email to external recipients only, the Email Security dialog is not displayed. 
This is only relevant when Apply Workshare Protect is selected for Internal 
Email. 
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• Email Security dialog for external mail only: The Email Security dialog is 
displayed when an email has external recipients. It is displayed after clicking 
Send once Workshare Protect has checked the email against the default profile. 
For email to internal recipients only, the Email Security dialog is not displayed. 
This is only relevant when Apply Workshare Protect is selected for External 
Email. 

• No dialog (process actions transparently): The Email Security dialog is not 
displayed. Workshare Protect processes the email and applies the default profile 
without any user intervention. 

The Email Security dialog is described in Using the Email Security Dialog. 

Using Interactive Protect 
The Interactive Protect panel offers you options to control your documents and secure 
attachments before sending your email.  

• Clean files: Enables you to clean metadata from your attachments.  

• Convert to PDF: Enables you to convert attachments to PDF or PDF/A. 

• Compress all to zip: Enables you to compress all attachments together into one 
zip file. 

• Convert to link: Enables you to send your documents to a secure folder in 
Workshare online and send recipients a link to that location.  
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To work with Interactive Protect: 

Open Outlook and create a new email. Attach one or more files. Immediately 
Workshare Protect reports on the metadata found in a notification across the top of your 
email and the Interactive Protect panel on the right side of your email. 

 

Note: If the Interactive Protect panel doesn’t open automatically, click the notification 
or click Protect Files in the Message tab. 

Using the options in the panel, you can clean metadata from the attachments, convert 
them to PDF and compress them in a zip file – all before sending the email. You can 
preview exactly what the processed attachments will appear like to the recipients 
BEFORE sending the email. Additionally, you can send the attachments to a secure 
location in Workshare online and send a link to that location to the recipients. 
After selecting the required options, you must click Apply and then you can write your 
email while the changes are being applied before finally clicking Send once you are 
confident that what you are sending is secure and safe. 

If you do NOT click Apply before sending the email, one of two things can happen: 

• If the parameter to automatically apply on send is selected in the Workshare 
Configuration Manager (Protection>Interactive Protect category), the 
Interactive Protect settings made in the panel will still be applied when you click 
Send. 

• If the parameter is not selected, no processing will occur. 
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Note: If you create an email with an attachment, clean with Interactive Protect and 
then close the email, you are not prompted to save the email BUT the email is saved 
to your drafts folder. 

Cleaning metadata using Interactive Protect 
In the Interactive Protect panel, you can leave the Remove metadata checkbox 
selected (this is selected by default) and click Apply. All metadata is removed from all 
the attachments. 
To select specific metadata to remove from each attachment, you can expand the 
Clean files section. 

 
You can expand each attachment and adjust the metadata to remove for each one by 
selecting/deselecting the checkboxes. 

Note: To view a detailed report of the metadata found in an attachment, click View 
risk report. 

Click Apply and the selected metadata is removed from each attachment. 
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You can write your email while the attachments are being cleaned and then preview the 
files by opening the cleaned attachments. Finally click Send once you are confident that 
what you are sending is secure and safe. 

Collaborating using Interactive Protect  
When you work with Workshare online, you can send attachments to a secure location 
in Workshare. The attachment to your email is saved in a folder in your Workshare Sent 
folder in Folders and the recipient receives a link to the file.  

To send a link to attachments: 

1. In the Interactive Protect panel, select the Replace all attachments with a link 
checkbox.  

2. To change the permissions set for the attachments in Workshare or to set an 
expiry date, expand the Convert to link section. 
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3. Deselect any of the following permissions for the attachments as required: 
 Recipients must login to access files: When selected, the recipient must 

be a Workshare user and must log into Workshare in order to access the 
files. 

 Recipients can download files: When selected, recipients can download 
the files. 

 Recipients can invite others to this folder: When selected, recipients can 
share the folder where the attachments are stored. 

4. If required, select an expiry date for the files. After this date, recipients will no 
longer be able to access the files. 

5. Select the Get return receipt checkbox if you want to receive an email once the 
recipients have accessed the files. 

6. Click Apply. You can write your email while the attachments are being 
processed and then preview the files in Workshare online by clicking the link. 

Tip! You can clean, convert to PDF or compress the attachments before 
uploading to Workshare using options in the Interactive Protect panel. 

 
If required, click Manage Permissions in the attachments bar and change the 
permissions set for your files. 

7. Finally in your email, click Send once you are confident that what you are 
sending is secure and safe. 
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The attachments are uploaded into a single folder in your Sent folder in Workshare 
online and in the recipients’ Received folder. The name of the folder is whatever you 
entered in the Subject field. 

The folder is created as soon as the attachments are converted to links and if you look 
in Workshare before you click Send, you will see the folder and the names of the files 
with upload pending. 

  
Once your email is sent, the files are uploaded to Workshare. The recipients will receive 
your email straightaway and they can click the link to view the files in Workshare. If the 
files are still uploading, upload pending is displayed. 

Converting attachments to PDF using Interactive Protect 
In the Interactive Protect panel, you can select the Convert selected file(s) checkbox 
in the Convert to PDF section and click Apply and all attachments are converted to 
PDF. 

Tip! You can clean attachments before converting to PDF. You can also convert to 
PDF after converting your attachments to links. 
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To select specific attachments to convert and to specify PDF conversion settings for the 
attachments, you can select the Convert selected file(s) checkbox and expand the 
Convert to PDF section. 

 
• Deselect any attachments you do NOT want converting to PDF. 

• Select whether to convert the attachments to PDF or PDF/A. 

• Select all or some of the following security options: 
 Print: Enables recipients to print PDF files. 
 Edit Text: Enables recipients with Adobe Distiller to edit PDF files. 
 Copy text and/or graphics: Enables recipients to copy graphics or text 

directly from PDF files. 
 Add comments: Enables recipients with Adobe Distiller to add comments to 

PDF files. 

Note: These options are not available if you selected PDF/A. 

• If required, set a password to protect the PDF files by entering the password 
twice. When a password is specified, recipients can only open the PDF files after 
entering this password. 
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Note: This option is not available if you selected PDF/A. 

Click Apply and the selected PDF settings are applied to all attachments that you have 
selected to convert to PDF. 
You can write your email while the attachments are being converted and then preview 
the files by opening the converted attachments. Finally click Send once you are 
confident that what you are sending is secure and safe. 

Compressing attachments using Interactive Protect 
In the Interactive Protect panel, you can select the Compress all checkbox in the 
Compress all to zip section and click Apply and all attachments are compressed into 
a single zip file. 

Tip! You can clean attachments before compressing and then upload the zip file to 
Workshare online. 

To set a password for the zip file, you can select the Compress all checkbox and 
expand the Compress all to zip section. 

 
If required, set a password to protect the zip file by entering the password twice. When 
a password is specified, recipients can only open the zip file after entering this 
password. 
Click Apply and all the attachments are compressed into a single zip file called 
Attachments.zip. 
You can write your email while the attachments are being compressed and then 
preview the files by opening the zip attachment. Finally click Send once you are 
confident that what you are sending is secure and safe. 
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Password protected files and Interactive Protect 
When you attach a password-protected file, Workshare cannot clean or convert the file 
unless you enter the password. Warnings are shown in your email window as follows: 

 
In order to proceed and clean the attachment or convert it to PDF, you must enter the 
open/modify password. 

Click the  icon. The Password required dialog is displayed. 
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Enter the open or modify passwords (or both) and click OK. 
You will now be able to expand the attachment in the Interactive Protect panel and 
select which metadata to remove or whether to convert the attachment to PDF. 

Note: You can send links to password-protected attachments and compress them 
without the need to enter the open/modify password. 

Using the Protect Profile Dialog 
The Protect Profile dialog provides a simple UI that enables you to select what profile to 
apply to your emails. 

A profile is a collection of policies that include a set of instructions to Workshare Protect 
as to what metadata to remove from an email attachment, whether to convert the 
attachment to PDF and whether to upload the attachment to Workshare online and 
send a link instead. 

Metadata settings and PDF instructions are specified per file type – Microsoft Word 
documents, Excel spreadsheets and PowerPoint presentations as well as PDF files. So 
for example, a profile could specify that comments and hidden text should be removed 
from Microsoft Word attachments and the document should be converted to PDF, and 
only hidden worksheets should be removed from Microsoft Excel attachments and they 
should not be converted to PDF. 

Your administrator defines profiles. Your administrator may have adopted a task-based 
approach or recipient-based approach when creating profiles: 

• Task-based profiles: For example, you are working on a legal document and 
sending it to colleagues to receive input. You email it and select the “Working 
Draft” profile which will remove metadata but keep track changes and 
comments. After receiving input and implementing changes, you email it and 
select the “Final Draft” profile which will remove metadata and remove track 
changes and comments. Once you are happy with the document, you email it 
and select the “Final” profile which will remove metadata, track changes and 
comments and convert the document to PDF. 

• Recipient-based profiles: For example, your company has a policy that 
whatever documents you send to opposing counsel, the metadata must be 
removed and the document must be converted to PDF. You therefore have a 
profile called “opposing counsel” which removes metadata and converts to PDF. 
You also have a profile called “Personal” which does nothing. 

These are just examples of the types of profiles that might be defined. If you have any 
questions or requirements regarding the profiles, contact your administrator. 
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To send an email:  

1. Create a new email, attach the required document(s) and click Send. The 
Protect Profile dialog is displayed. 

 
2. Select the profile you want to apply to your attachments and click Send. The 

following profiles are provided with Workshare Protect: 
 Default: Attachments are processed according to the settings in the 

Workshare Configuration Manager. 
 Clean: All metadata is cleaned from Microsoft Word, Excel, PowerPoint and 

PDF attachments. 
 Clean & PDF: All metadata is cleaned from Microsoft Word, Excel, 

PowerPoint and PDF attachments and Microsoft Word, Excel and PowerPoint 
attachments are also converted to PDF. 

 Clean & Secure File Transfer: All metadata is cleaned from Microsoft Word, 
Excel, PowerPoint and PDF attachments and then the attachments are 
uploaded to Workshare online and recipients are sent a link to the 
attachments. Refer to Secure File Transfer Profiles, page 128. 

 Secure File Transfer: Attachments are uploaded to Workshare online and 
recipients are sent a link to the attachments. Refer to Secure File Transfer 
Profiles, page 128. 
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If you want to send your email without Workshare Protect processing the attachments, 
click the arrow on the Send button and select Send without processing.  

If you want to access the Email Security dialog and specify personal settings or 
individual settings for each attachment, click the Advanced Options link. The Email 
Security dialog is displayed with options matching the profile selected. Refer to the next 
section for a description of the Email Security dialog. 

Note: Your administrator may not have enabled the Secure File Transfer profiles or 
the Send without processing option or the Advanced Options link. 

Secure file transfer profiles 
You can upload almost any file to Workshare online and send any recipient a link to 
where the document is stored. All recipients will be able to view the document in 
Workshare online in a browser and those recipients who have a Workshare account will 
also be able to collaborate on the documents by adding comments in real-time and 
uploading versions. 

To securely transfer files: 

1. Create a new email, enter the recipient email addresses and attach the required 
document(s). 

2. Click Send. The Protect Profile dialog is displayed. 
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3. Select Secure File Transfer or Clean & Secure File Transfer (if you want to 
remove metadata from the attachments before uploading them to Workshare 
online). 

 

Note: Click Advanced Options if you want to configure specific user access to 
the documents in Workshare. Refer to Setting advanced options. 

4. Click Send. The attached files are uploaded into a single folder in your Sent 
folder and the recipients Received folder (in Folders in Workshare online). The 
name of the folder is whatever is entered into the Subject field of the email 
followed by the date and time.  

Note: If you are not already logged into Workshare, you may be asked to log in 
first. 
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Setting advanced options 
If your administrator has given you the rights to access the advanced options, you can 
set access rights to documents that you upload to Workshare online to control recipient 
access. Clicking Advanced Options in the Protect Profile dialog enables you to 
configure specific user access to the documents you are uploading to Workshare 
online.  

To configure advanced options: 

1. Create a new email, enter the recipient email addresses and attach the required 
document(s). 

2. Click Send. The Protect Profile dialog is displayed. 

3. Select Secure File Transfer or Clean & Secure File Transfer and click 
Advanced Options. The Advanced Email Security Options dialog is displayed. 

4. Select the Secure File Transfer Action tab. 

 
5. You can configure the following parameters: 

Apply Action When selected the selected profile (Secure File Transfer or 
Clean & Secure File Transfer) is applied to the email. When 
not selected, the email is sent without a profile being applied. 
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Users must 
login to access 
folder 

When selected, the recipient must log into Workshare in order 
to access the file. When not selected, the recipient can 
access Workshare without being a registered user to view 
and download the file only. 

Recipients may 
invite others to 
this folder 

When selected, recipients can forward the link to other 
recipients who will be able to access the file. Unless Users 
must login to access folder is selected, this option is always 
selected. 

Expire access 
to files on: 

You can specify an expiry date for the file. After this date, the 
recipient will no longer be able to access the file. 

Get return 
receipt 

When selected, you will receive an email once the recipient 
has accessed the file. 

Download files When selected, recipients can download the file. 

Note: The default settings of these parameters are set in the Workshare Policy 
Designer. 

6. You specify these settings for the files selected on the left side. So you can 
select multiple files and set the same settings for all or you can select an 
individual file and specify settings individually. 

7. Click Send. The attached files are uploaded into a single folder in your Sent 
folder and the recipients Received folder (in Folders in Workshare online). The 
name of the folder is whatever is entered into the Subject field of the email 
followed by the date and time. 

Receiving links to files in Workshare online 
Recipients of emails sent using secure file transfer from the Protect Profile dialog 
receive an email with details of the name of the file and a link to click to access the file 
in Workshare online. The means of access and options available to the recipient will 
vary depending on whether the recipient is a Workshare user and the settings specified 
by the sender. Scenarios include: 

• When a recipient is a Workshare user, clicking the link displays the location in 
Workshare online where the file (or files) is stored. The file or files are stored in a 
folder with a name that matches the subject of the email. This folder appears in 
the recipient’s Received folder (in Folders in Workshare online). The recipient 
can add comments to the file, upload versions and make changes to the folder 
where the file is stored.  

• If the sender has specified that the recipient need not be a Workshare user, 
clicking the link displays the location in Workshare online where the file (or files) 
is stored. The recipient can view the file and download it. 
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• If the sender has specified that the recipient must be logged in to Workshare, 
clicking the link displays the Workshare login and the recipient must first log in to 
Workshare in order to view the file (or files) and download it. 

• If the sender has specified an expiry date then the link will only work until the 
expiry date. Once the date has passed, the recipient will not be able to access 
the file. 

Using the Email Security Dialog 
When you send an email using the Email Security dialog configuration, Workshare 
Protect checks any attachments to see if they breach any security policies defined in 
the default profile. A security policy defines the conditions that must exist in order for 
Workshare Protect to detect content risk and the actions that should be taken when the 
conditions are met (i.e. content risk is found). 

When deciding which policy to apply, Workshare Protect checks each recipient. If an 
external recipient is found, external policy settings are applied. Only if all recipients are 
internal, are internal policy settings applied. For example, an attached document could 
contain hidden data that should not be sent to external parties but is suitable for 
distribution internally. 

The options available to you depend on the security policies in place in your 
organization and the action specified for a policy breach. The different actions are as 
follows: 

• Block Action: This action blocks your attempts to send the email until the 
offending information is removed. See Resolving blocked emails for more 
information. 

• Alert Action: This action alerts you to content risk contained within your email, 
although you are still able to send the email. See Reviewing alerts for more 
information. 

• Clean Action/Lightspeed Clean Action/PDF Clean: This action cleans the 
attachments before sending the email. See Cleaning hidden data from 
attachments for more information. 

• PDF Action: This action converts attached documents to PDF before sending 
the email. See Converting attachments to PDF for more information. 

Note: Using the Apply Workshare Protect parameter in the Workshare 
Configuration Manager (Protection > Administration category), Workshare Protect 
can be configured to NOT check attachments of emails sent internally or externally 
(or both) to see if they breach any security policies. If you have queries about your 
email security settings, refer to your administrator. 
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Password-protected documents 
When an attachment is encrypted (password-protected), Workshare Protect requires 
the password in order to check the document. Password-protection here refers to the 
file encryption functionality available in Microsoft Word where the user can set a 
password that must be entered in order to open or modify the document. 

Note: This functionality is available by clicking the File menu/Office button, selecting 
Save As and from the Save As dialog, clicking Tools and then selecting General 
Options. 

When sending an email with an attachment that requires a password in order to be 
opened or modified, a Password dialog is displayed. For example, 

 
Enter the password required to open the document in the Open Password or Modify 
Password field and click OK, or you can click Skip and Workshare Protect will not 
check the document. 

When an attachment is a protected document, Workshare Protect also requires the 
password in order to check the document. Protected document refers to the “Protect 
Document” functionality available in Microsoft Word where the user can restrict specific 
users from editing specific sections of the document. The protection settings are 
protected by a password.  

Note: This functionality is available from the Review tab (Protect group) – click 
Restrict Editing (Word 2010/2013) or click Protect Document (Word 2007). 
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When sending an email with an attachment that is a protected document, a Password 
dialog is displayed. For example, 

 
Enter the password required to open the document in the Document Protection 
Password field and click OK, or you can click Skip and Workshare Protect will not 
check the document. 

Send and Protect 
Your administrator may have configured Workshare Protect to include a Send and 
Protect button in your message window. If so, you can click this button instead of 
clicking Send and the Email Security dialog will always be displayed – regardless of 
how the When sending an email with attachments show parameter is configured in 
the WCM. You can then select to clean attachments or convert attachments to PDF as 
required. 



 

135 

Protecting Attachments 

Sending emails 
The following procedure describes how to send emails using the Email Security dialog. 

To send an email: 

Create a new email, attach the required document(s) and click Send. The Email 
Security dialog is displayed. 

Note: If the Email Security dialog while discovering risk option has been selected 
(When sending an email with attachments show parameter, Protection > 
Administration category), the Email Security dialog is displayed immediately while 
Workshare Protect checks the email against the default profile. The options are 
enabled once the check is complete (see example screen below). When this option is 
not selected, a progress bar is first displayed and the Email Security dialog is only 
displayed once the check is complete. 

 
This dialog alerts you to any breaches of security policies in the default profile triggered 
by your email or its attachments. If your administrator has given you permissions, you 
can modify the settings for each attachment. Refer to Quick tour of the Email Security 
dialog for further information about the options available. 

If the Email Security dialog while discovering risk option has been selected and you 
click Send before Workshare Protect has finished checking the email, the email is sent 
and the attachment(s) is processed according the settings in the default profile. This 
mean that the actual metadata that is cleaned and the settings used for converting to 
PDF are taken from the default profile. 

Click Send and Workshare Protect processes the email as specified. 
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Quick tour of the Email Security dialog 
The Email Security dialog includes several tabs. The number of tabs may vary 
according to the policies triggered but there will always be a Summary tab and a 
Policies tab. 

Tip! Click View Risk Report if you want to print a risk report detailing the content risk 
discovered in the attached document(s). The risk report enables you to evaluate the 
content risk contained in the selected attachments. 

Select File area 
The Select File area is the same in every tab. It includes a list of the email attachments 
that have triggered a policy. 

 

For each item, you can see the risk 
level and the actions to be applied to 
the item. You can select individual 
attachments or select the entire list by 
selecting the Select All checkbox. 
When a Clean or PDF action is to be 
applied, you can double-click an item 
in the list to preview what it will look 
like once the actions have been 
applied. For example, if an attachment 
in DOCX format will have the PDF 
action applied, double-clicking this 
DOCX attachment will enable you to 
preview it as a PDF. 
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Summary tab 
The Apply Action area of the Summary tab provides one-click checkboxes to change 
details of the Clean and PDF actions as well as a list of triggered policies which 
provides links to the policies that triggered the actions. 

 

Under Metadata Removal, selecting 
Remove Comments or Remove Track 
Changes cleans comments or track 
changes from the selected attachment. 
Selecting one of the Skip Cleaning 
options means the selected attachment 
is not cleaned at all. Click View Options 
to display all options in the Office 
Metadata/PDF Metadata tabs. 
Under Workshare Secure PDF, 
selecting Convert to PDF means the 
selected attachment is converted into 
PDF. Click View Options to display all 
options in the Convert to PDF tab. 
Under Triggered Policies, there is a list 
of policies triggered by the email and its 
attachments. Click the name of a policy 
to see more information about the policy 
in the Policies tab. 

Note: The availability of checkboxes and options may appear differently depending 
on your organization’s security policies included in the default profile. Any options 
that are disabled have been locked. Refer to your system administrator if you need to 
override these settings. 
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Policies tab 
The View Policies area on the right side of the Policies tab provides detailed 
information about the policies breached by the email and it attachments. 

 

In the Policies tab, you can discover 
more information about what caused a 
breach of policy. Click More/Less to 
display/hide details of each policy as 
required. 

Other tabs 
The Office Metadata tab is included in the Email Security dialog when a Clean or 
Lightspeed Clean action is triggered for an Office file. Refer to Cleaning hidden data 
from attachments, for more information. 
The PDF Metadata tab is included in the Email Security dialog when a PDF Clean 
action is triggered for a PDF file. Refer to Cleaning hidden data from attachments, for 
more information. 
The Convert to PDF tab is included in the Email Security dialog when a PDF action is 
triggered. Refer to Converting attachments to PDF, for more information. 
The ZIP Options tab is included in the Email Security dialog when a Zip action is 
triggered. 
The Secure File Transfer Action tab is included in the Email Security dialog when a 
Secure File Transfer profile is selected in the Protect Profile dialog. Refer to Secure file 
transfer profiles. 
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Resolving blocked emails 
Every time you send an email with an attachment, Workshare Protect checks the 
attachment to see if it breaches any security policies in the default profile. 
Your system administrator can define policies that block any attempt to send emails 
containing certain pre-defined policy triggers. An attempt to send an email or 
attachment that contains one of these policy triggers results in the email being blocked. 
If an email is blocked, the conditions that caused it to be blocked (content, attachment, 
or recipients) must be removed before the email can be sent. 
When you send an email that triggers a Block action, Workshare Protect notifies you 
that your email has been blocked. 

 
To resolve blocked emails: 

1. Click the name of the policy in the Triggered Policies list or select the Policies 
tab to view what content has triggered the email policy. 

2. Click the Close button to close the Email Security dialog. 

3. Make the appropriate changes to the email and/or document(s) by removing or 
modifying the content, attachments or recipients that caused your email to be 
blocked. 

4. If making changes to attachments, re-attach the corrected documents. 

5. Click Send. If you have made all the relevant changes, you should now be able 
to send the email successfully. 
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Reviewing alerts 
Every time you send an email with an attachment, Workshare Protect checks the 
attachment to see if it breaches any security policies in the default profile. 
Your system administrator can define policies that contain certain pre-defined policy 
triggers that alert you to content risk in emails and documents when they are sent by 
email. The Alert action provides information about content or attachments that might 
violate policy, but does not require that the content be removed before sending the 
email. 
When you send an email that triggers an Alert action, Workshare Protect notifies you 
that your email and/or attachment(s) contain content risk.  

 
To find out more about what triggered a policy, click the name of the policy in the 
Triggered Policies list or select the Policies tab. The Policies tab is displayed 
showing the policies triggered on the right side. Click More/Less to display/hide details 
of each policy as required. If required, you can make changes to your email or the 
attached documents to take account of the content risk discovered. 

When you are ready to send the email, click Send. 
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Cleaning hidden data from attachments 
Every time you send an email with an attachment, Workshare Protect checks the 
attachment to see if it breaches any security policies in the default profile. 

Your system administrator can define policies that contain certain pre-defined policy 
triggers that oblige you to clean hidden data from attached documents when they are 
sent by email. The Clean, Lightspeed Clean and PDF Clean actions remove hidden 
data, such as track changes, hidden text, comments, markup and more, from 
attachments. 

Lightspeed cleaning is much faster than regular cleaning because it maintains the 
original structure of the document and redacts hidden data which might contain 
sensitive information. Regular cleaning actually removes the hidden data element from 
the document. With Lightspeed cleaning, formatting track changes which pose no risk 
are left intact. For a detailed description of what is cleaned using each method of 
cleaning, refer to Appendix C: Clean and Lightspeed Clean. 

When you send an email that triggers a Clean, Lightspeed Clean or PDF Clean 
action, Workshare Protect notifies you that your email and/or attachment(s) will be 
cleaned. 

 

Note: For more information on the types of hidden data contained within Microsoft 
Office documents, see Cleaning options. 

If your administrator has enabled you to override the clean hidden data settings and you 
do not want to clean the attachment(s), you can select the Skip Cleaning checkbox (or 
either of the Skip Office Metadata Cleaning or Skip PDF Metadata Cleaning 
checkboxes individually) in the Apply Action area. 
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To clean hidden data: 

1. Select the attachment in the Select File list to specify individual options for a 
single attachment or select the Select All checkbox to select all attachments. 
Any settings will then be applied to all attachments. 

2. Click View Options in the Metadata Removal area or select the Office 
Metadata tab. The Office Metadata tab displays the different hidden data 
cleaning options for Microsoft Office attachments. 

 
3. Select the hidden data that you want to remove by selecting or deselecting the 

relevant checkboxes. 
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4. Click View Options in the Metadata Removal area of the Summary tab or 
select the PDF Metadata tab to display the different hidden data cleaning 
options for PDF attachments. 

 
5. Select the hidden data that you want to remove by selecting or deselecting the 

relevant checkboxes. 

Note: The availability of these options is dependent on whether your 
administrator has enabled you to override the cleaning options in the policy 
settings. Refer to your system administrator if you need to override these 
settings and they are disabled. 

6. Repeat for additional attachments if required. 

7. Click Send to send the email. 

Workshare Protect cleans the hidden data from the attached document(s) according to 
your settings before sending the email. 
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Converting attachments to PDF 
Every time you send an email with an attachment, Workshare Protect checks the 
attachment to see if it breaches any security policies in the default profile. 

Your system administrator can define policies that contain certain pre-defined policy 
triggers that force you to convert documents to PDF when they are sent by email. This 
prevents the document from being edited, ensuring that its formatting remains intact. 
Additional security features enable you to prevent recipients from printing, editing, 
copying from or adding comments to the PDF attachment. 

When you send an email that triggers a PDF action, Workshare Protect notifies you that 
your attachment(s) will be converted to PDF. 

 
If your administrator has enabled you to override the PDF settings and you do not want 
to PDF the attachment(s), you can deselect the Convert to PDF checkbox in the Apply 
Action area. 
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To convert attachments to PDF: 

1. Select the attachment in the Select File list and click View Options in the 
Workshare Secure PDF area or select the Convert to PDF tab. The Convert 
to PDF tab displays the different PDF security settings available. 

 

Note: You can specify individual PDF settings for each attachment or select the 
Select All button. 

2. Select one or more of the following security options: 
 Prevent printing to prevent recipients from printing the PDF document. 
 Prevent editing of text to prevent recipients with Adobe Distiller from editing 

the PDF document. 
 Prevent the copying of text and/or graphics to prevent recipients from 

copying graphics or text directly from the PDF document. 
 Prevent comments being added to prevent recipients with Adobe Distiller 

from adding comments to the PDF document. 

Note: Highlighting text and adding a strikethrough in a PDF is not considered 
editing the text. If you want to prevent users doing this, select Prevent 
comments being added as well as Prevent editing of text. 

3. If required, set a password for access to the PDF by entering the password 
twice in the relevant fields. 

4. If required, select the Reconstruct Hyperlinks checkbox to preserve standard 
URL and bookmark hyperlinks. 
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Note: Selecting the Reconstruct Hyperlinks option can increase the time it 
takes to create a PDF document. Hyperlinks that are preserved using this 
option may not correspond exactly to the location in the original document. 

5. Select the PDF/A checkbox to convert the attachment to PDF/A. 

6. Repeat steps 2 to 5 for additional attachments if required. 

7. Click Send to send the email. 

Workshare Protect converts the attachments to PDF or PDF/A and applies your settings 
before sending the email. 

Sending Links to your Files 
Your administrator may have configured Protect to automatically convert your 
attachments to links according to attachment size or using a shortcut in the attachments 
bar. 

Links shortcut 
Whatever the Protect user experience set up in your environment, when you have a 
shortcut on the attachment bar, you can convert your attachments to links in a single 
click. 

The configuration required for this option is in the Workshare Configuration Manager as 
follows: 

Category Parameter Default 
Protection > Sharing Display Link on 

attachments bar 
Not selected 

Whenever you add attachments to an email, the Link option is displayed in the 
attachments bar. 

 



 

147 

Protecting Attachments 

Click Link and your attachments are converted to links and appear in the body of your 
email. 

 

Note: If required, click Manage Permissions in the attachments bar and change the 
permissions set for your files, such as whether recipients can download the files. 

The attachments are uploaded into a single folder in your Sent folder in Workshare and 
in the recipients’ Received folder. The name of the folder is whatever you enter in the 
Subject field. 

The folder is created as soon as the attachments are converted to links and if you look 
in Workshare before you click Send, you will see the folder and the names of the files 
with upload pending. 

  
Once your email is sent, the files are uploaded to Workshare. The recipients will receive 
your email straightaway and they can click the file names or the View the files button to 
view the files in Workshare. If the files are still uploading, upload pending is displayed. 
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Large attachments 
In order to avoid blocking email with large heavy files, you can upload the files to 
Workshare and send recipients a link to those files. There are several ways this can be 
done depending on your configuration. 

Auto convert 
The configuration required for this option is in the Workshare Configuration Manager as 
follows: 

Category Parameter Default 
Protection > Sharing Automatically convert to link(s) 

when total attachment size 
exceeds (MB) 

No size specified 

If a limit has been set for this parameter, as soon as you attach files above this limit, 
they are automatically converted to links. 

The links appear in the body of your email and the attachments are uploaded into a 
folder in Workshare. 

Attach as Link button 
The configuration required for this option is in the Workshare Configuration Manager as 
follows: 

Category Parameter Default 
Protection > Sharing Display Attach as Link button 

(Outlook) 
Selected 

When auto convert is not set up and your administrator has set a limit on attachment 
size (to avoid large files blocking Exchange), when you try and add a file with a size 
over the specified limit, Microsoft Outlook displays a message such as: 

 
In this case, you can use the Attach as Link button to save the large file to a folder in 
Workshare and send recipients a link to the location. 

The procedure will vary depending on the Protect user experience set up. 
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When Interactive Protect is configured: 

1. Click Attach as Link. 

2. Browse to the file you want to send. 

3. Click Open. A link to the file appears in the body of your email. 

4. Repeat steps 1 to 3 to add further files. 

Once your email is sent, the files are uploaded to Workshare. The recipients will receive 
your email straightaway and they can click the file names or the View the files button to 
view the files in Workshare. If the files are still uploading, upload pending is displayed. 

 

When the Protect Profile dialog is configured: 

1. Click Attach as Link. 

2. Browse to the large file you want to send and click Open.  

3. Add the recipient and message details and click Send. The Protect Profile dialog 
is displayed with only the Secure File Transfer profiles available. 

4. Select the required Secure File Transfer profile and click Send. 

The large file is uploaded to a folder in your Sent folder (in Folders) in Workshare. The 
name of the folder is whatever is entered into the Subject field of the email. The 
recipient receives an email notifying them that file has been uploaded to Workshare 
online and providing a link to the file. 

Auto select convert to link 
The configuration required for this option is in the Workshare Configuration Manager as 
follows: 

Category Parameter Default 
Protection > Interactive 
Protect 

Automatically select ‘Convert to 
link’ when total attachment size 
exceeds (MB) 

No size specified 

If a limit has been set for this parameter and you have Interactive Protect configured, 
when you attach a file over the specified limit, the Replace all attachments with a link 
checkbox in the Convert to link area is selected when the Interactive Panel displays. 
Simply click Apply, complete your email and click Send and your large file will be 
uploaded to a folder in your Sent folder (in Folders) in Workshare. The recipient 
receives an email notifying them that file has been uploaded to Workshare online and 
providing a link to the file. 
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Chapter 6. Working Online 
This chapter describes the Connect element of your installation which brings the online 
secure file sharing, collaboration and storage features of Workshare to your desktop. It 
includes the following sections: 

• Overview, page 151, introduces the online functionality available with 
Workshare. 

• Syncing local files, page 151, describes how to use the Workshare desktop 
app to sync content between your desktop and Workshare online. 

• Getting content online, page 164, describes how to share files to Workshare 
groups from open Office documents and using right-click options. 
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Overview 
With File Share & Sync included in your installation, you can add your files to the 
secure Workshare online platform. Once there, you can access your files from 
anywhere and share them securely with people inside or outside your organization. 

Workshare integrates with Windows Explorer so you can save and organize your files in 
local folders that function seamlessly on your hard drive, but automatically synchronize 
with Workshare online. Workshare also integrates with Office so you can share for 
review, for example, from right inside Word. 

Workshare is available online through a browser at my.workshare.com. Content is 
divided into different areas to suit your needs: 

Folders Use Folders to publish files and make them available to others. 
Within Folders, use My Files to store your own private files that 
you don’t want to share with anyone but you want easy access 
to from anywhere. 

Groups Use groups as workspaces where you can collaborate on files 
with people inside and outside your company.  

Workshare integrates its save and share functionality into your familiar working 
environment: 

• Using the Workshare sync folder on your desktop, you can save and share any 
files to all areas of Workshare online 

• From open Office documents, you can save files to My Files in Workshare and 
share files into Workshare groups 

• From your desktop, you can right click any file and share it to a group in 
Workshare 

In order to access and use Workshare online, you must have a Workshare account. 

Syncing Local Files 
The Workshare sync folder is your local access point to the online services of 
Workshare. Both the Workshare sync folder and the synchronization functionality are 
provided by the Workshare desktop app. 
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What is the desktop app? 
With File Share & Sync included in your installation, the Workshare desktop application 
(the desktop app) is installed. This is an application that syncs content between 
Workshare and your PC so you can access your files and continue collaborating from 
your desktop while offline. The key features of the desktop app are as follows: 

• Synchronization - Synchronizes groups, folders and files between Workshare 
and your desktop. You can be selective about what is synchronized to reduce 
the storage footprint on your local machine. If you can’t work online, as soon as 
you’re back online, the new versions are uploaded right away. 

• Integration - Integrates Windows with Workshare online linking Workshare 
directly to everyday applications – users can save files directly into the 
Workshare sync folder from where they are copied into Workshare online. 

Launching the desktop app for the first time 
The desktop app is launched once the Professional 9 installation is complete. 

 
The installation of the desktop program places an icon in your Windows taskbar for 
basic management and it puts a folder in your Favorites section in Windows Explorer, 
so you can quickly access and save your Workshare content. In order to access and 
use the desktop app, you must log in to it. You only need to perform this login once; in 
future the desktop app will launch automatically when Windows starts. You use your 
Workshare login credentials to log into the desktop app. 
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To log in to the desktop app for the first time: 
• When the desktop app launches after installation, enter the email address and 

password you used to sign up for Workshare and click Sign In. 

Note: You can also display the login page by clicking the Workshare icon on 
your desktop or selecting Programs > Workshare Desktop > Workshare from 
the Start menu. 

The Workshare desktop app looks very similar to Workshare online accessed from a 
browser. 

In fact, from the desktop app, you can do all the things you can do when logging into 
Workshare online through a browser. 

Once you have logged in: 

• Your files and folders from your online Workshare account start to synchronize 
to your local Workshare sync folder 

• The desktop app icon appears in your system tray 

Workshare sync folder 
The Workshare sync folder is your local access point to your online Workshare content. 
You can always find the latest copy of your Workshare files and you can add files to 
Workshare via the sync folder. It appears in your Favorites folder and its default location 
is C:\Users\[user name]\Workshare. You can change the location of the Workshare 
sync folder in Preferences > Sync Settings, described on page 235. 

You can also click Open Workshare Folder from the desktop app main window. 
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In your Workshare sync folder, you will see all your synchronized Workshare files and 
folders, grouped as follows: 

• Folders: Shows all your Workshare files and folders, including files you have 
uploaded, as well as files others have shared with you. There are also three 
default folders: 
 My Files: Includes personal files that you don’t want to share. 
 Received: Includes all the files sent to you by secure file transfer from 

Outlook. 
 Sent Files: Includes all the files you sent out to others by secure file transfer 

from Outlook.  

• Group Files: Includes all your Workshare groups which are flexible workspaces 
ideal for projects that require dynamic conversations. 

If you add, update or delete a file in your Workshare sync folder, it will be added, 
updated or deleted in Workshare online too. Similarly, if you add, update or delete a file 
in a synced folder in Workshare online through the web app on a browser, the changes 
will be seen in the Workshare sync folder. 

The icon to the left of a file/folder indicates its sync status:  

 Waiting to be synchronized or synchronization is in progress 

 Synchronized 

In this two-way file synchronization, updated files are copied in both directions, usually 
with the purpose of keeping the two locations identical to each other. You can control 
what is synced from your desktop just by adding or replacing files in your Workshare 
sync folder. Careful, though because anything you remove from your Workshare sync 
folder will also be removed from your Workshare online content. 

Default sync 
By default, the following files are synchronized: 

• Files you add to My Files 

• Files you add to a shared folder or a group that you own 

• Files others add to a shared folder or a group that you own 

You can select which folders to sync using the selective sync option. Refer to Selective 
synchronization. 
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System tray icon 
The desktop app system tray icon shows the status of the desktop app as follows: 

Icon Status Description 

 
Synced  The files in your local Workshare desktop folder are fully 

synced you’re your online Workshare content.  

 
Sync in 
progress 

The files in your local Workshare desktop folder are 
currently syncing with W your online Workshare content. 

 
Pause Synchronization between your local Workshare desktop 

folder and your online Workshare content is currently 
paused. 

 
Conflict There is a conflict between files in your local Workshare 

desktop folder and files in your online Workshare content. 

 
Upgrade An upgrade is available for the Workshare desktop app. 

 
Offline The desktop app has been placed offline so no 

synchronization can occur. 

Clicking the icon displays the following options: 

Option Description 

Open Workshare 
App 

Opens the Workshare desktop app window. 

Open Workshare 
folder 

Opens the Workshare sync folder. 

Files up to 
date/conflicts 

Indicates that all files are synchronized successfully or if there 
are sync conflicts between the desktop app and Workshare. 

Pause Pauses the current synchronization. The option becomes 
Resume Syncing when synchronization is paused. 

Refresh Refreshes the display and synchronizes with Workshare 
online.  

Recycle Bin Displays the Workshare recycle bin which includes all the 
Workshare files, folders and groups that have been deleted. 

Selective Sync Enables you to select which folders are synchronized between 
your desktop and Workshare online. 

Preferences Enables you to change application settings for the desktop 
app, such as the location of the sync folder or general account 
settings. 

Help and support Provides access to the Workshare knowledge base. 
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Option Description 

Quit Workshare Stops the synchronization between your desktop and 
Workshare online. 

Adding files to Workshare via the sync folder 
You can add most file types to your local Workshare sync folder which will then be 
synchronized with your Workshare online account. You can add files to existing groups 
or folders or create new folders. You cannot create new groups from within the sync 
folder. 

Note: Groups are created in Workshare from the web app or the desktop app. 

You can simply copy/paste or save files into your local Workshare sync folder and they 
will be synchronized to Workshare online by default. However, if you have selected that 
specific folders do not synchronize then files added to those folders will not be 
synchronized. Refer to Selective synchronization. 

To copy/paste to your local Workshare sync folder: 

Drag the files or folders you want to add into your local Workshare sync folder.  
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To save files to the Workshare sync folder: 

1. Open a file – this can be any file, for example, a Word file, a PowerPoint 
presentation or an image file. 

2. Click Save As. 

3. Browse to your Workshare sync folder in Favorites. By default this folder is 
located at Users\[user name]\Workshare. 

4. Browse to a location in any of the 3 areas in Workshare and select an existing 
folder or create a new folder. 

5. Click Save. Your file is now saved in your local Workshare sync folder and it is 
immediately synchronized to Workshare online (unless the selected folder is not 
set to synchronize). 

Files won’t sync from here… 
• Files added to the top level “Workshare” folder in your local sync folder will not 

be synchronized. Files must be added into one of the three areas of Workshare 
– Files & Folders (Classic), Group Files or My Files.  

• New folders added to the Group Files area will not be synchronized – Groups 
can only be created via the web app. 

In either of the above scenarios, the icon next to the file  and a popup message alert 
you that the file/folder cannot synchronize to Workshare. 

 
Clicking View opens the non-syncing folder locally so you address the problem. 
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Restoring deleted files 
From the desktop app, you can access the Workshare online recycle bin where you can 
restore any of your accidentally deleted files, folders or groups. The recycle bin lists all 
your Workshare files and folders (those you own) that have been deleted – you may 
have deleted them using a Web browser, from the desktop app or directly from the 
Workshare sync folder. 

Note: When you have deleted files and folders from the desktop app or the 
Workshare sync folder, you will only see the deleted files and folders in the recycle 
bin after synchronization. 

The desktop app provides a window into the Workshare online recycle bin so if you are 
offline, you will not be able to access the recycle bin. 

To access the recycle bin: 

Click Recycle Bin in the left panel. 

 
In the recycle bin you can see: 

• Files, folders and groups owned by you that have been deleted by anyone; and  

• Files, folders and groups owned by anyone that have been deleted by you. 

. You can filter the list to see what was deleted by you and what was deleted by others. 

• Click Restore All to restore all files and folders in the recycle bin back to their 
original location. 

• Click Empty Recycle Bin to permanently delete all files and folders in the 
recycle bin. 
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To restore selected files: 

1. Click Recycle Bin in the left panel. 

2. Select a file or a folder (or several files and folders). The buttons change to 
Restore Selected and Empty Selected. 

 
3. Click Restore Selected to restore the selected folders and files. 

File synchronization 
The desktop app synchronizes your online Workshare content to your PC so you can 
access your files and continue collaborating when offline. By default, the following files 
are synchronized: 

• Files you add to My Files 

• Files you add to a shared folder or a group that you own 

• Files others add to a shared folder or a group that you own 

So if you add any of these files to Workshare via a web browser, they will be synced to 
your desktop and you will be able to access them from the Workshare desktop app (or 
sync folder). Synchronization works both ways so if you delete any of these files from 
the Workshare desktop app (or sync folder), they will be deleted from Workshare online 
and you will no longer be able to access them via a web browser. 
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Synchronization between Workshare online and your desktop occurs in the following 
situations: 

• When logging into the desktop app 

• When a new event occurs on Workshare online, such as a new file uploaded or 
a new version added 

• When a new event occurs in the Workshare desktop app (or sync folder), such 
as a new folder created or a file added 

• When the desktop app has been offline and then you go back online 

• When clicking Refresh in the desktop app system tray menu 

• When clicking Update and Sync in the Selective Sync page 

You can pause synchronization at any time, for example, if you have a slow connection, 
and then restart it when convenient. 

To pause synchronization: 

Click the desktop app system tray icon and select Pause. Synchronization stops. 

To restart synchronization, click the desktop app system tray icon and select Resume. 

Selective synchronization 
You can modify the default synchronization settings so that less files and folders are 
synchronized to your desktop in order to reduce the storage footprint on your local 
machine.  

To select folders to synchronize: 

1. Click the desktop app system tray icon and select Selective Sync or from the 
File menu in the desktop app main window, select Selective Sync. The 
selective sync page is displayed showing the root folders on Workshare – 
Folders and Group Files. 

2. Click a folder to display its subfolders. 

3. Select the folders that you want to synchronize between Workshare and your 
desktop by selecting the checkbox to the left of the folder/subfolder name. 
Selecting or deselecting a folder will automatically select/deselect the subfolders 
belonging to the folder. However, you can select a folder but then manually 
deselect some of its subfolders. Use the Select All checkbox to quickly 
select/deselect all folders. 

Note: By default when a folder or group is shared with you it is selected for 
synchronization. To change this, deselect the Automatically sync new folders 
shared with me checkbox. 
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4. Click Update and Sync. All folders with a selected checkbox will be 
synchronized. The progress of the synchronization is shown in the sync 
progress page. 

Folders that are not synchronized will not appear in your local Workshare sync folder. 

Sync progress 
The sync progress page shows the folders and files currently being synchronized. 

To display the sync progress page: 

When synchronization is in progress, select Sync Progress from the View menu. 

 
The status bar provides a summary of the sync situation and the sync progress report 
provides a detailed view. 

The files being synchronized are shown in a queue format. If you want to move a file in 
the queue, for example, you want to upload a small Word document and it is being held 
up by a large PowerPoint presentation, right-click the file you want to delay and select 
Lower the sync priority. 
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Synchronization conflict 
The sync conflicts page provides a dedicated area where you can deal with file 
conflicts. Possible conflict scenarios include: 

• You have opened a synced file locally and you are editing it. Meanwhile, in the 
web app, a new version is added to the file. When you save the open file, a 
conflict is shown. 

• Two users are working offline and make changes to a file they share. User 1 
goes back online and the revised file is synced to Workshare online as a new 
version. User 2 goes back online and a conflict is shown. 

In your local Workshare sync folder, the file icon shows there is a conflict: 

 

In addition, the desktop app system tray icon shows there is a conflict  and the 
menu includes a Conflicts option: 
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To resolve a conflict: 

1. Click the desktop app system tray icon and click Conflicts. The sync conflicts 
page is displayed listing the files with conflicts. 

2. Expand a file in the sync conflicts page by clicking . The options for resolving 
the conflict are displayed. For example, you may want to add your file as the 
latest version or overwrite your version with the online version. You can always 
opt to keep both files involved in the conflict. Different options are displayed 
according to the particular conflict. 

 
3. Select the option you want to apply and click Resolve. 

Note: When there are no conflicts, the sync conflicts page is not available. 
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Collaborating in Workshare  
Once you have shared folders with other users, those users will be able to access 
Workshare via the web app, view the files in the folder and add comments in real-time. 
If they have permission, they could also add new versions to a file. Any new versions 
will be synchronized to your desktop and you can also add versions to Workshare files 
from your desktop through your Workshare desktop app or your local Workshare sync 
folder. For example, simply open a file from your local Workshare sync folder, edit it and 
save it and it will be synced to Workshare online and appear as a new version. 

 
You can also open any file and save over a file in your local Workshare sync folder. It 
will be synced to Workshare online and appear as a new version. 

Getting Content Online 
As well as using your local Workshare sync folder to get your content online, you can 
use the right-click options and toolbar options added by the Connect element of your 
Professional installation. 

Right-click sharing 
The way to share files and folders from your desktop is to share them to a Workshare 
group. 
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Right-clicking any file on your desktop provides the option to share it to a group. The file 
or folder will be added to the group’s files and all members of the group will be able to 
access it. 

To share to a group: 

1. In Windows Explorer, right-click any file or folder. 

 
2. Select Workshare, then Share to group. 

 
3. Enter the name of the group you want to share the file/folder with. When you 

click in the text box, a list of the most recent groups selected is displayed. As 
you start to enter a name, groups are suggested to you. 
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4. Select an existing group or enter a new group name and click Create a new 
group. 

Note: Click Change Group to remove the specified group so you can select 
another one. 

5. If you want to change the name of the file/folder you are sharing, click  and 
edit the name. 

6. Click Share. The file/folder is uploaded to the specified group in Workshare 
online. If the group is synced, the added file or folder will also appear in the 
selected group in your local Workshare sync folder. 

From open Office documents 
Using Workshare toolbar options, you can save your Office files to Workshare online so 
they will be accessible to you online at all times. You can save them directly to a folder 
in My Files if they are private files that you don’t want to share with anyone or you can 
save them directly to a group if you want to collaborate on them with people inside and 
outside your company. 

You can save Word, Excel and PowerPoint files in their native format or convert them to 
PDF as you save. 

Note: You can also save Redlines to Workshare online from within Workshare 
Compare. Refer to Saving Redlines to Workshare online. 

Additionally, you can display the Workshare Connect panel inside Office which provides 
a window into the document you have shared to a Workshare group. 

Saving to My Files 
The My Files area of Workshare online is where you can securely store your own 
private files that you don’t want to share with anyone but you want easy access to from 
anywhere. 

To save documents to My Files: 

1. Open a file in Microsoft Word, Excel or PowerPoint. 

2. In the Workshare tab, click Save to My Files. The Save to My Files dialog is 
displayed. 
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Note: If you are not already logged into Workshare, you may be asked to log in 
before the Save to My Files dialog is displayed. 

 

Tip! You can also display this dialog using Workshare options in the File menu. 

3. Browse through My Files and select the folder where you want to save the file. 

Note: To create a new folder, click Create new folder, enter a name for the 
folder and click Create. 

4. In the File name field, modify the name of the file as required. 

5. From the Save as type dropdown list, select the format for the saved file from 
the following: 
 Word Document/Excel Workbook/PowerPoint Presentation: Saves the 

file in its native format 
 PDF: Saves the file as a PDF file 
 PDF/A: Saves the file as a PDF/A file 
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6. Click Save. The file is saved to the specified folder in Workshare My Files and 
you can log into Workshare and access the file from anywhere. The following 
notification pops up on your desktop: 

 
You can click View to open the file in Workshare in your browser or click Copy 
link to copy the URL to the file to your clipboard. You can then paste this link to 
another location, for example, an email or an instant message. 

If the Workshare My Files folder is synced, the added file or folder will also appear in 
your local Workshare sync folder 

Once you have saved a file to My Files, you can continue working and making changes 
as required. Clicking Save to My Files again will save the file to Workshare with the 
same name and in the same location as a new version. If you want to save the file to 
My Files as a new file with a different name, click the arrow on the Save to My Files 
button and click Save as. 
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Sharing to a Workshare group 
By sharing files to Workshare groups, you save your file to a group in Workshare and all 
members of that group can access your file and collaborate on it with you.  

To share documents to a group: 

1. Open a file in Microsoft Word, Excel or PowerPoint. 

2. In the Workshare tab, click Share. The Share dialog is displayed. 

Note: If you are not already logged into Workshare, you may be asked to log in 
before the Share dialog is displayed. 

 

Tip! You can also display this dialog using Workshare options in the File menu. 

3. Enter the name of the group you want to share the file with. As you start to enter 
the name, groups are suggested to you. 
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4. Select a group or enter a new group name and click Create a new group. 

5. Edit the name of the document by clicking , modifying the name and then 
clicking . 

6. Click Share. The document is saved to the group in Workshare and a 
confirmation dialog is displayed. 

 
If the Workshare group is synced, the added file or folder will also appear in your 
local Workshare sync folder 

7. Continue in one of the following ways: 
 Click Send email to open a new email in Outlook that includes a link to the 

document in Workshare. You can invite people to the group by sending the 
email to them. 

 Click Go to group to open the group in Workshare in your browser where 
you can see the document, set group permissions and select members. 

Note: Click  to copy the link to the document to your clipboard. You can 
then paste this link to another location, for example, an email or an instant 
message.  
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Monitoring shared files 
The Workshare Connect panel inside Office provides a window into the files you have 
shared to Workshare groups. 

When you have shared a document into a group in Workshare and you open the 
document locally, the Workshare Connect panel provides a view of what is happening 
with your collaboration. You can see the other reviewers (the members of the group) 
and whether they are online at the moment. You can also see how many comments 
have been made on the document and whether any new versions have been added to 
it. With a single click you can open the document in Workshare online via a browser 
and join in the collaboration by viewing comments and making your own comments. 

If you open a shared document in Office and the Workshare Connect panel is not 
displayed, click Toggle Panel in the Workshare tab to display it. When the document is 
not shared to a Workshare group, the panel will look something like this: 
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Once your document is shared, the Workshare Connect panel will provide real-time 
information about the collaboration, like new comments and versions. 

 

New versions 
When another group member adds a new version of the document, you are notified in 
the Workshare Connect panel. Click Download and the new version is downloaded and 
opened. Now the Workshare Connect panel will ask if you’d like to see what’s different 
between this new version and the previous version. With a single click, both versions 
are compared in Workshare Compare. 
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Comments added 
In the Comments tab, you can see the number of comments made on the version of 
the file you are looking at (in orange) as well as the total number of comments on all 
versions of the file. If you want to see the actual comment, click View online and open 
the file in Workshare via a browser so you can view comments and update versions and 
add comments if you want. When comments are made that you have not yet seen, click 
the Unread comments alert and the file is opened in Workshare via a browser. 

Group members 
In the People tab, you can see all members of the group that have access to your 
document. A green light indicates the member is currently viewing the file. The following 
three lists are available: 

• Everyone: All members who have access to the file 

• Reviewers: Any member who has looked at the file 

• Editor: A member who has looked at the file in Word (and had Professional 9 
installed and the Connect panel turned on) 
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Chapter 7. Advanced PDF Functionality 
This chapter describes how to convert a PDF file to a Microsoft Word file as well as 
combine several documents into a single PDF. It includes the following sections: 

• Converting PDF Files to Word Format, page 175, describes how to convert a 
PDF document into Microsoft Word format. 

• PDF Combine, page 177, describes how to combine multiple files into a single 
PDF. 
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Converting PDF Files to Word Format 
Note: This functionality is not available when Workshare Compare is installed in 
Office 2013 environments (and above); they have this functionality built-in. 

Workshare Compare provides accurate conversion of PDF files to Microsoft Word files 
(PDF to DOC/DOCX format) preserving document formatting and page layout. This 
functionality is available from within Microsoft Word and by right-clicking closed PDF 
files on your desktop. 

Converting a PDF document into Word format is useful if you want to edit the 
document, as PDF documents cannot be edited as easily as Word documents. 

Notes: 
Workshare cannot convert secure PDFs, meaning PDF files with security settings 
configured. 

Scanned PDF files will not be converted to editable text – the content remains as an 
image and cannot be edited. 

To convert a PDF: 

1. To convert a PDF document to DOC format: 
 Right-click the closed PDF file and select Open in Word with Workshare. 
 From Microsoft Word, click the Office Button/File menu and select Open. 

Browse to the PDF file and click Open. 
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The Open PDF in Word dialog is displayed. 

 
2. Select a conversion method according to how much of the formatting and layout 

you want to preserve and click OK. The PDF document is converted to Word 
format and is opened in Microsoft Word. 

Notes: 
The name in the title bar will still include the PDF extension. However, the document 
is in DOC/DOCX format. 
 
When converting a PDF file to Word format, the display may vary according to the 
type of PDF. The type of PDF means the software used to create the PDF file. For 
example, Adobe, Amyuni, CutePDF, novaPDF, and so on. 

You must save the document. 
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PDF Combine 
Workshare Protect enables you to combine multiple files into a single PDF or PDF/A 
file. For example, electronic court submissions are required to be submitted as a PDF 
or PDF/A file. Case information can include multiple file formats such as contracts, 
financial spreadsheets and email conversations. 

Protect supports the combination of the following file types into a single PDF file: DOC, 
DOCX, PPT, PPTX, XLS, XLSX, PDF, RTF, TXT, HTML, MSG. 

To combine multiple documents into a single PDF: 

1. In an open Office document, click Combine PDF (Protect group) in the 
Workshare tab or in Windows Explorer or your DMS, right-click one or more files 
that you want to combine into a single PDF and select Combine files in 
Workshare. (You do not have to select all the files to combine at this stage but 
can add them later.) The Combine Files dialog is displayed. 

 
2. Add the additional files you want to include in the single PDF using the buttons 

at the top or by dragging and dropping. Click Add Files to select and add a 
single file and select Add Folder to add multiple files from a selected folder. 

3. Once you have selected the files to combine, arrange the order using the Move 
Up and Move Down buttons. If you want to remove a file from the list, select it 
and click Remove. 
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4. If you only want to include selected pages from a particular document, select the 
file in the list and click Pages Range. 

 
5. Select the Pages radio button and specify the pages to be included into the 

combined PDF as required. 

6. Click OK. 

7. Select whether you want to create a PDF file or a PDF/A file from the Create 
PDF version as dropdown list. 
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8. If you want to set security options for the combined PDF, click Configure PDF 
Security. 

 
9. Select one or more of the following security options: 
 Prevent printing: Prevents recipients from printing the PDF document. 
 Prevent editing of text: Prevents recipients with Adobe Distiller from editing 

the PDF document. 
 Prevent the copying of text and/or graphics: Prevents recipients from 

copying graphics or text directly from the PDF document. 
 Prevent comments being added: Prevents recipients with Adobe Distiller 

from adding comments to the PDF document. 

Note: These options are disabled and cannot be selected if you selected 
PDF/A in step 7. 
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10. To specify what hidden data to remove before converting it to PDF, select the 
Clean before PDF checkbox and click Cleaning Options. 

 
11. Select hidden data elements as required. For a full description of all the hidden 

data elements, refer to Cleaning Hidden Data for further information. 

12. Click OK. 

13. If required, set a password to protect the PDF by entering the password twice in 
the Password protection area. When a password is specified, the recipient can 
only open the PDF after entering this password. 

Note: If you selected PDF/A in step 7, you cannot set a password and the 
Password protection area is disabled. 

14. Click Apply. 

15. If required, click Preview to view the combined PDF. 

16. Click Create PDF. A Save as dialog is displayed. 
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17. Specify the name and location for the combined PDF file and click Save. The 
documents are converted into a single PDF. The progress of the operation can 
be seen in the Status column in the Combine files dialog. 

If you want to save your selection without creating a PDF – for example, if you have not 
completed the selection of documents – you can save your work in progress as a 
Workshare workbook (.WWB) by clicking Save in the Combine Files dialog. When you 
are ready to work on it again, simply right-click the WWB file and select Combine files 
in Workshare or drag new files you want to include over the WWB file. This re-opens 
the Combine Files dialog and you can continue. 

Note: For iManage users, in order to save a Workshare workbook, the WWB file type 
needs to be registered as a file type on the Worksite Server. 

 

Note: If you work with Workshare online, you can also use Save As and save the 
combined PDF to your Workshare sync folder and it will be synchronized to 
Workshare. Refer to Adding files to Workshare. 
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Chapter 8. Configuring Workshare 
This chapter describes the Workshare Configuration Manager. It includes the following 
sections: 

• Introducing the Workshare Configuration Manager, page 183, introduces the 
Workshare configuration utility. 

• Accessing the Workshare Configuration Manager, page 183, describes how 
to access the Workshare Configuration Manager. 

• Setting Parameters, page 185, describes how to set values for parameters in 
the Workshare Configuration Manager. 
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Introducing the Workshare Configuration 
Manager  
The Workshare Configuration Manager is a configuration utility that enables you to 
configure Workshare and the way it behaves as well as modify the configuration of the 
Client Default profile (via the parameters in the Protection category).  

Note: A profile is a collection of policies. A policy is a set of parameters applied by 
Workshare Protect when determining content risk. 

Administrator Mode and User Mode 
The Workshare Configuration Manager has two modes as follows: 

• Administrator Mode: This mode is for administrators to make changes to the 
default settings on the local machine. Settings made are saved in 
HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access 
to Administrator mode if you have Administrator rights. 

• User Mode: This mode is for users to make changes to the Workshare 
configuration to suit their own personal preferences on the local machine. Other 
users could log in and they would not have the same configuration settings. 
Settings made are personal to the user and saved in HKEY_CURRENT_USER 
in the Registry. 

Note: Your system administrator may have restricted the rights of users to modify 
configuration parameters by locking individual parameters so that users cannot 
override the setting. If you have restricted access rights and have special 
requirements for configuration, please speak to your system administrator. 

Accessing the Workshare Configuration 
Manager 
The Workshare Configuration Manager can be accessed from within Microsoft Word or 
from the Start menu. 

To access the Workshare Configuration Manager from Microsoft Word: 
• In Microsoft Word, click Options in the Workshare tab. The Workshare 

Configuration Manager opens in User Mode. 
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To access the Workshare Configuration Manager from the Start menu: 
• From the Start menu, select All Programs > Workshare > Workshare 

Configuration (User Mode). The Workshare Configuration Manager opens in 
User Mode. 

 

Note: In User Mode, the state of the options reflects the settings in 
HKEY_CURRENT_USER in the Registry. 

The configuration parameters for Workshare are grouped into categories and sub-
categories. Click a sub-category to display the parameters for that sub-category. The 
different sub-categories and their parameters are described in a separate guide - 
Workshare Configuration Options.  

Searching parameters 
If you know the name of a parameter (or part of its name) but not its location, you can 
search the Workshare Configuration Manager using the search box on the top right. 
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Click the parameter in the results list and the relevant category and sub-category is 
displayed in the Workshare Configuration Manager. 

Setting Parameters 
Most parameters in the Workshare Configuration Manager are set by selecting or 
deselecting a checkbox. There are also some that require you to enter a value in a text 
box. 

To specify parameters: 

1. In the Workshare Configuration Manager, select a category and then a sub-
category. 

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting 
an option from a dropdown list or entering a value in a text box. 

 

The  icon to the right of a parameter indicates that the parameter value has 
been changed. 

Note: When parameters have been locked by your administrator, the parameter 
will be disabled and a lock symbol will appear to the left of the parameter. You 
cannot change locked parameters. 

3. Continue to select categories and sub-categories and specify parameters as 
required. 
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4. Click Apply to save your settings. A confirmation message is displayed once the 
settings have been saved. 

 
5. Click OK and restart all Microsoft Office applications. 

Note: The different sub-categories and their parameters are described in the 
Workshare Configuration Options guide. 
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Appendix A. Configuring Rendering 
Sets 
This appendix describes how to configure rendering sets for Workshare Compare and 
apply them to a comparison. It includes the following sections: 

• Introducing Rendering Sets, page 188, introduces Workshare rendering sets 
and describes how they determine the look of a Redline. 

• Accessing the Rendering Sets Manager, page 189, describes how to access 
the Workshare Rendering Sets Manager. 

• Customizing Rendering Sets, page 192, describes how to create your own 
rendering sets as well as modify and delete existing rendering sets. 

• Rendering Set Parameters, page 193, provides a detailed description of all the 
parameters included in rendering sets. 
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Introducing Rendering Sets 
Workshare Compare uses colors and different formats in the Redline to enable you to 
see the changes that have been made to the documents. 

For example, the following indications can be used: 

• Deletions in red with a strikethrough 

• Insertions in bright blue with a double underline 

• Moved or cut text in green with a strikethrough 

• Pasted (copied) text in green with a double underline 

• Moved deletions in salmon pink with a strikethrough 

The colors and formats adopted depend on the rendering set applied to the 
comparison. Workshare Compare includes several different rendering sets that you can 
apply as required or you can modify these rendering sets or create your own rendering 
set. 

Note: It is general practice that your system administrator will have been involved in 
creating a set of standard rendering sets for your company to use and may have 
restricted the rights of users to create, delete or modify their own rendering sets. If 
you have restricted access rights and have special requirements for rendering sets, 
please speak to your system administrator. 

Where are rendering sets stored? 
By default, rendering sets are stored in the following locations: 

• The default rendering sets included with Compare are machine-wide rendering 
sets and are stored in a shared documents folder at the following location: C: 
Users > Public > Public Documents > Workshare > Rendering. 

• Any further rendering sets created by users are personal rendering sets and are 
stored in C: Users > (user name) > My Documents > Workshare > Rendering. 
This can be changed by an administrator in the Default location rendering set 
parameter in the Workshare Configuration Manager (Comparison > 
Administration category). 

You can store rendering sets at other locations but you must specify the location (or 
locations) in the Additional locations for rendering sets parameter in the Workshare 
Configuration Manager (Comparison > Administration category). Workshare 
Compare looks in the two default locations (specified above) to create a list of the 
possible rendering sets available and will also look in any additional locations specified 
in this parameter. 
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Applying rendering sets 
You apply a rendering set to a comparison before the comparison is run and you can 
also apply a rendering set at any time after a comparison has been performed. 

To apply a rendering set after the comparison has been run: 
• Refer to Applying a different rendering set 

• Refer to Changing the comparison options 

Accessing the Rendering Sets Manager 
The Rendering Sets Manager is accessible from the Workshare Configuration Manager, 
from Workshare Compare and from the Workshare tab in Microsoft Office. 

From the Workshare Configuration Manager 
Access the Workshare Configuration Manager and select the Rendering Set Manager 
tab. 
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If you have permissions, you can modify and delete existing rendering sets and create 
new rendering sets. Refer to Customizing Rendering Sets. 

Before running a comparison 

Before running a comparison, click  in the Compare Documents dialog. 

 
If you have permissions, you can modify and delete existing rendering sets and create 
new rendering sets. Refer to Customizing Rendering Sets. 

Additionally, you can edit the rendering set parameters as required and click OK. The 
Save Rendering Set dialog is displayed where you can either: 

• Enter the name of an existing rendering set to overwrite a rendering set or enter 
a new name to create a new rendering set. Do not use the following characters 
when naming rendering sets: <, >, :, \, “, /, \\ or |. Click Yes. The updated 
rendering set is saved and it is selected in the Compare Documents dialog. 

• Click No. The revised options are saved as a temporary rendering set called 
“Custom rendering set” and this rendering set is selected in the Compare 
Documents dialog. 
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After running a comparison 
In the Workshare Compare main window, click Edit in the Home ribbon (Comparison 
Themes group). 

 
If you have permissions, you can modify and delete existing rendering sets and create 
new rendering sets. Refer to Customizing Rendering Sets. 

Additionally, you can re-run a comparison changing specific comparison options. Refer 
to Changing the comparison options. 
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Customizing Rendering Sets 
If you have the relevant access rights, you can modify and delete existing rendering 
sets as well as create new rendering sets. 

Note: Depending on how Workshare Compare has been distributed through the 
company, you may or may not have access rights to configure rendering sets. If you 
have any questions about your access rights, please speak to your system 
administrator. 

Modifying existing rendering sets 
If you have permission, you can modify the settings of an existing rendering set. 

To modify an existing rendering set: 

1. In the Rendering Sets Manager, select the rendering set you want to modify 
from the Rendering Set dropdown list. 

 
2. Configure or modify the parameters for the rendering set as follows: 
 Click a category in the left pane to display parameters for that category in 

the right pane. 
 Configure the parameters as required. 

Categories and their parameters are described in Rendering Set Parameters. 

3. Click Save. The modified settings are saved to the selected rendering set. 

Creating new rendering sets 
If you have permission, you can create a new rendering set. You create a new 
rendering set based on an existing rendering set and then modify it as required. 

To create a new rendering set: 

1. In the Rendering Sets Manager, select the rendering set on which you want to 
base your new rendering set from the Rendering Set dropdown list. 
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2. Click Save As. The Save Rendering Set dialog is displayed: 

 
3. Enter a name for the rendering set. Enter the name of an existing rendering set 

to overwrite a rendering set or enter a new name to create a new rendering set. 
Do not use the following characters when naming rendering sets: <, >, :, \, “, /, \\ 
or |. 

4. Click OK. The new rendering set is selected in the Rendering Set dropdown 
list. 

5. Configure or modify the parameters for the rendering set as follows: 
 Click a category in the left pane to display parameters for that category in 

the right pane. 
 Configure the parameters as required. 

Categories and their parameters are described in Rendering Set Parameters. 

6. Click Save. The settings are saved to your new rendering set. 

Deleting rendering sets 
If you have permission, you can delete rendering sets from the Rendering Sets 
Manager. 

To delete a rendering set: 

1. In the Rendering Sets Manager, select the rendering set that you want to delete 
from the Rendering Set dropdown list. 

2. Click Delete. The selected rendering set is deleted. 

Rendering Set Parameters 
The parameters for rendering sets are grouped into the following categories: 

• Comparison Options. 

• Redline Options 

• Redline Rendering 
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The categories appear in the left pane of the Rendering Sets Manager. Selecting a 
category displays the parameters for that category in the central pane. The right hand 
pane show a preview of how the Redline will look with the parameters selected. 

Comparison Options 

 
The Comparison Options category includes parameters that enable you to customize 
how the compare is performed. 

The Comparison Options parameters are described in the following table: 

Parameter Description 
Allow Auto Retry When selected, if a comparison fails for any reason then 

Workshare Compare automatically attempts to perform a 
comparison using reduced settings. Workshare Compare 
methodically and automatically disables the Comparison 
Options selected until it is able to perform a comparison. 
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Parameter Description 
Detect List Numbering 
Changes 

If selected, changes to automatically generated list 
numbers for numbered paragraphs are detected. 

Detect 
Footnote/Endnote 
Numbering Changes 

If selected, changes to the numbering of footnotes and 
endnotes are detected. You may want to deselect this 
parameter yet keep the Compare Footnotes parameter 
selected. This way, changes to the content of footnotes 
and endnotes will be detected but not changes to the 
numbering. 

Compare 
Headers/Footers 

If selected, the headers and footers in the original and 
modified documents are compared. 

Compare Footnotes If selected, the footnotes in the original and modified 
documents are compared. 

Compare at Character 
Level 

If selected, words that are only slightly different from each 
other are compared. For example, if banana has been 
changed to bananas - Workshare Compare shows just an 
insertion of an s in the Redline, rather than showing a 
deletion of banana and an insertion of bananas. This is 
intended to catch simple typing mistakes. 

Compare Numbers at 
Character Level 

As above description, but compares numbers instead of 
characters. 

Ignore Embedded 
Objects/Images 

If selected, embedded objects and images are ignored 
while doing the comparison and will not be displayed in 
the Redline. 
If not selected, the embedded objects and images will 
appear in the Redline (although changes to them are not 
detected unless the Detect changes to Images 
parameter is selected.) 
This option is useful when documents have very large 
images embedded in them which would produce vast 
amounts of data if written to the Redline RTF file and 
would slow down the comparison process and the loading 
of the Redline. 

Ignore Case Changes If selected, any case changes, for example, upper case to 
lower case, made in the modified document are ignored. 

Ignore Text Boxes If selected, any text boxes in the modified document are 
ignored. 
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Parameter Description 
Ignore Field Codes If selected, fields are treated as the same even if their field 

codes differ. So if you have a Date field in the original 
document and an Author field in the same place in the 
modified document, the Redline will not show a change. 
If not selected, field codes are compared and where they 
have changed, the entire original field is shown as deleted 
and the entire modified field is shown as inserted. 

Compare field 
contents as text 

If selected, converts certain field codes to text and then 
compares. If not selected, compares field code only. 
Fields converted to text will not be subject to the Ignore 
Field Codes parameter if that is also selected. 

Note: The following field codes are converted to text: 
TOC, REF, TOA, TA, DATE, TIME, COMMENTS, 
KEYWORDS, AUTHOR, FILENAME, SAVEDATE, 
CREATEDATE, PAGEREF, INDEX, DOCPROPERTY, 
TITLE, MERGEFIELD, NOTEREF, SHAPE, QUOTE. 
Other field codes will be dealt with according to the 
Ignore Field Codes parameter setting. 

For example, where there is a date field that in the original 
document shows 1 Jan 2012 and in the modified updates 
to 31 Jan 2012. When this parameter is selected, the 
Redline will show 131 Jan 2012. Where this parameter is 
not selected, no change will be shown. 

Ignore Tables If selected, any tables in the modified document are 
ignored. 

Display comments in 
Redline 

If selected, comments in the original and modified 
documents are compared. 

Detect Changes to 
Images 

If selected, images in the original and modified documents 
are compared. 
In order for images to be compared, you must ensure that 
the Ignore Embedded Objects/Images parameter is 
NOT selected. 

Ignore auto list 
against manual 
number list changes 

If selected, when an automatically formatted list is being 
compared against a manual list, any changes in the 
manual list are ignored. 

Generally this parameter should NOT be selected. It 
should only be selected in circumstances when one of the 
documents being compared contains automatic list 
numbering and the other document contains manual list 
numbering. 
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Redline Options 

 
The Redline Options category includes parameters that enable you to customize how 
the Redline is displayed and what information is included with the Redline. 

The Redline Options parameters are described in the following table: 

Parameter Description 
General Options  

Include Redline 
statistics 

If selected, statistics about the changes between the 
original and modified documents is displayed in the 
Redline. You can select to display these statistics at the 
start of the document or at the end of the document. 
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Parameter Description 
Include Redline 
Comparison Summary 

If selected, a summary of all the changes is displayed at 
the end of the Redline. The changes are hyperlinked to 
take you directly to the change in the Redline. 

Include Redline Option 
Summary 

If selected, a summary of the options selected in the 
current rendering set is displayed at the end of the 
Redline in the statistics report.  

Display Workshare 
Compare Footers 

If selected, details about the two documents being 
compared are displayed in the footer of the Redline. 

Black And White 
Headers 

If selected, changes detected in the header are rendered 
in black and white. The color scheme set up in the 
rendering set is maintained for changes to all other parts 
of the document. 

Black And White 
Footers 

If selected, changes detected in the footer are rendered in 
black and white. The color scheme set up in the rendering 
set is maintained for changes to all other parts of the 
document. 

Show Moved Deletions If selected, text that was deleted from a section of the 
document and then subsequently moved to a new 
location is indicated. 

Show Changes to 
Spaces 

If selected, any extra spaces that have been added to or 
deleted from the modified document are indicated.  

Show Paragraph 
Changes 

If selected, paragraph markers ( ) of any extra 
paragraphs that have been added to or deleted from the 
modified document are displayed. 

Include file names in 
Redline statistics 

If selected, the names of the compared documents are 
included in the Redline statistics.  

Change Indicator 
Options 

 

Show Hidden Text If selected, hidden text is displayed in the Redline. 

Show Line Numbering If selected, the line number is displayed to the left of each 
line in the margin of the Redline. 

Show Change 
Numbering ToolTips 

If selected, tool tips are displayed when you position the 
cursor over change numbers. 

Show change bars If selected, vertical lines to indicate a change are 
displayed next to each change in the margin of the 
Redline. You can select to display the lines either in the 
Left or Right margin. 
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Parameter Description 
Show change numbers If selected, the change number is displayed next to each 

change in the margin of the Redline. You can select to 
display the number either in the Left or Right margin. 

Readability See the Readability section below. 

Note: The change indicator settings do not show if you open the Redline in Microsoft 
Word. 

Readability 
The Readability option enables you to set at what point insertions and deletions should 
no longer be marked individually but marked as an entire paragraph deleted followed by 
an entire paragraph inserted. The deleted paragraph is as the paragraph appears in the 
original document and the inserted paragraph is as the paragraph appears in the 
modified document. 

For example, the following paragraph showing numerous deletions and insertions is 
quite difficult to read: 
DeltaView Redline with Table of Contents: (Vendor)When performing a Redline where the document contains 
ancontents issue: An error occurs in the number of bullet points when DeltaView does a Redline on a document where 
the table of contents is automatically generated Table of Contents, the DeltaView output does not number the 
sections properly. This happens in DeltaView or if the file format is *.wdf. Workaround: Save the RedlineWord. 
Workaround: Save the table of contents in as a new document or email the Redline as a Word document, it formats 
correctly. We are working with the vendor for a resolutionDOC file and open it in Word before printing. 

It would be much easier to read this paragraph if it was presented as the entire 
paragraph deleted followed by a new paragraph inserted, as follows: 
DeltaView Redline with Table of Contents: (Vendor)When performing a Redline where the document contains an 
automatically generated Table of Contents, the DeltaView output does not number the sections properly. This happens 
in DeltaView or if the file format is *.wdf. Workaround: Save the Redline as a new document or email the Redline as a 
Word document, it formats correctly. We are working with the vendor for a resolution. 
DeltaView Table of contents issue: An error occurs in the number of bullet points when DeltaView does a Redline on a 
document where the table of contents is automatically generated in Word. Workaround: Save the table of contents in as 
a DOC file and open it in Word before printing. 

Obviously, if there were only a few deletions and insertions in a paragraph, then the first 
example is easy to read. 
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With the Readability parameter, you can specify at what point Workshare Compare no 
longer marks deletions and insertions individually but marks the entire paragraph as a 
deletion followed by the new paragraph as an insertion. You specify this by setting a 
readability percentage by dragging the Paragraph Matched Text Threshold slider to 
your required setting. The percentage selected is shown in a tool tip above the slider. 

 
The meaning of the setting is as follows: 

• With readability set at 10%, Workshare Compare will mark insertions and 
deletions individually unless 90% of the paragraph has changed. In other words, 
in most circumstances paragraphs will be displayed in the same way as the first 
example shown previously. Only when more than 90% of the paragraph has 
changed will Workshare Compare display the paragraph as the second 
example. 

• With readability set at 50%, Workshare Compare will mark insertions and 
deletions individually unless 50% of the paragraph has changed. In other words, 
paragraphs will be displayed in the same way as the first example shown 
previously unless more than 50% of the paragraph has changed. 

• With readability set at 90%, Workshare Compare will mark insertions and 
deletions individually unless 10% of the paragraph has changed. In other words, 
in most circumstances paragraphs will be displayed in the same way as the 
second example shown previously. Only when less than 10% of the paragraph 
has changed will Workshare Compare display the paragraph as the first 
example. 

The default setting for readability is 10%. 

Workshare Compare looks at each paragraph separately and assesses its readability 
according to the number of changes in the paragraph. 

Note: When working with tables, Workshare Compare does not treat the entire table 
as a paragraph. Each paragraph within each cell is treated separately. 

Readability only applies to paragraphs that contain both inserted and deleted text 
because such paragraphs may be unclear whereas paragraphs with only insertions or 
deletions do not have such readability problems. 
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Redline Rendering 

 
The Redline Rendering category includes parameters that enable you to customize 
how specific types of changes are displayed in the Redline. 

The Redline Options parameters are presented in the following sections: 

Inserted Text  
The Inserted Text section includes parameters that enable you to customize how you 
would like inserted text to appear in the Redline. 
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The Inserted Text Format parameters are described in the following table: 

Parameter Description 
Inserted Text Color The color of inserted text. 

Inserted Text 
Background 

The color of the background of inserted text. 

Inserted Text Format The format of inserted text. Select from Underline, Double 
Underline, Italic or Strikethrough. 

Surrounding 
Characters 

A keyboard character to go before and after inserted text. 

Deleted Text  
The Deleted Text section includes parameters that enable you to customize how you 
would like deleted text to appear in the Redline. 

 
The Deleted Text Format parameters are described in the following table: 

Parameter Description 
Deleted Text Color The color of deleted text. 

Deleted Text 
Background 

The color of the background of deleted text. 

Deleted Text 
Format 

The format of deleted text. Select from Underline, Double 
Underline, Italic or Strikethrough. 

Surrounding 
Characters 

A keyboard character to go before and after deleted text. 
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Parameter Description 
Deleted Text 
Replacement 
Character 

The character used to replace deleted text. If the Replace 
Deletes with Single Character checkbox is selected, the 
deleted text is replaced with a single instance of the character 
specified. If the Replace Deletes with Single Character 
checkbox is not selected, each character in the deleted text is 
replaced with the character specified. For example, if the word 
compare is deleted and the character specified is X, the word 
appears as XXXXXXX.  

Replace Deleted 
Text with a Single 
Character 

If selected, deleted text is replaced with a single character. If 
you select this checkbox, enter the required character in the 
Replacement Character field. For example, if the word 
compare is deleted and the character specified is X, the word 
appears as X. 

Include summary 
of deletions 

If selected, a summary of deletions is included with the 
Redline. 

Moved Text  
The Moved Text section includes parameters that enable you to customize how you 
would like moved text to appear in the Redline. 
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The Moved Text parameters are described in the following table: 

Parameter Description 
Show Movements If selected, moved text is shown in the Redline. If you leave 

this checkbox unchecked, then any text that has been 
moved is displayed the same as inserted and deleted text. 

Note: Text is only shown as moved if it's over 22 
characters. Anything less will be shown as insertions and 
deletions. This is to prevent showing moved text 
incorrectly. For example, if someone had deleted the 
word "and" from one paragraph and added "and" in 
another, they probably have not moved the text, rather 
they are just changing the individual paragraphs, so 
would want them displayed as insertions and deletions.  

Moved Text Color The color of moved text. 

Moved Text 
Background 

The color of the background of moved text. 

Moved Source Text 
Format 

The format of the source moved text. Select the format of 
the text in its original position from Underline, Double 
Underline, Italic or Strikethrough. 

Moved Destination 
Text Format 

The format of the destination moved text. Select the format 
of the text in its new position from Underline, Double 
Underline, Italic or Strikethrough. 

Move Source 
Surrounding 
Characters 

A keyboard character to go before and after source moved 
text. Specify the characters to surround the text in its 
original position. 

Move Destination 
Surrounding 
Characters 

A keyboard character to go before and after destination 
moved text. Specify the characters to surround the text in 
its new position. 

Change Numbering  
The Change Numbering section includes parameters that enable you to select 
whether change numbers are shown in the Redline and, if so, how they appear. 
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The Change Numbering parameters are described in the following table: 

Parameter Description 
Show Change 
Numbering 

If selected, the number of the change is displayed next to each 
change in the body of the Redline (as superscript).  

Show Change 
Numbering 
before Change 

If selected, the change number is displayed before the change. If 
not selected, the change number is displayed after the change. It 
is recommended to position the change number before the 
change as footnotes often appear after text. This reduces 
confusion. 

Change Number 
Text Color 

The color of change numbers. 

Change Number 
Text Format 

The format of change numbers. Select from a range of formats, 
including Superscript or Bold. 

Font Changes  
The Font Changes section includes parameters that enable you to customize how you 
would like any font changes to appear in the Redline. 

 
The Font Changes parameters are described in the following table: 

Parameter Description 
Show Font Changes If selected, font changes are shown in the Redline. 

Font Change Text 
Color 

The color of font changes. 

Font Change Text 
Background 

The color of the background of font changes. 

Surrounding 
Characters 

A keyboard character to go before and after font changes. 

Note: Insertions and deletions override any font changes. For example, if the 
modified document has new inserted text in a different font, it appears as inserted 
text and not as font change text. 
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Style Changed Text 
The Style Changed Text section includes parameters that enable you to customize 
how you would like any style changes to appear in the Redline. 

 
The Style Changed Text parameters are described in the following table: 

Parameter Description 
Show Paragraph 
Style Changes 

If selected, paragraph style changes are shown in the 
Redline. Paragraph style changes are indicated in words, for 
example, normal to heading two. 

Style Changed 
Label Color 

The color of text in paragraphs where the paragraph style 
has changed. 

Show Character 
Style Changes 

If selected, character style changes are shown in the 
Redline. 

Style Changed 
Color 

The color of character style changes. 

Style Changed 
Background 

The color of the background of character style changes. 

Style Changed 
Format 

The format of character style changes. Select from 
Underline, Double Underline, Italic or Strikethrough. 

Surrounding 
Characters 

A keyboard character to go before and after style changed 
text. 

Note: Changes to heading styles are also shown in the statistics report at the end of 
the Redline. 
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Table Changes 
The Table Changes section includes parameters that enable you to customize how you 
would like any format changes in tables to appear in the Redline. 

 
The Table Changes parameters are described in the following table: 

Parameter Description 
Table Change 
Options 

The way changes in tables are indicated. You can select 
from the following: Changes with surrounding 
characters, Changes without surrounding characters, 
Whole original and modified tables, Whole modified 
table only or Whole modified table only (unmarked). 
Selecting Whole modified table only (unmarked), the 
modified table is shown in the Redline as a new table with 
no changes marked. Selecting Whole modified table only, 
the modified table is also shown in the Redline as a new 
table but it is shown as an insertion. 

Table Cell Inserted 
Color 

The color of inserted cells. 

Table Cell Deleted 
Color 

The color of deleted cells. 

Table Cell Moved 
Color 

The color of moved cells. 

Table Cell Merged 
Color 

The color of merged cells. 

Table Cell Padding 
Color 

The color of padded cells. 
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What are padded cells? 
Padded cells occur when an insert and delete have occurred within a table, a cell 
becomes both an insert and a delete; therefore it creates a padded cell. 

Original Table 
Cell 1 Cell 2 Cell 3 
Cell 4 Cell 5 Cell 6 

Modified Table 
Cell 1 Cell 3 
Cell A Cell B 
Cell 4 Cell 6 

Rendered Table 
Cell 1 Cell 2 Cell 3 
Cell A PADDED CELL Cell B 
Cell 4 Cell 5 Cell 6 
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Appendix B. Configuring Comparison 
Themes 
This appendix describes how to configure comparison themes for Workshare Compare 
for PowerPoint and apply them to a comparison. It includes the following sections: 

• Introducing Comparison Themes, page 210, introduces Workshare Compare 
comparison themes and describes how they determine the look of a 
comparison. 

• Applying Comparison Themes, page 210, describes how to apply a 
comparison theme to a comparison. 

• Customizing Comparison Themes, page 211, describes how to create your 
own comparison themes as well as modify existing comparison themes. 

• Comparison Theme Parameters, page 213, provides a detailed description of 
all the comparison theme parameters. 
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Introducing Comparison Themes 
Workshare Compare for PowerPoint uses colors and different formats in the 
comparison to enable you to see the changes that have been made to the presentation. 

The colors and formats adopted depend on the comparison theme applied to the 
comparison. Workshare Compare for PowerPoint includes a default comparison theme 
that you can apply or you can modify this comparison theme or create your own 
comparison theme. 

Applying Comparison Themes 
You can apply a comparison theme to a comparison before the comparison is run and 
also at any time after a comparison has been performed. 

To apply a comparison theme before the comparison is run: 

In the Select Presentations for Comparison dialog, select a comparison theme from the 
Select Comparison Theme dropdown list. 

To apply a comparison theme after the comparison has been run: 

In the Comparison Themes group of the Home tab, select a comparison theme from 
the Select dropdown list. Workshare Compare for PowerPoint re-performs the 
comparison applying the new comparison theme styles to the resulting comparison. 
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Customizing Comparison Themes 
You can modify existing comparison themes as well as create new comparison themes. 
Comparison themes are created and modified in the Comparison Themes Manager. 

To open the Comparison Themes Manager: 

Select Edit in the Comparison Themes group of the Home tab. The Comparison 
Themes Manager is displayed. 

Note: You can also click  to the right of the Select Comparison Theme field in 
the Select Presentations for Comparison dialog. 

 
Comparison themes are made up of a set of parameters. The comparison theme 
parameters are grouped into categories. The categories appear in the left pane of the 
Comparison Themes Manager. Selecting a category displays the parameters for that 
category in the right pane of the Comparison Themes Manager. The different 
categories and their parameters are described in Comparison Theme Parameters. 
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Creating new comparison themes 
You can create new comparison themes as required to determine the colors and 
formats used in the comparison to distinguish the changes that have been made to the 
presentation. 

To create a new comparison theme: 

1. In the Comparison Themes Manager, click Create New. The Comparison 
Theme Name dialog is displayed. 

 
2. Enter a name for the comparison theme and click OK. 

3. In the Comparison Themes Manager, specify the comparison theme parameters 
as follows: 
 Click a category in the left pane to display parameters for that category in 

the right pane. 
 Configure the parameters as required. 

Categories and their parameters are described in Comparison Theme 
Parameters. 

4. Click Apply. The new comparison theme is saved. 

Note: When you click OK in the Comparison Themes Manager, Workshare Compare 
for PowerPoint re-performs the comparison applying the new comparison theme 
styles to the resulting comparison. 

Modifying existing comparison themes 
You can modify existing comparison themes by changing the parameter settings for the 
comparison theme or changing the name of the comparison theme. You can also delete 
unwanted comparison themes. 

To modify an existing comparison theme: 

1. In the Comparison Themes Manager, select the comparison theme you want to 
modify from the dropdown list. 
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2. Modify the comparison theme parameters as follows: 
 Click a category in the left pane to display parameters for that category in 

the right pane. 
 Configure the parameters as required. 

Categories and their parameters are described in Comparison Theme 
Parameters. 

3. Click Apply. 

Note: When you click OK in the Comparison Themes Manager, Workshare Compare 
for PowerPoint re-performs the comparison applying the new comparison theme 
styles to the resulting comparison. 

To rename a comparison theme: 

1. In the Comparison Themes Manager, select the comparison theme from the 
dropdown list and click Rename. The Comparison Theme Name dialog is 
displayed. 

2. Enter the new name for the comparison theme and click OK. The comparison 
theme is saved with the new name. 

To delete a comparison theme: 

In the Comparison Themes Manager, select the comparison theme that you want to 
delete from the dropdown list and click Delete. The comparison theme is deleted. 

Note: You can delete one of the predefined comparison themes but all predefined 
comparison themes are regenerated when Workshare Compare for PowerPoint is 
launched. 

Comparison Theme Parameters 
The comparison theme parameters for Workshare Compare for PowerPoint are 
grouped into the following categories: 

• Comparison 

• Insertions 

• Deletions 

• Moves 

• Property Changes 

• Font Changes 

• Sensitivity 
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Comparison 
The Comparison category includes parameters that enable you to specify what 
changes Workshare Compare for PowerPoint will detect. 

 
The Comparison parameters are described in the following table: 

Parameter Description 
Detect Changes to Select the specific items that Workshare 

Compare for PowerPoint will detect 
changes to, from the following: Speaker 
Notes, Image Content, Embedded 
Object Content, Item Location and 
Size, Text Formatting, Text Box 
Formatting, Slide Background, 
Hyperlink Target, Autoshape Style and 
Orientation. 

Detect Moved Text If selected, moved text within slides is 
detected. 

Detect Moved Slides If selected, moved slides are detected. 
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Insertions 
The Insertions category includes parameters that enable you to specify how inserted 
text as well as inserted images and objects will be displayed. 

 
The Insertions parameters are described in the following table: 

Parameter Description 
Insertion options Select how insertions are displayed. 

You can select any or a combination of the following 
formatting options for inserted text: Bold, Italic, Underline 
and Strikethrough. (You cannot select Underline and 
Strikethrough.) You also select the font color from the 
Color dropdown list. 
Inserted images and objects are indicated with a dashed 
border in the selected color. 
An example of how inserted text, inserted images and 
inserted charts will look with your selections is shown. 
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Deletions 
The Deletions category includes parameters that enable you to specify how deleted 
text as well as deleted images and objects will be displayed. 

 
The Deletions parameters are described in the following table: 

Parameter Description 
Deletion options Select how deletions are displayed. 

You can select any or a combination of the following 
formatting options for deleted text: Bold, Italic, Underline 
and Strikethrough. (You cannot select Underline and 
Strikethrough.) You also select the font color from the 
Color dropdown list. 
Deleted images and objects are indicated with a dashed 
border in the selected color. 
An example of how deleted text, deleted images and 
deleted charts will look with your selections is shown. 
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Moves 
The Moves category includes parameters that enable you to specify how moved text as 
well as moved images and objects will be displayed. 

 
The Moves parameters are described in the following table: 

Parameter Description 
Move source options Select how the source of moves is displayed. 

You can select any or a combination of the following 
formatting options for source moved text: Bold, Italic, 
Underline and Strikethrough. (You cannot select 
Underline and Strikethrough.) You also select the font 
color from the Color dropdown list. 
The source of moved images and objects is indicated with 
a dashed border in the selected color. 
An example of how source moved text, source moved 
images and source moved charts will look with your 
selections is shown. 
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Parameter Description 
Move destination 
options 

Select how the destination of moves is displayed. 
You can select any or a combination of the following 
formatting options for destination moved text: Bold, Italic, 
Underline and Strikethrough. (You cannot select 
Underline and Strikethrough.) You also select the font 
color from the Color dropdown list. 
The destination of moved images and objects is indicated 
with a dashed border in the selected color. 
An example of how destination moved text, destination 
moved images and destination moved charts will look with 
your selections is shown. 

Property Changes 
The Property Changes category includes parameters that enable you to specify how 
items that have had their properties changed will be displayed. 

 
The Property Changes parameters are described in the following table: 

Parameter Description 
Changed item option Select a color from the Color dropdown list. Images and 

objects that have had their properties changed are 
indicated with a dashed border in the selected color. 
An example of how changed images and charts will look 
with your selection is shown. 
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Font Changes 
The Font Changes category includes parameters that enable you to specify how text 
that has had its font changed will be displayed. 

 
The Font Changes parameters are described in the following table: 

Parameter Description 
Changed font option Select a color from the Color dropdown mist. Text that has 

had its font changed is displayed in the selected color. 
An example of how changed text will look with your 
selection is shown. 
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Sensitivity 
The Sensitivity category includes parameters that enable you to specify how sensitive 
Workshare Compare for PowerPoint should be when detecting changes. 

 
The Sensitivity parameters are described in the following table: 

Parameter Description 
Slide similarity 
threshold (%) 

Specify at what point insertions and deletions should no 
longer be marked individually but marked as an entire 
slide deleted and an entire slide inserted. 
For example, if you set the threshold at 30% and the 
similarity between the slides is calculated to be less than 
30% then they will be shown as an inserted and deleted 
slide. If the similarity is calculated as more than 30% then 
the slides will be shown with changes found to individual 
items on the slides. 
Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the 
slider. 
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Parameter Description 
Text Box similarity 
threshold (%) 

Specify at what point insertions and deletions in text 
boxes should no longer be marked individually but 
marked as an entire text box deleted and an entire text 
box inserted. 
Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the 
slider. 

Table similarity 
threshold (%) 

Specify at what point insertions and deletions in tables 
should no longer be marked individually but marked as 
an entire table deleted and an entire table inserted. 
Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the 
slider. 

Minimum length for 
moved text 

Specify the minimum number of characters to detect as a 
move – moved pieces of text shorter than this threshold 
will be shown as an insertion and a deletion. 
Drag the slider to your required setting. As you drag the 
slider, the length (in characters) is shown as a tool tip 
above the slider. 

Threshold for detecting 
changes in size or 
position 

Specify a threshold which determines how far an object 
must be moved (or by how much its size must be 
changed) for the change to be detected. The threshold 
value is measured in inches. 
Drag the slider to your required setting. As you drag the 
slider, the position (in inches) is shown as a tool tip above 
the slider. 

Minimum ratio of 
unchanged text to 
surrounding changes 

Specify at what point short matches of text should be 
ignored if they are surrounded on both sides by 
unmatched text. This prevents common words such as 
'of', 'and' and 'the' being matched up in a paragraph 
where the content has been completely changed. 
Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the 
slider. 

Note: Selecting extreme values for the Sensitivity parameters can lead to unusual 
comparison results. You can return the Sensitivity parameters to their default settings 
at any time by clicking Reset All. 
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Appendix C. Clean and Lightspeed 
Clean 
This appendix describes the differences between the Lightspeed clean and the regular 
clean performed by Workshare Protect. It includes the following sections: 

Types of Cleaning, page 223, introduces Lightspeed cleaning and regular cleaning. 

Features Cleaned, page 223, describes the features in Microsoft Word, Excel and 
PowerPoint files that are cleaned. 

Cleaning PDF Files, page 229, describes how Workshare Protect cleans PDF files. 
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Types of Cleaning 
Lightspeed cleaning is a secure white-out technology that overwrites hidden data to 
prevent leaks. Lightspeed cleaning is much faster than regular cleaning because it does 
not rely on Microsoft Office for cleaning the document and uses exclusive binary 
reading and writing technology. Lightspeed cleaning maintains the original structure of 
the document but may either remove hidden data or redact it (replace it with spaces). 
Thus regular cleaning actually removes the hidden data element from the document 
whereas Lightspeed cleaning may have different effects. There are some subtle 
differences in how each technology cleans the document but both ensure the document 
is safe. 

Features Cleaned 
The following tables detail the features of Microsoft Word, Excel and PowerPoint 
documents that are cleaned by Workshare Protect when a Clean or a Lightspeed 
Clean is performed on the document. The tables also briefly explain the effect of the 
clean or Lightspeed clean. The effect of these actions varies according to the format of 
the document: 

DOC/XLS/PPT Word 97-2003 Document/Excel 97-2003 Workbook/PowerPoint 
97-2003 Presentation 

DOCX/XLSX/PPTX Office Open XML Format (no macros) 
DOCM/XLSM/PPTM Office Open XML Format (macros allowed) 

Microsoft Word documents 
Feature Clean Lightspeed Clean 

DOC Format DOCX/DOCM 
Format 

DOC Format DOCX/DOCM 
Format 

Track 
Changes 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted, but 
where track 

change deletes 
text, the text is 

turned into hidden 
spaces (revealed 
if turn on “show 

hidden text”) 

√ 
Deleted 

Comments √ 
Deleted 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted 
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Feature Clean Lightspeed Clean 
DOC Format DOCX/DOCM 

Format 
DOC Format DOCX/DOCM 

Format 
Small Text √ 

Deleted 
√ 

Deleted 
√ 

Deleted, but 
turned into hidden 
spaces (revealed 
if turn on “show 

hidden text”) 

√ 
Deleted 

White Text √ 
Deleted 

√ 
Deleted 

√ 
Deleted, but 

turned into hidden 
spaces (revealed 
if turn on “show 

hidden text”) 

√ 
Deleted 

Hidden Text √ 
Deleted 

√ 
Deleted 

√ 
Deleted, but 

turned into hidden 
spaces (revealed 
if turn on “show 

hidden text”) 

√ 
Deleted 

Versions  √ 
Deleted 

NA √ 
Deleted 

NA 

Authors √ 
Deleted 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted 

AutoVersion √  
Cleared 

NA √  
Cleared 

NA 

Custom 
Properties 
(in Custom 
tab) 

√  
Deleted 

√ 
Deleted 

√  
Deleted 

√ 
Deleted 

Document 
Variables 

√ 
Deleted 

X 
 

√ 
Name and value 

turned into 
spaces but the 

document 
variable still 

exists 

√ 
Deleted 

Macros √ 
Deleted 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted 
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Feature Clean Lightspeed Clean 
DOC Format DOCX/DOCM 

Format 
DOC Format DOCX/DOCM 

Format 
Routing Slip √ 

Deleted 
NA √ 

Deleted 
NA 

Reviewers √ 
Deleted 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted 

Footnotes √ 
Deleted 

√ 
Deleted 

√ 
Turned into 

hidden spaces 
(revealed if turn 
on “show hidden 

text”) 

√ 
Deleted 

Fields  √ 
Field code is 
deleted and 
the result 

turned to text 

√ 
Field code is 
deleted and 
the result 

turned to text 

√ 
Field code turned 
to blank spaces 

and the result left. 
When update 

performed, result 
becomes empty 

√ 
Field code is 
deleted and 
the result 

turned to text 

Hyperlinks  √ 
Hyperlink 

removed and 
the result 

turned to text 

√ 
Hyperlink 

removed and 
the result 

turned to text 

√ 
Hyperlink turned 
to blank spaces 

and the result left. 
When update 

performed, result 
is error… 

√ 
Hyperlink 

removed and 
the result 

turned to text 

Document 
Statistics (in 
Statistics 
tab) 

√ 
Deleted 

X √ 
Deleted “Last 

Saved By” and 
other fields reset. 

√ 
Deleted “Last 

Saved By” and 
other fields 

reset. 
Built-In 
Properties – 
Standard 
Properties 
(in Summary 
and 
Contents 
tabs) 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted “Title” 

√ 
Deleted 

Smart Tags √ 
Deleted 

√ 
Deleted 

√ 
Deleted 

√ 
Deleted 
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Feature Clean Lightspeed Clean 
DOC Format DOCX/DOCM 

Format 
DOC Format DOCX/DOCM 

Format 
Template √ 

Removes 
reference to 
template and 
shows only 
“Normal” 

√ 
Removes 

reference to 
template and 
shows only 
“Normal” 

√ 
Removes 

reference to 
template  

 

√ 
Removes 

reference to 
template and 
shows only 
“Normal” 

Headers X √ 
Checks 

headers in 
same way as 

body text 

X √ 
Checks 

headers in 
same way as 

body text 

Footers X √ 
Checks footers 

in same way 
as body text 

X √ 
Checks footers 

in same way 
as body text 

Endnotes √ 
Deleted 

√ 
Deleted 

√ 
Deleted text of 

endnote but 
leaves separator 

√ 
Deleted 

Text Within 
Text Box 

X X √ 
Deleted text from 

textbox 

√ 
Deleted text 
from textbox 

SmartArt X X √ 
Deleted 

√ 
Deleted text 

from SmartArt 
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Microsoft Excel workbooks 
Feature Clean Lightspeed Clean 

XLS Format XLSX/XLSM 
Format 

XLS Format XLSX/XLSM 
Format 

Track 
Changes 

√ √ √ √ 

Comments √ √ √ 
Comment turned to 
blank spaces but 

placeholder remains 

√ 

Small Text X √ X √ 
White Text X √ X √ 
Authors √ √ √ √ 
Custom 
Properties 
(in Custom 
tab) 

√ √ √ √ 

Macros X X √ √ 
Routing Slip √ NA √ NA 
Hyperlinks  X X √ √ 
Document 
Statistics (in 
Statistics 
tab) 

√ X √ √ 

Built-In 
Properties – 
Standard 
Properties 
(in Summary 
and 
Contents 
tabs) 

√ √ √ √ 

Smart Tags X X X X 
Headers √ √ √ √ 
Footers √ √ √ √ 
Text Within 
Text Box 

X X X X 

SmartArt NA X NA X 
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Microsoft PowerPoint presentations 
Feature Clean Lightspeed Clean 

PPT Format PPTX/PPTM 
Format 

PPT Format PPTX/PPTM 
Format 

Comments  √ √ √ 
Comment turned to 
blank spaces but 

placeholder remains 

√ 

Small Text X X X X 

White Text X X X X 

Authors √ √ √ √ 

Custom 
Properties 
(in Custom 
tab) 

√ √ √ √ 

Macros X X √ √ 

Hyperlinks  X X √ √ 
Document 
Statistics (in 
Statistics 
tab) 

X √ √ X 

Built-In 
Properties – 
Standard 
Properties 
(in Summary 
and 
Contents 
tabs) 

√ √ √ √ 

Smart Tags X X X X 
Template X X X X 
Headers X X X √ 
Footers X X X √ 
Text Within 
Text Box 

X X X X 

SmartArt NA X NA X 
Speaker 
Notes 

√ √ √ √ 
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Feature Clean Lightspeed Clean 
PPT Format PPTX/PPTM 

Format 
PPT Format PPTX/PPTM 

Format 
Hidden 
Slides 

√ √ √ √ 

Cleaning PDF Files 
Workshare Protect does not distinguish between clean and Lightspeed clean when 
cleaning PDF files and whichever type of cleaning is selected, Workshare Protect will 
clean PDF files in the same way. 

Feature PDF PDF/A 
Attachments √ √ 

Bookmarks √ √ 

Markup √ √ 

Properties √ √ 
Cleaning Properties from PDF/A 

invalidates the PDF/A status 
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Appendix D. Configuring Workshare 
Desktop App 
This appendix describes how to configure the Workshare desktop application (the 
desktop app). This is an application that syncs content between Workshare online and 
your desktop so you can access your files and continue collaborating from your desktop 
while offline. 
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Configuring the Workshare Desktop App 
You can configure application settings for the Workshare desktop app, such as the 
location of the sync folder or general account settings. 

To configure the Workshare desktop app: 

1. Click the desktop app system tray icon and select Preferences or from the File 
menu in the desktop app main window, select Preferences. The following dialog 
is displayed. 

 
The Account page provides information about your account. You can see your 
registered Workshare email address that you use to log in to Workshare as well 
as the address to the Workshare server. Additionally, you have version 
information about the desktop app. 
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2. Select General. 

 
3. Select the Launch Workshare when I login checkbox and the desktop app will 

start when your computer is started. 

4. When you have Workshare 9 with a DMS integration, select the Display DMS 
Open dialog… checkbox and you can select files from your DMS when 
uploading files to Workshare from the desktop app. 

5. To control how Workshare updates, select from the dropdown: 
 Automatically download and install updates: Updates to the desktop app 

will be downloaded and installed automatically as they become available. 
 Notify me when updates are ready to install: You will be notified when 

updates to the desktop app are available. 
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6. Select Network. 

 
The Network page enables you to limit bandwidth settings and change the 
settings of your proxy server. 

7. In the Bandwidth field, click Change Settings. 

 
8. If you want to limit the bandwidth available to data downloaded to the desktop 

app, deselect the Don’t limit checkbox and specify the limit in the Limit to field. 

9. Click Save. 
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10. In the Proxies field, click Change Settings. 

 
11. When working with a proxy server, select Auto-detect and Workshare will use 

your computer’s system settings to connect to the network, or select Manual 
and enter your proxy server details manually. 

Note: There is no Auto-detect option available when working on a Mac. 

12. When manually specifying proxy server settings, you can select Force Proxy so 
that the desktop app traffic MUST go via your proxy server and if the proxy 
server is not available then the desktop app will be offline. 

13. Select the type of your proxy server (HTTP, HTTP Caching or Socks5) and 
enter the server address and port number. 

14. Click Save. 
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15. Select Sync Settings. 

 
16. If required, change the location of the Workshare sync folder by clicking the 

browse button and selecting a different location. By default, this folder is named 
and located as follows: 
 Windows: C:\Users\[user name]\Workshare 
 Mac: /Users/[user name]/Workshare 

Any files or folders put in this folder will be synced to Workshare online and will 
appear in the desktop app. 
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17. Select Notifications. 

 
18. If required, change the notification settings. By default, users receive 

notifications by email and via desktop popup alerts in the following 
circumstances: 
 When a user first accesses a folder you have shared with them 
 When a new file is added to a shared folder 
 When there is a new version of a file 
 When a comment is posted 
 When someone shares a file or folder with you 
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